


Safety Precautions 
Observe the following notices to ensure personal safety or to prevent accidents. 
To ensure that you use this product correctly, read this User’s Manual thoroughly before use. 
Make sure that you fully understand the product and information on safety. 
This manual uses two safety flags to indicate different levels of danger. 

WARNING 
If critical situations that could lead to user’s death or serious injury is assumed by 
mishandling of the product. 
-Always take precautions to ensure the overall safety of your system, so that the whole 
system remains safe in the event of failure of this product or other external factor. 
-Do not use this product in areas with inflammable gas. It could lead to an explosion. 
-Exposing this product to excessive heat or open flames could cause damage to the lithium 
battery or other electronic parts. 

CAUTION 
If critical situations that could lead to user’s injury or only property damage is 
assumed by mishandling of the product. 
-To prevent excessive exothermic heat or smoke generation, use this product at the values 
less than the maximum of the characteristics and performance that are assured in these 
specifications. 
-Do not dismantle or remodel the product. It could cause excessive exothermic heat or smoke 
generation. 
-Do not touch the terminal while turning on electricity. It could lead to an electric shock. 
-Use the external devices to function the emergency stop and interlock circuit. 
-Connect the wires or connectors securely. 
The loose connection could cause excessive exothermic heat or smoke generation. 
-Do not allow foreign matters such as liquid, flammable materials, metals to go into the inside 
of the product. It could cause excessive exothermic heat or smoke generation. 
-Do not undertake construction (such as connection and disconnection) while the power 
supply is on. It could lead to an electric shock. 
 

Copyright / Trademarks 
-This manual and its contents are copyrighted. 
-You may not copy this manual, in whole or part, without written consent of Panasonic 
Industrial Devices SUNX Co., Ltd. 
-Windows is a registered trademark of Microsoft Corporation in the United States and other 
countries. 
-EtherCAT is registered trademark and patented technology, licensed by Beckhoff 
Automation Gmbh, Germany. 
-All other company names and product names are trademarks or registered trademarks of 
their respective owners. 
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Introduction 

Thank you for buying a Panasonic product. Before you use the product, please carefully read 
the installation instructions and the users manual, and understand their contents in detail to 
use the product properly. 

Types of Manual 

• There are different types of users manual for the FP7 series, as listed below. Please refer to 
a relevant manual for the unit and purpose of your use. 

• The manuals can be downloaded on our website: 
http://industrial.panasonic.com/ac/e/dl_center/manual/ 
Unit name or purpose of use Manual name Manual code 
FP7 Power Supply Unit 

FP7 CPU Unit Users Manual  (Hardware) WUME-FP7CPUH 

FP7 CPU Unit 
FP7 CPU Unit Command Reference Manual WUME-FP7CPUPGR 

FP7 CPU Unit Users Manual  
(Logging Trace Function) WUME-FP7CPULOG 

FP7 CPU Unit Users Manual (Security Function) WUME-FP7CPUSEC 

 

Instructions for Built-in 
LAN Port 

FP7 CPU Unit Users Manual 
 (LAN Port Communication) WUME-FP7LAN 

 FP7 CPU Unit User's Manual (EtherNetIP 
Communication) WUME-FP7CPUETEX 

 FP7 CPU Unit Users Manual (EtherNet IP 
communication) See our web site. 

 FP7 Web Server Function Manual See our web site. 

 Instructions for Built-in 
COM Port 

FP7 series Users Manual (SCU communication) WUME-FP7COM 
 

FP7 Extension Cassette 
(Communication)  
(RS-232C/RS485 type) 

 
FP7 Extension Cassette 
(Communication)  
(Ethernet type) 

FP7 series Users Manual (Communication 
cassette Ethernet type) WUME-FP7CCET 

 
FP7 Extension (Function) 
Cassette  
Analog Cassette 

FP7 Analog Cassette Users Manual WUME-FP7FCA 

FP7 Digital Input/Output Unit FP7 Digital Input/Output Unit Users Manual WUME-FP7DIO 

FP7 Analog Input Unit FP7 Analog Input Unit Users Manual WUME-FP7AIH 

FP7 Analog Output Unit FP7 Analog Output Unit Users Manual WUME-FP7AOH 

Thermocouple Multi-analog 
Input Unit 

Thermocouple Multi-analog Input Unit 
RTD Input Unit 
Users Manual 

WUME-FP7TCRTD 
RTD input unit 

FP7 Multi Input/Output Unit FP7 Multi Input/Output Unit Users Manual WUME-FP7MXY 

FP7 High-speed Counter Unit FP7 High-speed Counter Unit Users Manual WUME-FP7HSC 

http://industrial.panasonic.com/ac/e/dl_center/manual/
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Unit name or purpose of use Manual name Manual code 
FP7 Pulse Output Unit  FP7 Pulse Output Unit Users Manual WUME-FP7PG 

FP7 Positioning Unit FP7 Positioning Unit Users Manual WUME-FP7POSP 

FP7 Serial Communication 
Unit FP7 series Users Manual (SCU communication) WUME-FP7COM 

PHLS System PHLS System Users Manual WUME-PHLS 

Programming Software 
FPWIN GR7 FPWIN GR7 Introduction Guidance WUME-FPWINGR7 



Glossary 

iii 
 

Glossary 

To make explanations simple, abbreviations are used for the following terms.  

Abbreviation Name Description 
FP7 MC Unit FP7 Motion Control Unit The product name of the unit described in this manual. 

CMI Control Motion 
Integrator The software for stting parameters of FP7MC Unit. 

 
As for the following terms, they are expressed differently in software, manuals and 
specification concerning FP7 MC Unit and Servo Amplifier A5B. 

FP7 MC Unit A5B Description 

Station address Station alias 
This shows the unit numbers allocated to slaves on 
EtherCAT network. The left two terms have the same 
meaning. 

- General-purpose 
monitor input 

Five inputs of symbols SI-MON1 to SI-MON5 are allocated 
on the A5B side. 

General-purpose 
input - 

On the FP7 MC Unit side, eight signals of A5B are treated 
as "general-purpose input" and can be monitored through 
the unit memory. 
NOT, POT, HOmE, SI-MON1 to SI-MON5 
For using it in combination with FP7 MC Unit, SI-MON3 and 
SI-MON4 are used as limit inputs. NOT and POT are not 
used. 

- General-purpose output On the A5B side, one input of symbol EX-OUT1 is 
allocated. 

General-purpose 
output - 

On the FP7 MC Unit side, one signal to A5B are treated as 
"general-purpose output" and can be written through the 
unit memory. 
EX-OUT1 

 

 



Table of Contents 

iv 
 

Table of Contents 

1.  Unit Functions and Restrictions ....................................... 1-1 

1.1 Functions of Motion Control ................................................................... 1-2 
1.1.1 Functions of Unit ..................................................................................... 1-2 
1.1.2 List of Models .......................................................................................... 1-3 

1.2 Restrictions............................................................................................ 1-4 
1.2.1 Supported Functions ............................................................................... 1-4 
1.2.2 Restrictions by Power Consumption in FP7 System ............................... 1-5 
1.2.3 Applicable Versions of FPWINGR7 and FP7 Units ................................. 1-5 

1.3 System Configuration ............................................................................ 1-6 
1.3.1 Example of System Configuration ........................................................... 1-6 
1.3.2 Type of Software ..................................................................................... 1-7 

1.4 Mechanism of Processing ...................................................................... 1-8 
1.4.1 Schematic View ....................................................................................... 1-8 
1.4.2 Operation When Powe Supply Turns On ................................................ 1-9 
1.4.3 Start/Stop by User Programs .................................................................. 1-9 

2.  Names and Functions of Parts ......................................... 2-1 

2.1 Names and Functions of Parts............................................................... 2-2 
2.1.1 Names and Functions of Parts ................................................................ 2-2 
2.1.2 Operation monitor LEDs .......................................................................... 2-3 
2.1.3 ESM (State Transition Diagram) ............................................................. 2-4 

3.  Installation and Wiring ...................................................... 3-1 

3.1 Settings of Servo Amplifier A5B ............................................................. 3-2 



Table of Contents 

v 
 

3.1.1 Checking Rotary Switches ...................................................................... 3-2 
3.1.2 Connection of Input Signals .................................................................... 3-3 

3.2 Connection of Network .......................................................................... 3-4 
3.2.1 Wiring ...................................................................................................... 3-4 
3.2.2 Precautions on Wiring ............................................................................. 3-4 

4.  Basic Procedure ................................................................. 4-1 

4.1 Section Details ...................................................................................... 4-2 

4.2 Registration in I/O Map ......................................................................... 4-3 
4.2.1 Creation of I/O map ................................................................................. 4-3 
4.2.2 Download of I/O map .............................................................................. 4-4 
4.2.3 Storage of I/O map .................................................................................. 4-4 
4.2.4 Confirmation of I/O Allocation ................................................................. 4-4 
4.2.5 Confirmation of Slot Numbers ................................................................. 4-5 

4.3 Setting of Used Axes............................................................................. 4-6 
4.3.1 Registration of Used Axes ....................................................................... 4-6 

4.4 Setting of Network Configuration ......................................................... 4-10 
4.4.1 Registration of Slaves (Offline) ............................................................. 4-10 
4.4.2 Registration of Slaves (Online) ............................................................. 4-12 
4.4.3 Setting of Station Addresses and Axis Numbers .................................. 4-14 
4.4.4 Download to FP7 MC Unit ..................................................................... 4-16 
4.4.5 Restarting Power Supplies and Checking Communication State ......... 4-18 

4.5 Connection of Limit and Near Home Switches .................................... 4-20 
4.5.1 Connection of Input Signals .................................................................. 4-20 
4.5.2 Pin Assignment Setting of Servo Amplifier ........................................... 4-21 
4.5.3 Checking Servo Amplifier Input State ................................................... 4-23 
4.5.4 Settings of FP7 MC Unit ........................................................................ 4-24 
4.5.5 Download to FP7 MC Unit ..................................................................... 4-25 
4.5.6 Checking Input State ............................................................................. 4-25 

4.6 Saving and Managing Files ................................................................. 4-26 
4.6.1 File Type ................................................................................................ 4-26 



Table of Contents 

vi 
 

4.6.2 Saving as CMI Files .............................................................................. 4-26 
4.6.3 Export to CSV Files ............................................................................... 4-27 

5.  Settings of FP7 MC Unit .................................................... 5-1 

5.1 MC Common Settings ........................................................................... 5-2 
5.1.1 MC Common Settings Dialog Box ........................................................... 5-2 
5.1.2 MC Common Settings Parameters ......................................................... 5-3 

5.2 Axis Parameter Settings ........................................................................ 5-5 
5.2.1 Setting by CMI ......................................................................................... 5-5 
5.2.2 Axis Parameters (Basic Setup) ............................................................... 5-6 
5.2.3 Axis Parameters (Options) ...................................................................... 5-7 
5.2.4 Axis Parameters (Operation) ................................................................... 5-8 

5.3 Positioning Table Setting ..................................................................... 5-10 
5.3.1 Construction of Positioning Tables ........................................................ 5-10 
5.3.2 Operation Patterns and Tables ............................................................. 5-13 

5.4 Synchronous Parameter and Cam Pattern Settings ............................. 5-14 
5.4.1 Synchronous Parameter Settings ......................................................... 5-14 
5.4.2 Cam Pattern Setting .............................................................................. 5-15 

5.5 Confirmation of Setting Contents ......................................................... 5-16 
5.5.1 Check on Parameter Data ..................................................................... 5-16 
5.5.2 Comparison of Parameter Information .................................................. 5-16 

5.6 Transfer of Parameters ........................................................................ 5-18 
5.6.1 Writing Parameters to Unit .................................................................... 5-18 

6.  Data Transfer to MC Unit and Test Operation .................. 6-1 

6.1 Before Turning On the Power ................................................................ 6-2 

6.2 Procedure for Turning On the Power ..................................................... 6-3 
6.2.1 Procedure for Turning On the Power ...................................................... 6-3 
6.2.2 Procedure for Turning Off the Power ...................................................... 6-3 



Table of Contents 

vii 
 

6.3 Checking While the Power is ON .......................................................... 6-4 
6.3.1 Items to Check When the Power is ON................................................... 6-4 
6.3.2 Checking Network Communication State ............................................... 6-5 
6.3.3 Checking the safety circuit by the PLC unit ............................................ 6-6 
6.3.4 Checking the Operation of Near Home Switch ....................................... 6-7 
6.3.5 Checking Rotating and Moving Directions and Moving Distance ........... 6-7 

6.4 Monitor Function of CMI ........................................................................ 6-8 
6.4.1 Status Monitor ......................................................................................... 6-8 
6.4.2 Data Monitor .......................................................................................... 6-10 

6.5 Tool Operation Function of CMI .......................................................... 6-12 
6.5.1 Tool Operation Function ........................................................................ 6-12 
6.5.2 Serve ON/OFF with Tool Operation Function ....................................... 6-14 
6.5.3 JOG Operation with Tool Operation Function ....................................... 6-16 
6.5.4 Home Return by Tool Operation Function ............................................ 6-18 
6.5.5 Positioning by Tool Operation Function ................................................ 6-20 
6.5.6 Teaching by Tool Operation Function ................................................... 6-23 

7.  Creation of User Programs ................................................ 7-1 

7.1 How to Create User Programs .............................................................. 7-2 
7.1.1 Basic Configuration of Program .............................................................. 7-2 

7.2 Overview of Programs ........................................................................... 7-4 
7.2.1 Reading Data From Input Control Area .................................................. 7-4 
7.2.2 Servo ON/OFF Control Program ............................................................. 7-5 
7.2.3 Start Enabled Program ............................................................................ 7-6 
7.2.4 Each Control Programs ........................................................................... 7-6 
7.2.5 Writing Data to Output Control Area ....................................................... 7-7 

7.3 Precautions On Programming ............................................................... 7-8 
7.3.1 Turning Off Power Supply Clears Contents in Unit Memories ................ 7-8 
7.3.2 Operation Cannot be Switched Once One Operation Has Started ......... 7-8 
7.3.3 Operation When PLC Mode Changes From RUN To PROG. ................ 7-8 



Table of Contents 

viii 
 

8.  Automatic Operation (Position Control) .......................... 8-1 

8.1 Basic Operation ..................................................................................... 8-2 
8.1.1 Patterns of Position Control..................................................................... 8-2 
8.1.2 Setting and Operation of E-point Control ................................................ 8-4 
8.1.3 Setting and Operation of P-point Control ................................................ 8-6 
8.1.4 Setting and Operation of C-point Control ................................................ 8-8 
8.1.5 Setting and Operation of J-point Control ............................................... 8-10 

8.2 Interpolation Control ............................................................................ 8-12 
8.2.1 Type of Interpolation Control (Two-axis Interpolation) .......................... 8-12 
8.2.2 Type of Interpolation Control (Three-axis Interpolation) ....................... 8-14 
8.2.3 Setting and Operation of Two-Axis Linear Interpolation ....................... 8-17 
8.2.4 Setting and Operation of Two-Axis Circular Interpolation ..................... 8-19 
8.2.5 Setting and Operation of Three-Axis Linear Interpolation ..................... 8-21 
8.2.6 Setting and Operation of Three-Axis Spiral Interpolation ...................... 8-23 

8.3 Repeat Function .................................................................................. 8-25 
8.3.1 Overview of Repeat Operation .............................................................. 8-25 
8.3.2 Stop Operation During Repeat Operation ............................................. 8-26 
8.3.3 Setting and Operation of Repeat ........................................................... 8-27 

8.4 Sample Programs ................................................................................ 8-29 
8.4.1 Sample Programs (E-point, C-point and C-point Controls) ................... 8-29 
8.4.2 Precautions on Programming ................................................................ 8-31 

8.5 Rewriting Positioning Data by User Programs ..................................... 8-32 
8.5.1 Overview of Function ............................................................................. 8-32 
8.5.2 Procedure of Rewriting .......................................................................... 8-33 
8.5.3 Sample Program (Rewritign Positioning Tables) .................................. 8-34 

9.  Automatic Operation (Synchronous Control) .................. 9-1 

9.1 Synchronous Control ............................................................................. 9-2 
9.1.1 Overview of Synchronous Control ........................................................... 9-2 

9.2 Settings for Master and Slave Axes ....................................................... 9-4 



Table of Contents 

ix 
 

9.2.1 Selection of Master Axis and Settings .................................................... 9-4 
9.2.2 Selection of Slave Axes and Settings ..................................................... 9-5 
9.2.3 Unit Type and Number of Axes ............................................................... 9-5 
9.2.4 Setting by CMI ......................................................................................... 9-6 

9.3 Start and Cancel of Synchronous Control ............................................. 9-8 
9.3.1 Start and Cancel of Synchronous Control ............................................... 9-8 
9.3.2 Precautions When Canceling or Starting Synchronous Control ........... 9-10 

9.4 Electronic Gear Function ..................................................................... 9-12 
9.4.1 Overview of Electronic Gear Function .................................................. 9-12 
9.4.2 Types and Contents of Setting Parameters .......................................... 9-13 
9.4.3 Gear Ratio Changes while in Operation................................................ 9-14 

9.5 Electronic Clutch Function .................................................................. 9-16 
9.5.1 What is Electronic Clutch Function? ..................................................... 9-16 
9.5.2 Types and Contents of Setting Parameters .......................................... 9-17 
9.5.3 Trigger Types for Electronic Clutch ....................................................... 9-18 
9.5.4 Engagement Method of Electronic Clutch ............................................. 9-19 

9.6 Electronic Cam Function ..................................................................... 9-20 
9.6.1 Overview of Electronic Cam Function ................................................... 9-20 
9.6.2 Types and Contents of Setting Parameters .......................................... 9-21 
9.6.3 Cam Pattern Setting Method ................................................................. 9-22 

10.  Manual Operation (JOG Operation) ................................ 10-1 

10.1 Setting and Operation of Home Return ............................................... 10-2 

10.2 Changing Speed During JOG Operation ............................................. 10-4 

10.3 Setting and Operation of JOG Inching Operation ................................ 10-6 

10.4 Sample Programs ............................................................................... 10-8 
10.4.1 Sample Program (JOG Operation)........................................................ 10-8 
10.4.2 Precautions on Programming .............................................................. 10-10 



Table of Contents 

x 
 

11.  Manual Operation (Home Return) .................................. 11-1 

11.1 Types of Home Return ........................................................................ 11-2 

11.2 Operation of Home Return ................................................................... 11-8 

11.3 Sample Programs .............................................................................. 11-10 
11.3.1 Sample Program (Home Return) ........................................................ 11-10 
11.3.2 Precautions on Programming .............................................................. 11-12 

12.  Stop Functions ................................................................ 12-1 

12.1 Type of Stop Functions ........................................................................ 12-2 
12.1.1 Type of Stop Operations ....................................................................... 12-2 
12.1.2 Characteristics of Pause Function ........................................................ 12-4 
12.1.3 Stop Operation During Interpolation Control ......................................... 12-4 
12.1.4 Stop Operation During Synchronous Control ........................................ 12-4 

12.2 Settings Related to Stop Function ....................................................... 12-5 
12.2.1 MC Common Settings ........................................................................... 12-5 
12.2.2 Axis Parameter ...................................................................................... 12-6 

12.3 Operation During Stop ......................................................................... 12-7 

13.  Supplementary Functions .............................................. 13-1 

13.1 Dwell Time........................................................................................... 13-2 

13.2 Software Limit ...................................................................................... 13-3 

13.3 Auxiliary Output Code and Auxiliary Output Contact ............................ 13-4 

13.4 Current Value Update .......................................................................... 13-6 

13.5 Home Coordinates ............................................................................... 13-8 

13.6 Movement Amount Automatic Check ................................................. 13-10 

13.7 Monitor Error (Torque / Actual Speed Judgement)............................. 13-11 



Table of Contents 

xi 
 

13.8 EtherCAT Communication Setting..................................................... 13-12 
13.8.1 EtherCAT Configurator ........................................................................ 13-12 
13.8.2 Device Editor ....................................................................................... 13-13 
13.8.3 Overview of PDO Mapping .................................................................. 13-14 
13.8.4 Change of PDO Mapping .................................................................... 13-15 

13.9 EC Packet Monitor Function .............................................................. 13-18 
13.9.1 Overview of Function .......................................................................... 13-18 
13.9.2 Stored Files ......................................................................................... 13-18 
13.9.3 How to Set ........................................................................................... 13-19 
13.9.4 How to Execute ................................................................................... 13-20 
13.9.5 Handling of SD Memory Card ............................................................. 13-20 

14.  Troubleshooting .............................................................. 14-1 

14.1 Errors and Warnings ........................................................................... 14-2 
14.1.1 Errors and warnings .............................................................................. 14-2 
14.1.2 Checking and Clearing by CMI ............................................................. 14-2 
14.1.3 Clearing Errors/Warnings Using User Programs .................................. 14-3 
14.1.4 Error and Warning Logs ........................................................................ 14-4 

14.2 Error Recovery Process ...................................................................... 14-5 
14.2.1 Overview ............................................................................................... 14-5 

14.3 Error Code Table ................................................................................ 14-6 
14.3.1 System Errors (From 00F0 1000H ........................................................ 14-6 
14.3.2 AMP Communication Errors (From 00F0 2000H) ................................. 14-6 
14.3.3 Axis Operation Errors (From 00F0 3000H) ........................................... 14-7 
14.3.4 Setting Value Errors (From 00F0 4000H) ............................................. 14-9 
14.3.5 Synchronous Parameter Setting Errors (From 00F0 5000H) ............. 14-12 

14.4 Warning Code Table ......................................................................... 14-15 
14.4.1 Unit Warnings (From 00B0 0000H) ..................................................... 14-15 



Table of Contents 

xii 
 

15.  Specifications .................................................................. 15-1 

15.1 Specifications ...................................................................................... 15-2 
15.1.1 General Specifications .......................................................................... 15-2 
15.1.2 Communication Specifications .............................................................. 15-3 
15.1.3 Performance Specifications................................................................... 15-4 

15.2 I/O Allocation ....................................................................................... 15-6 

15.3 Whole Configuration of Unit Memories ................................................ 15-8 

15.4 Unit Memories (Input and Output Control Areas) ............................... 15-10 
15.4.1 Configuration of Input Control Area ..................................................... 15-10 
15.4.2 Configuration of Output Control Area .................................................. 15-11 
15.4.3 List of Input Control Area Functions .................................................... 15-12 
15.4.4 List of Output Control Area Function ................................................... 15-20 

15.5 Unit Memories (Common Area) ......................................................... 15-25 
15.5.1 Configuration of Common Area ........................................................... 15-25 
15.5.2 Setting Parameter Control Area .......................................................... 15-26 
15.5.3 Operation Speed Rate Area ................................................................ 15-26 
15.5.4 Axis Group Setting Area ...................................................................... 15-27 
15.5.5 Current Value Update Data Area ........................................................ 15-28 
15.5.6 Positioning Control Starting Table Number Setting Area .................... 15-29 
15.5.7 Positioning Control Area...................................................................... 15-29 
15.5.8 Error Annunciation and Clear Area ..................................................... 15-30 
15.5.9 Warning Annunciation and Clear Area ................................................ 15-32 
15.5.10 Synchronous Control Monitor Area ................................................. 15-34 

15.6 Unit Memories (Each Axis Information Area) ..................................... 15-36 
15.6.1 Configuration of each axis information area........................................ 15-36 
15.6.2 Each Axis Information & Monitor Area ................................................ 15-37 

15.7 Unit Memories (Each Axis Setting Area) ............................................ 15-40 
15.7.1 Configuration of Each Axis Setting Area ............................................. 15-40 
15.7.2 Configuration of Parameter Setting Area ............................................ 15-41 
15.7.3 Parameter Setting Area ....................................................................... 15-42 
15.7.4 Configuration of Positioning Data Setting Area ................................... 15-48 



Table of Contents 

xiii 
 

15.8 Unit Memories (Synchronous Control Setting Area) .......................... 15-55 
15.8.1 Configuration of Synchronous Control Setting Area ........................... 15-55 
15.8.2 Sychronous Control Setting Area ........................................................ 15-56 
15.8.3 Electronic Gear Setting Area ............................................................... 15-57 
15.8.4 Clutch Setting Area ............................................................................. 15-57 
15.8.5 Electronic Cam Setting Area ............................................................... 15-59 

15.9 Dimensions ....................................................................................... 15-60 
 



Table of Contents 

xiv 
 



 

 

1 
 Unit Functions and 

Restrictions 



Unit Functions and Restrictions 

1-2 
 

1.1 Functions of Motion Control 

1.1.1 Functions of Unit 

A5B A5B A5B
FP7MC

EtherCAT

USB

Control FPWIN GR7
Control Motion Integrator

USB

PANATERM

 

 Controlling Servo Motor MINAS A5B series through EtherCAT 
FP7 Motion Control Unit (hereafter FP7 MC Unit) adopts EtherCAT communication and 
controls servo motors. It achieves wiring saving by network connection and high-speed control. 
(Note): EtherCAT is a registered trademark of Beckhoff Automation Gmbh in Germany and a technology protected 

by a patent. 

 Setting using dedicated software "Control Motion Integrator" 
Dedicated software "Control Motion Integrator" (sold separately) is provided for easily 
configuring the setting of EtherCAT communication and parameters of position control. 
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1.1.2 List of Models 

 Main unit 
Product name Max. number of control axes Product no. 

FP7 Motion Control Unit 
(Abbreviated name: FP7 
MC Unit) 

16 axes/unit AFP7MC16EC 

32 axes/unit AFP7MC32EC 

64 axes/unit AFP7MC64EC 

 Related software 
Product name Application Product no. 
Programming software 
FPWIN GR7 

This software is used for configuring the whole 
FP7 system and creating user programs. 

For the latest information, 
see our web site. 

Software 
Control Motion Integrator 

This software is used for configuring FP7 MC Unit 
and monitoring the state.. 
 EtherCAT communication parameters 
 Setting of positioning parameters 
 Setting of positioning tables 

For the latest information, 
see our web site. 

 Key Unit For installing a USB port (Note 3) AFPSMTKEY 

Setup support software 
PANATERM 

This software is used for setting parameters and 
monitoring the states of Servo Amplifier A5B 
series. 

For the latest information, 
see our web site. 

(Note 1): For the latest information on FPWIN GR7 and Control Motion integrator, see the following web site. 
http://industrial.panasonic.com/ac/e/fasys/plc/software/fpwingr7/index.jsp 

(Note 2): For the latest information on PANATERM, see the following web site. 
https://industrial.panasonic.com/ww/products/motors-compressors/fa-motors/ac-servo-motors/minas-a5-
panaterm 

(Note 3): All the functions of Control Motion Integrator can be used free of charge for 60 days after the installation. For 
using the "EtherCAT communication setting" function continuously after the elapse of 60 days, the key unit 
should be installed. 

 Required files for EtherCAT communication 
The setup information (ESI files) required for EtherCAT communication is included in the 
installation data of software "Control Motion Integrator". 
(Note): ESI (EtherCAT Slave Information) 
 

http://industrial.panasonic.com/ac/e/fasys/plc/software/fpwingr7/index.jsp
https://industrial.panasonic.com/ww/products/motors-compressors/fa-motors/ac-servo-motors/minas-a5-panaterm
https://industrial.panasonic.com/ww/products/motors-compressors/fa-motors/ac-servo-motors/minas-a5-panaterm
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1.2 Restrictions 

1.2.1 Supported Functions 

FP7 MC Unit is designed in conformity with the specifications and standard of EtherCAT, 
however, FP7 MC Unit Ver.1 supports the items listed in the following table only. 

 Comparison with EtherCAT specifications 
Item EtherCAT specifications Supported items by FP7 MC Unit 
Transmission 
system 100BASE-TX Same as on the left. 

Baud rate 100 Mbps Same as on the left. 

Trasmission 
distance Max. 100 m between nodes Same as on the left. 

Transmission 
cable STP cable, category 5/5e Always use a cable of category 5e or higher. 

Topology Line, Daisy chain, Star, Tree Daisy chain (without brach) 

Max. number of 
connected units 65535 64 

Connectable 
device EtherCAT-compatible devices 

Panasonic 
AC serv motor A5B series 
(EtherCAT-compatible type) 

 Control mode 

Control mode of EtherCAT Supported function 
of A5B Supported items by FP7 MC Unit 

Cyclic position control mode (csp) Supported 
The cyclic position control mode (csp) is used 
when using it in combination with FP7 MC 
Unit. 

Profile position control mode (pp) Unsupported Only the home return position control mode 
(Method33/34/37) is supported. The cyclic 
position control mode (csp) is used when 
using it in combination with FP7 MC Unit. 

Home return position control 
mode (hm) Supported 

Interpolation position control 
mode (ip) Unsupported 

When using it in combination with FP7 MC 
Unit, FP7 MC Unit performs the interpolation 
control. 

Cyclic speed control mode (csv) 

Supported Unsupported 
Profile speed control mode (pv) 

Cyclic torque control mode (cst) 

Profile torque control mode (tq) 
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1.2.2 Restrictions by Power Consumption in FP7 System 

The unit has the following internal current consumption. Make sure that the total current 
consumption is within the capacity of the power supply with consideration of all other units 
used in combination with this unit. 

Name Product no. Consumption current 

FP7 Motion Control Unit 
AFP7MC16EC 
AFP7MC32EC 
AFP7MC64EC 

180 mA or less 

1.2.3 Applicable Versions of FPWINGR7 and FP7 Units 

For using FP7 MC Unit, the following versions of FPWIN GR7 and units are required. 

Item Applicable versions 
Programming tool software 
FPWIN GR7 Ver.2.12 or later 

FP7 CPU Unit 
There is no restriction on the version. 
For using the EC packet monitor function of FP7 MC Unit, use FP7 CPU Unit 
(Ethernet function- built-in type). 
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1.3 System Configuration 

1.3.1 Example of System Configuration 

The following figure shows the example of the configuration of one axis when using over limit 
switches and a near home switch. 

 

 Configuration of devices 
No. Item Explanation 

① FP7  
The above figure shows the minimum configuration that FP7 CPU Unit, 
FP7 MC Unit and an end unit are combined. For FP7 MC Unit, the units 
for 16 axes, 32 axes, and 64 axes are available. 

② Shielded twisted pair (STP) 
cable 

FP7 MC Unit and Servo Amplifier A5B are connected with a shielded 
twisted pair (STP) cable. 

③ Servo Amplifier A5B The units of the number of required axes areconnected.  

④ Over limit switch 

The over limit switches are connected to the servo amplifier. When 
using the servo amplifier in combination with FP7 MC Unit, the over 
limit switches are connected to the terminals allocated to the general-
purpose monitor inputs of the servo amplifier (SI-MON3/SI-MON4). 

⑤ Near home switch The near home switch is connected to the servo amplifier. It is 
connected to the terminal allocated to the near home input (HOME). 
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1.3.2 Type of Software 

The following three softwares are used for using the system combining FP7 MC Unit and 
Servo Amplifier A5B. 

 Control Motion Integrator Ver.1.0 
 

 

Application: 
This software is used for setting parameters of 
FP7 MC Unit, monitoring the state and test 
operations. 
 Setting of EtherCAT communication 
parameters 
 Setting of positioning parameters 
 Setting of positioning tables, etc. 
Download destination: 
FP7 MC Unit 
Connection with the unit: 
Connect to the USB port of FP7 CPU Unit. 

 FPWIN GR7 Ver.2.12 
 

 

Application: 
This software is used for configuring the whole 
FP7 system and creating user programs. 
Download destination: 
FP7 CPU Unit 
Connection with the unit: 
Connect to the USB port of FP7 CPU Unit. 

 PANATERM Ver.6.0 
 

 

Application: 
This software is used for setting parameters 
and monitoring the states of Servo Amplifier 
A5B series. 
Download destination: 
Servo Amplifier A5B 
Connection with the unit: 
Connect to the USB port of Servo Amplifier 
A5B. 
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1.4 Mechanism of Processing 

1.4.1 Schematic View 

FP7 CPU FP7 MC A5B

FROM

Slave 
processing

MC unit

Operation 
processing 

part

I/O

Y0: System stop 

X0: Link establishment

Input 
processing

User program

I/O map

● ● ● ● ●

CPU Config.

Power on

EtherCAT communication 

Positioning parameters

Positioning tables

● ● ● ● ●

Communication 
parameters

UM

FPWIN GR7 CMI PANATERM

Update cycle 500μs-4000μs

Input control area

Output control area

Busy, Done, Error flag

Start, Stop, Servo on/off

UM

Output 
processing
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1.4.2 Operation When Powe Supply Turns On 

• FP7 MC Unit reads the "parameters for FP7 MC Unit" stored in the FROM (FlashROM) 
within the unit and sets them in the memory areas within the unit. 

• FP7 MC Unit starts the communication with the slaves (servo amplifiers) connected to 
EtherCAT. Once the links with the slaves (servo amplifiers) are established, it is notified to 
FP7 CPU Unit by the input relay (X0). 

• When the mode setting switch is set to RUN mode, FP7 CPU Unit checks that the state of 
the FP7 system is correct, switches the mode to RUN mode, and executes user programs. 

1.4.3 Start/Stop by User Programs 

• In the case of FP7 MC Unit, main I/O signals to execute various controls (such as positioning, 
JOG operation, home return, and stop) are allocated to the unit memories (UM). 

• In the unit memories (UM) "Output control area", request signals to perform stop control are 
allocated. In the unit memories "Input control area", flags such as busy flag and error flag to 
check the start conditions are allocated. 

• FP7 MC Unit controls operations by reading or writing data to these unit memories. 
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2.1 Names and Functions of Parts 

2.1.1 Names and Functions of Parts 

①

②

③

④

⑤

⑥

⑦

 

②-a ②-b

②-c

 

⑥

 

 Names and functions of parts 
No. Name Function 

① Operation monitor 
LEDs 

Indicates the state of EtherCAT communication, the occurrence states of 
unit's errors and alarms. 

② 

Card cover A SD memory card slot is located under the cover. 

a: Card slot An SD memory card is inserted. 

b: COPY switch This is provided for expansion. Use the switch at the factory default (lower 
side) as it is. 

c: Memory selector 
switch 

This is provided for expansion. Use the switch at the factory default (lower 
side) as it is. 

③ Network connector 
(RJ45) This is the connector for connecting to EtherCAT. 

④ DIN hook This hook is used to install the unit on a DIN rail. 

⑤ Unit connector Connects the internal circuits between units. 

⑥ Mode setting switch This switch is used for the system. Use this at the factory default (no.1-3: ON, 
no.4: OFF) as it is. 

⑦ Fixing hook This hook is used to fix units. 
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2.1.2 Operation monitor LEDs 

 

LED Color Status Description 
－ Blue ON Turns on when the power is supplied to the unit. 

EC RUN Green 

OFF INIT state Indicates the state of the 
ESM (EtherCAT State 
Machine) of EtherCAT 
communication. Refer to 
the next page for details. 

Blinking Pre-Operational state 

Single flash Safe-Operational state 

ON Operational state 

EC ERR Red 
OFF No error Indicates errors in 

EtherCAT communication. ON EtherCAT communication error 

EC L/A Green 

OFF LINK is not established. 

Indicates the LINK state of 
EtherCAT communication. 

Blinking LINK is established. Data is 
sent/received. 

ON LINK is established. Data is not 
sent/received. 

[SD] Green 
ON SD memory card is beng accessed. 

OFF Other than the above state. 

CARD Green (Reserved for system) 

COPY Green (Reserved for system) 

ERR Red 

ON Unit error occurs. 

Blinking Unit warnig occurs. 

OFF Other than the above states. 

ALM Red 
ON Unit alarm occurs. 

OFF Other than the above state. 

(Note 1): Blinking and single flash of EC RUN are activated as below. 

Blinking

Single flash

Approx.200ms

Approx.1000ms

Approx.200ms

Approx.200ms
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2.1.3 ESM (State Transition Diagram) 

Init

Pre-Operational

Safe-Operational

Operational

(IP) (PI) (SI)

(SP)

(SO) (OS)

(PS)

(OP)

(OI)

 
Reference: Created by us based on "Operating principle of EtherCAT" issued by ETG 

ESM state 
(Abbr.) 

SDO 
communication 
Send/Receive 

PDO 
communication 

（S→M） 

PDO 
communication 

（M→S） 
Description 

Init Not available Not available Not available 

The state that the 
communication part is being 
initialized, and data cannot 
be sent/received using SDO 
(Mailbox) and PDO. 

Pre-
Operational 
（PreOP） 

Available Not available Not available 
The state that data can be 
sent/received using SDO 
(Mailbox). 

Safe-
Operational 
（SafeOP） 

Available Available Not available 

The state that data can be 
sent/recevied using SDO 
(Mailbox) and data can be 
sent (from slaves to master) 
using PDO. 

Operational 
（OP） Available Available Available 

The state that data cannot be 
sent/received using SDO 
(Mailbox) and PDO. 

(Note): S: Slave, M: Master 

 What is ESM (EtherCAT State Machine)? 
• ESM shows the state of the communication determined as the specifications of EtherCAT. 

• The state transition is performed between FP7 MC Unit and Servo Amplifier A5B, an any 
settings or programming by users are not required. 

 Confirmation method 
• The state of ESM can be confirmed by the operation monitor LED "EC RUN" on the front 

side of FP7 MC Unit. 

• When communication is performed, "Operational (OP)" (EC RUN LED) is ON, and the input 
relay (X0 (Link established)" of FP7 MC Unit is ON. 
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3.1 Settings of Servo Amplifier A5B 

3.1.1 Checking Rotary Switches 

When using FP7 MC Unit in combination with Servo Amplifier A5B, the address of the 
EtherCAT network is set by the software CMI. 

• Set the rotary switch of Station Alias (ID) on the front side of Servo Amplifier A5B to "00". 

• The parameter: Pr7.40 of Servo Amplfiier A5B should be always set to "0". 

 

 Switch setting 

Setting 
value 

Front panel 
display Function 
MSD LSD 

0 0 0 The settings on the FP7 MC Unit side that is the higher master are valid.  
Make the setting using the setting software CMI. 

REFERENCE  
• For the setting method of station addresses using software CMI, refer to 

"4.4 Setting of Network Configuration". 
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3.1.2 Connection of Input Signals 

For the system which uses the over limit switches and near home switch, connect them to the 
I/O connector of Servo Amplifier A5B. 

AMP

Near home
switch

Over limit
switch

Over limit
switch

 

 I/O connector (X4): Allocation of functions at the factory setting 
X4 connector Function at the factory setting 

Application  
on the FP7 MC Unit side Name Pin 

no. Signal name Code Logic 

SI1 5 General-purpose monitor 
input 5 SI-MON5 A contact It can be only monitored by the 

unit memories.. 

SI2 7 CW over-travel inhibit input POT B contact 
Do not allocate POT or NOT. 

SI3 8 CCW over-travel inhibit 
input NOT B contact 

SI4 9 Near home input HOME A contact It is used as a near home input. 

SI5 10 External lutch input 1 EXT1 A contact It can be only monitored by the 
unit memories.. SI6 11 External lutch input 2 EXT2 A contact 

SI7 12 General-purpose monitor 
input 3 SI-MON3 A contact It is used as limit +. 

SI8 13 General-purpose monitor 
input 4 SI-MON4 A contact It is used as limit -. 

(Note 1): The above table shows the allocation before shipment. It varies according to the setting of PANATERM. 

KEY POINTS
 

• When using FP7 MC Unit in combination with Servo Amplifier A5B, the 
general-purpose inputs (SI-MON3 and SI-MON4) are used as limit inputs. For 
using the general-purpose monitor inputs (SI-MON3 and SI-MON4) as limit 
inputs, the setting of the limit switch should be set to "A: Enabled" in the 
"Axis parameter setting" menu  of CMI. 

• The over-travel inhibit inputs (POT, NOT) cannot be used as the limit inupts 
on the MC Unit side. Do not allocate the over-travel inhibit inputs (POT, 
NOT) to the I/O connector (X4) of Servo Amplfiier A5B. 

REFERENCE  
• For details of the parameter settings, refer to "4.5 Connection of Limit and 

Near Home Switches". 
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3.2 Connection of Network 

3.2.1 Wiring 

AMP AMP AMPFP7
MC

100m max.100m max. 100m max.

X2A

X2B

X2A X2A

X2B

 

• The cable connected to FP7 MC Unit is connected to the connector X2A of Servo Amplififer 
A5B. 

• The distance between each node should be within 100m. 

3.2.2 Precautions on Wiring 

• Always use shielded twisted pair (STP) cables that are compatible with category 5e or higher. 

• Turn off the power supply of the system before wiring cables. 

• To prevent the cable from coming off, securely connect the connector of the cable to the 
network connector (RJ45 connector) of the unit. 

• Hubs for EtherCAT and Ethernet cannot be used. 

 
  To the next page 
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 Conformity conditions to EMC Directive 
Although this product conforms to EN61131-2 for the European EMC Directive (EMC Directive 
2004/108/EC), the following wiring condition is required. 

• Always use shielded twisted pair (STP) cables that are compatible with category 5e or higher. 

• Attach ferrite cores at two points on the FP7 MC Unit side and Servo Amplifier A5B side, and 
wire the cable to make a loop. Recommended ferrite core: Takeuchi Industry Co., Ltd. SFT-
72SN or equivalent 

AMPFP7
MC

50mm max. 50mm max.

X2A
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4.1 Section Details 
The following are the procedures of configuring basic settings by connecting FP7 MC Unit and 
Servo Amplifier A5B. Confirm them before setting parameters and creating programs. 

 Operation procedure 
 Item Used tool Outline of operation 

① Registration in I/O 
map of the unit FPWIN GR7 

Regiser the unit configuration of the FP7 system on the "I/O 
map" dialog box. 

Download the "I/O map" information to FP7 CPU Unit. 

② Allocation of used 
axes CMI Register the "configuration of axes" controlled by FP7 MC Unit 

in the "Used axis" setting dialog box. 

③ Registration of 
network configuration 

- 
Set the rotary switch of Servo Amplifier A5B to "00". 

Turn on the powers of Servo Amplifier A5B and FP7. 

CMI 

Start "EtherCAT Configurator" and register slaves in 
accordance with the configuration to be used. 

Set station addresses and axis numbers. 

Download the "slave registration" information to FP7 MC Unit. 

Turn on and off the powers of Servo Amplifier A5B and FP7, 
and then turn them on again. 

Confirm the communication state by LEDs or the monitor of 
CMI. 

④ 

Confirmation of the 
connections of limit 
and near home 
switches 
(Option) 

- Connect the limit and near home input switches to Servo 
Amplifier A5B. 

PANATERM Set the input logic. Monitor the input state. 

CMI 

Enable the functions on the FP7 MC Unit side. Set the input 
logic. 

Download the set information to FP7 MC Unit. 

Monitor whether the limit and near home inputs are loaded or 
not. 

⑤ Storage of files 
FPWIN GR7 
CMI 
PANATERM 

Save created files. 
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4.2 Registration in I/O Map 

4.2.1 Creation of I/O map 

Before setting parameters or creating programs, register units to be used in the I/O map. The 
I/O is created on FPWIN GR7. The following procedure is explained on the condition that 
FPWIN GR7 has already started. 

PROCEDURE  
1. Select "Options" > "FP7 Configuration" > "I/O map" in the menu bar. 

The "I/O map" dialog box is displayed. 

 
2. Double-click a desired slot. 

The unit selection dialog box is displayed. 

3.  Select "Motion control" for "Unit type" and select the unit name used, and 
press the "OK" button. 

 
The selected unit is registered in the I/O map. 

 
4. Confirm the I/O map, and press the "OK" button. 

The unit selection dialog box is displayed. 
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4.2.2 Download of I/O map 

The created I/O map is downloaded to the CPU unit as part of configuration information. 
Perform the following operations on FPWIN GR7. 

 Download to the CPU unit 
The I/O map is saved in the CPU unit together with program data. Execute "Online" > 
"Download to PLC". 

4.2.3 Storage of I/O map 

The created I/O map is saved as project data as part of configuration information. Perform the 
following operations on FPWIN GR7. 

 Save as files 
• To save the I/O map as "Entire project", execute "Project" > "Save As". 

• To save only the "I/O map setting" information, press the "Save Setting" button in the "I/O 
map" setting dialog box. 

4.2.4 Confirmation of I/O Allocation 

• I/O numbers allocated to the unit are decided by registering them in the I/O map. 

• I/O numbers vary depending on the starting word number registered for the slot where the 
unit is installed. 

Example) When the starting word number is 10, the "link establishment flag" of FP7 MC Unit 
is X100, and "system stop request signal" is Y100. 

REFERENCE  
• For details, refer to "15.2 I/O Allocation". 
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4.2.5 Confirmation of Slot Numbers 

Slot numbers are decided by registering units in the I/O map. Slot numbers are used when 
reading or writing the values of unit memories by user programs. They are also used when 
performing the data monitoring on FPWIN GR7. 

 Slot number 
Slot numbers are decided by each installation position of units. They are counted from the unit 
closest to the CPU unit. 

2 3 161
C
P
U

●●●●●●

 

 Display on the I/O map of FPWIN GR7 
Slot numbers are specified in the "I/O map" dialog box of FPWIN GR7. 

 

 Using by user programs 
The following shows the case that reads values of unit memories using a user program. A slot 
number is specified at the beginning of a target operand. 

R0
S1:UM00086 S1:UM00089 WR106MV.US

X100
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4.3 Setting of Used Axes 

4.3.1 Registration of Used Axes 

Axes to be used in FP7 MC Unit are allocated by CMI. The following procedure is explained 
on the condition that FP7 MC Unit has been already allocated in the I/O map. 

PROCEDURE  
1. Select "Tools" > "Control Motion Integrator" from the menu bar of FPWIN 

GR7. 

The "Select Slot no." dialog box is displayed. 

 
2. Select the slot number and unit of the FP7 MC Unit that the setting is made, 

and press the [OK] button. 

"CMI" is activated, and the start dialog box is displayed. 

  
3. Press the [New] button. 

The "Axis settings" dialog box is displayed. 

 
(This is the 16-axis type. For the 32-axis and 64-axis types, see p.4-9.) 
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4. Select the axes to be used, and press the [OK] button. 

The dialog box for the interpolation operation group setting is displayed. When 
you do not set the interpolation operation, go to step 6. 

 
5. Drag the line to be allocated for interpolation to the interpolation group field. 

The following picture shows the allocations of "axes 1 and 2" to "group 1" and 
"axes 3 and 4" to "group 2" of interpolation groups. When removing the axes from 
the interpolation groups, right-click on the target axis in the "Interpolation group" 
field and execute "Clear". 

 
6. Press the [OK] button. 
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7. Confirm the change and press the [Yes] button. 

The data table is created in accordance with the setting content. The 
corresponding axis numbers are also displayed in the project tree. 

 

KEY POINTS
 

• When setting interpolation groups, setting items of the movement amount 
and interpolation opration are added to the data table, and the group 
numbers are displayed. 

• Closing the window with the X mark during editing displays a confirmation 
message. Press the [Yes] button to cancel and finish the operation. 
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 Axis settings dialog box (For MC32EC) 

  

 Axis settings dialog box (For MC64EC) 
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4.4 Setting of Network Configuration 

4.4.1 Registration of Slaves (Offline) 

Slaves connected to FP7 MC Unit are registered using the EtherCAT communication setting 
menu "EtherCAT Configurator" of CMI. The following procedure is explained on the condition 
that CMI has already started. 

PROCEDURE  
1. Select "Parameter" > "EtherCAT communication setting" from the menu bar. 

The "EtherCAT Configurator" window is displayed. 

 
2. Right-click on "FP7 Motion Control Unit" in the project explorer. 

The context menu is displayed. 

3. Select "Append Slave" from the context menu. 

The dialog box for selecting slaves is displayed. 
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4. Select slaves (servo amplifier form) to be used from the list. 

5. Input the number of slaves, and press the [OK] button. 

The registration state of the slaves (A5B) connected to FP7 MC Unit is displayed 
in the project explorer. The list shows the slaves in the connection order from the 
unit connected to FP7 MC Unit first. 

 
6. When there are multiple types of slaves (servo amplifier form), repeat steps 

2 to 5. 
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4.4.2 Registration of Slaves (Online) 

In FP7 MC Unit, the configuration of slaves connected to the network can be read and 
registered in online mode. The following procedure is explained on the condition that CMI has 
already started. 

PROCEDURE  
1. Turn on the power supplies of all servo amplifiers A5B connected to the 

network. 

2. Turn on the power of the FP7 MC system. 

The "EC L/A" LED of FP7 MC Unit turns on or blinks after the execution of 
EtherCAT communication between FP7 MC Unit and servo amplifiers A5B. 

3. Select "Parameter" > "EtherCAT communication setting" from the menu bar. 

The "EtherCAT Configurator" window is displayed. 

 
4. Right-click on "FP7 Motion Control Unit" in the project explorer. 

The context menu is displayed. 
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5. Select "Scan EtherCAT Network" from the context menu. 

FP7 MC Unit executes scanning the network. The information on the servo 
amplifiers A5B connected to FP7 MC Unit is displayed in the project explorer in 
the connection order. 

 

KEY POINTS
 

• It takes approximately 10 seconds for one axis to complete the scanning of 
EtherCAT network. 

• "Scan EtherCAT network" can be executed when the "EC L/A" LED on FP7 
MC Unit is lit or blinking. Possible situations are as follows. 

 Unit state and network scanning operation 
LEDs of FP7 MC Unit 

Possible case and confirmation method Network 
scanning EC L/A EC 

RUN ERR 

ON OFF ON 

"Network configuration verify error" occurs. In this case, 
even when the ERR LED is lit, the network scanning can 
be executed. 
This error also occurs when using FP7 MC Unit for the 
first time as the information on the network configuration 
is not downloaded to FP7 MC Unit. 

Executable 

Blinking ON ON 
"Network configuration verify error" may occur as the 
rotary switch on Servo Amplifier A5B is not set to "00". 
Set the rotary switch to "00" and restart the power supply. 

Not 
executable 

ON 
Blinking ON OFF 

The situation that the network configuration information 
has been downloaded and the number of connected 
servo amplifiers matches is possible. The network 
scanning can be executed. 

Executable 
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4.4.3 Setting of Station Addresses and Axis Numbers 

Once the information on devices connected to the network is displayed in the project explorer 
of EtherCAT Configurator, set the station addresses and axis numbers of servo amplifiers 
A5B.erCAT Configurator, set the station addresses and axis numbers of servo amplifiers A5B. 

 Explanation of terms 
Name Setting 

range Description 

Station address 1-192 ID of a slave used on the EtherCAT network. In the technical data of Servo 
Amplifier A5B, it is expressed as station alias (node ID). 

Axis number 
1-16 
1-32 
1-64 

It is linked with various functions set for each axis in CMI such as axis 
parameter setting, positioning table setting, and synchronous parameter setting. 
The start requests and flags used in user porgrams are determined based on 
the "axis numbers" set  in CMI. User programs are created using FPWIN GR7. 

 Procedure 
The following procedure is explained on the condition that slaves have already been 
registered in CMI. 

PROCEDURE  
1. Select an arbitrary slave (servo amplifier) in the project explorer. 

The slave information is displayed on the "General" tab in the "Device Editor" 
window. 

 
2. Input "Station Address" and "Axis No.". 

KEY POINTS
 

• When a station address is overlapped, an error message is displayed on 
EtherCAT Configurator of CMI. 

 

• When "Not use" is displayed in the project explorer, no "Axis no." is set. 
Change the used axis setting as necessary. When there is "Not use", an 
error occurs at the time of download. 

• When the number of axes specified in the used axis setting is more than the 
number of slave axes registered in the project explorer, the download is 
executed, however, "network configuration error" occurs when the power 
supplies of servo amplifier and FP7 MC Unit turn off and on. 
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 Setting example 
Although station addresses and axis numbers can be set arbitrarily, it is recommended to set 
the same numbers to facilitate the management. By default, station addresses are allocated in 
the connection order. 

No. Display of project explorer Configuration of devices 

① 

 

This shows the state the station addresses are the 
same as axis numbers, and set in the connection 
order. 

FP7MC A5B A5B A5B A5B

001 002 003 004
1 2 3 4

Station address
Axis number  

② 

 

This shows the state the station addresses are the 
same as axis numbers, and set in the reverse order 
of the connection. 

FP7MC A5B A5B A5B A5B

004 003 002 001
4 3 2 1

Station address
Axis number  

③ 

 

The station addresses do not match the axis 
numbers. 

FP7MC A5B A5B A5B A5B

003 001 002 004
2 3 4 1

Station address
Axis number  

KEY POINTS
 

• When closing EtherCAT Configurator of CMI, an error message is displayed 
if station addresses or axis numbers are duplicated. 
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4.4.4 Download to FP7 MC Unit 

Check the configuration of devices connected to the network, and download setting 
information to FP7 MC Unit after finishing the setting of station addresses and axis numbers. 
The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "File" > "Download to Unit" from the menu bar. 

A message confirming the target unit is displayed. 

 
2.  Confirm the message, and press the [Yes] button. 

When the CPU is in RUN mode, the following message is displayed. 

 
3.  Select a unit to which the setting data is downloaded, and press the "Yes" 

button. 

A message confirming whether to execute the writing to FROM is displayed. 
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4.  Press the [Yes] button to write data to the FROM in the unit, and press the 
[No] button not to perform the writing. 

When the processing is finished, the following message is displayed.  

 
5.  Press the [OK] button. 

The message for confirming the mode switching of the CPU unit is displayed. 

 
6.  Press the [Yes] or [No] button. 

KEY POINTS
 

• Execuitng "Writing to FROM" writes set parameters to the FROM in FP7 MC 
Unit. When the power turns on again, the parameters are read to the unit 
memory (RAM) from the FROM. 

• When "Write to FROM" is not executed, the set parameters are temporarily 
written to the unit memory (RAM) in the unit and used as data during 
operation. However, when the power turns on again, it is overwritten by the 
parameters written into the FROM. 

• It is also possible to execute "Online" > "Write to FROM" on CMI. 

• "Write to FROM" can also be executed by turning on the FROM write 
request (Y3) of user programs. However, we recommend using differential 
execution with this instruction to prevent the writing from being executed 
continuously. 

 
• Writing to FROM can be performed up to 10000 times. Do not write data to 

FROM more than 10000 times. 
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4.4.5 Restarting Power Supplies and Checking Communication State 

Download the parameters set by CMI to FP7 MC Unit, and then restart the power supplies for 
the system (Unit and Servo Amplifier). The setting is reflected and the communication is 
started. 

PROCEDURE  
1. Turn off the power supplies of FP7 MC Unit and Servo Amplifier A5B. 

2.  Turn on the power supply of Servo Amplifier A5B. 

3.  Turn on the power of FP7 MC Unit. 

EtherCAT communication is started between Servo Amplifier A5B and FP7 MC 
Unit. Once the communication is executed and the link is established properly, 
the both "EC RUN" LEDs turn on. 

4.  Confirm that no error occurs. 

When an error occurs, the ERR LED on FP7 MC Unit turns on. 

KEY POINTS
 

• The connection state of the network can be checked by monitorng the unit 
memories. The informatin on abnormal slaves is stored in the unit 
memories (UM 0012E-UM 00139). 

• When the configuration is different from the network configuration set by 
CMI, an error occurs. 

• The participation wait time for the nodes (slaves) connected to the 
EtherCAT network can be set in the "MC common setting" menu of CMI 
after the power-on of FP7 MC Unit. 
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 Unit memories (Slave tables) 

Slave no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 000FE 

Registered 
slave table H0 Turns on bits corresponding to each station address 

(slave number) registered in ENI file.  - 
17-32 UM 000FF 

- - 

177-192 UM 00109 

1-16 UM 0010A 
Network 
participating 
slave table 

H0 
Turns on the bits corresponding to each station 
address (slave number) in the OP mode out of the 
slaves participating in the network. 

 - 
17-32 UM 0010B 

- - 

177-192 UM 00115 

1-16 UM 00122 

Normal 
slave table H0 

Turns on bits corresponding to each station address 
(slave number) in the OP mode out of the slaves 
registered in ENI file and participating in the 
network. 

 - 
17-32 UM 00123 

- - 

177-192 UM 0012D 

1-16 UM 0012E 

Abnormal 
slave table H0 

Turns on bits corresponding to each station address 
(slave number) in any modes other than the OP 
mode out of the slaves registered in ENI file and 
participating in the network. 

 - 
17-32 UM 0012F 

- - 

177-192 UM 00139 

(Note 1): Sixteen slave numbers are allocated to each area (1 word). 
bit no.15 08 7

9 1816 ● ● ● ● ●● ● ● ● ●Slave no.
25 172432 ● ● ● ● ●● ● ● ● ●

41 334048 ● ● ● ● ●● ● ● ● ●

57 495664 ● ● ● ● ●● ● ● ● ●

73 657280 ● ● ● ● ●● ● ● ● ●

89 818896 ● ● ● ● ●● ● ● ● ●

105 97104112 ● ● ● ● ●● ● ● ● ●

121 113120128 ● ● ● ● ●● ● ● ● ●

137 129136144 ● ● ● ● ●● ● ● ● ●

153 145152160 ● ● ● ● ●● ● ● ● ●

169 161168176 ● ● ● ● ●● ● ● ● ●

185 177184192 ● ● ● ● ●● ● ● ● ●
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4.5 Connection of Limit and Near Home Switches 

4.5.1 Connection of Input Signals 

For the system which uses the over limit switches and near home switch, connect them to the 
I/O connector (X4) of Servo Amplifier A5B. 

AMP

Near home
switch

Over limit
switch

Over limit
switch

 

 I/O connector (X4): Allocation of functions at the factory setting 
X4 connector Function at the factory setting 

Application on the FP7 MC Unit 
side Name Pin 

no. Signal name Code Logic 

SI1 5 General-purpose 
monitor input 5 SI-MON5 A contact It can be only monitored by the unit 

memories.. 

SI2 7 CW over-travel inhibit 
input POT B contact 

Do not allocate POT or NOT. 
SI3 8 CCW over-travel 

inhibit input NOT B contact 

SI4 9 Near home input HOME A contact It is used as a near home input. 

SI5 10 External lutch input 1 EXT1 A contact It can be only monitored by the unit 
memories.. SI6 11 External lutch input 2 EXT2 A contact 

SI7 12 General-purpose 
monitor input 3 SI-MON3 A contact It is used as limit +. 

SI8 13 General-purpose 
monitor input 4 SI-MON4 A contact It is used as limit -. 

(Note 1): The above table shows the allocation before shipment. It varies according to the setting of PANATERM. 

KEY POINTS
 

• When using FP7 MC Unit in combination with Servo Amplifier A5B, the 
general-purpose inputs (SI-MON3 and SI-MON4) are used as limit inputs. For 
using the general-purpose monitor inputs (SI-MON3 and SI-MON4) as limit 
inputs, the setting of the limit switch should be set to "A: Enabled" in the 
"Axis parameter setting" menu  of CMI. 

• The over-travel inhibit inputs (POT, NOT) cannot be used as the limit inputs 
on the MC Unit side. Do not allocate the over-travel inhibit inputs (POT, 
NOT) to the I/O connector (X4) of Servo Amplifier A5B. 
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4.5.2 Pin Assignment Setting of Servo Amplifier 

The allocation of I/O connector (X4) and input logic is set by PANATERM. The following 
procedure is explained on the condition that PANATERM has already started. 

PROCEDURE  
1. Select "Other" > "Pin Assign" from the toolbar. 

The "Pin Assign" dialog box is displayed. 

 
2.  Double-click the row "Pin number 07 (SI2)" to which "POT" is allocated. 

The "Input function select" dialog box is displayed. 

 
3.  Select the row "Invalid", and press the [OK] button. 

The change result can be confirmed in the "Pin Assign" dialog box.  

4.  Repeat steps 2 and 3 for "NOT: Pin number 08 (SI3)". 

5.  When changing the input logics of limit and near home switches, go to step 
6. When they are not changed, go to step 10. 

6.  Double-click the row in which the general-purpose monitor input "SI-MON3" 
is allocated. 

The "Input function select" dialog box is displayed. 

7.  Confirm "SI-MON3" is selected, switch the three radio buttons from "A-
Connect" to "B-Connect", and press the [OK] button. 
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The change result can be confirmed in the "Pin Assign" dialog box.  

8.  Repeat the same operations in steps 6 and 7 for "SI-MON4", too. 

9.  When changing the input logic of near home switch, repeat the same 
operations. 

10. Press the "Apply" button in the "Pin Assign" dialog box. 

A confirmation message is displayed. 

 
11. Press the [OK] button. 

A confirmation message is displayed. 

 
12.  Press the [Yes] button. 

Writing to the EEPROM to the servo amplifier is executed. 
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KEY POINTS
 

• When FP7 MC Unit is being controlled, the following message is displayed. 

 

4.5.3 Checking Servo Amplifier Input State 

After the completion of the pin assign setting of Servo Amplifier, operate the connected limit 
inputs and near home inputs forcibly and check the input states. The input states can be 
checked on PANATERM. 
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4.5.4 Settings of FP7 MC Unit 

To enable the limit function, the axis parameter "Limit input" in CMI should be set to be 
enabled. Also, the input logic should be confirmed on CMI. 

 Settings related to Limit switch 

 
Parameter name Default Description 

Limit switch N: Disabled 
When using the limit switch function or the home return function 
using limit switches, select "A: Enabled". 
N: Disabled, A: Enabled 

Limit switch 
connection S: Standard 

When the arrangement of the connected "limit switch +" and "limit 
switch -" is opposite to the input state loaded to the unit, select "R: 
Reverse connection". 
S: Standard, R: Reverse connection 

Limit + Switch logic 1: Normal Close 
(B contact) 

Select the input logic of the limit swtiches. 
0: Normal Open (A contact), 1: Normal Close (B contact) Limit - Switch logic 

KEY POINTS
 

• In the system using FP7 MC Unit, limit switches are connected to the 
general-purpose inputs (SI-MON3 and SI-MON4) of Servo Amplifier A5B. 
When the "Limit switch" is set to "Enabled" in the above parameter, the 
state of the general-purpose inputs (SI-MON3 and SI-MON4) of Servo 
Amplifier A5B is reflected as the limit inputs of FP7 MC Unit. 

• It is recommended to select "Normal Open (A contact)" for "Limit + Switch 
logic" and "Limit - Switch logic". The input logic selected on the servo 
amplifier A5B is reflected as is. 

REFERENCE  
• For details of the axis parameter settings, refer to "5.2 Axis Parameter 

Setting". 
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 Setting of Home position proximity logic 

 
Parameter name Default Description 
Home position 
proximity logic 

Normal Open  
(A contact) 

The near home input logic is selected. 
0: Normal Open (A contact), 1: Normal Close (B contact) 

KEY POINTS
 

• It is recommended to select "Normal Open (A contact)" for "Home position 
proximity logic". The input logic selected on Servo Amplifier A5B is 
reflected as is. 

4.5.5 Download to FP7 MC Unit 

Once the settings of limit switches and input logic is completed in CMI, download the 
parameter information to FP7 MC Unit. 

REFERENCE  
• For details of the downloading method, refer to "4.4.4 Download to FP7 MC 

Unit". 

4.5.6 Checking Input State 

After the completion of the settings, operate the limit inputs and near home inputs connected 
to the servo amplifier forcibly, checker that they can be monitored on the FP7 MC Unit side. 

• They can be monitored by the status monitor or unit memories (input control area). 

• The unit memories of FP7 MC Unit can also be monitored when FP7 CPU Unit is in PROG. 
mode. 
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4.6 Saving and Managing Files 

4.6.1 File Type 

The set parameters and positioning table information can be saved or exported in the 
following four formats. 

File name Extension Application Operation 

Configurator CMI file .cmi 

The whole parameters of FP7 MC Unit are saved. 
 EtherCAT communication parameters 
 Setting of positioning parameters 
 Setting of positioning tables 

Save 
Open 

Project file .ecc Project files (EtherCAT communication parameters) 
created by EtherCAT Configurator in CMI are saved. 

Save 
Open 

ENI file .xml ENI files created by EtherCAT Configurator in CMI are 
exported/imported. 

Export 
Import 

CSV file .csv The whole parameters of FP7 MC Unit are exported in 
csv format. They can be used for checking parameters. Export 

4.6.2 Saving as CMI Files 

Set parameters and positioning table information can be saved and opened on CMI. The 
saved data can also be reused in multiple units and projects. 

PROCEDURE  
1. Select "File" > "Save As" from the menu bar. 

The "Save As" dialog box is displayed. 

2. Enter a saving destination and file name, and press [Save] button. 

Information on parameters and positioning tables is saved as files with the 
extension (.cmi). 

KEY POINTS
 

• The files saved by the above operations contain the information on all 
parameters and positioning tables set on CMI. 
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4.6.3 Export to CSV Files 

The information on set parameters and positioning tables can be exported in csv format. It is 
possible to open the csv files and check the settings of each parameter and positioning table.. 

PROCEDURE  
1. Select "File" > "Export to CSV" from the menu bar. 

The "Export to CSV" dialog box is displayed. 

 
2. Input an output file name, and press the [OK] button. 

CSV files with given file names are saved for each parameter. 
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5.1 MC Common Settings 

5.1.1 MC Common Settings Dialog Box 

In the "MC common settings" dialog box, The EtherCAT communication cycle and the 
operations when errors occur are set. The following procedure is explained on the condition 
that CMI has already started. 

PROCEDURE  
1. Select "Parameter" > "MC common settings" from the menu bar. 

The "MC common settings" dialog box is displayed. 

 
2. Set necessary parameters in accordance with the intended use. 

KEY POINTS
 

• Although the data being edited is held until finishing CMI even when the 
dialog box is closed with the X mark during the editing, save parameters by 
executing "File" > "Save As" as necessary. 
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5.1.2 MC Common Settings Parameters 

The Parameters common to the unit, such as error judgement conditions and operation when 
errors occur, are set. 

 MC operation 
Parameter name Default Description 

Threshold of the number 
of times of PDO error 
judgement 

3 

The EtherCAT communication error judgement threshold is set. 
When the error occurs for the specified number of times 
consecutively, it is judged as EtherCAT communication error. 
Range: 1 to 10 (times) 

All nodes participation 
wait time (s) 60 

The participation wait time for slaves connected to EtherCAT 
network after MC Unit is powered on is set. Error occurs when a 
node does not participate in the network after the elapse of the 
specified time.  
Range: 1 to 240 (s) 

Operation when an error 
occurs All axes stop 

The operation performed when an error occurs in axes (nodes) 
connected to the network is set. 

All axes stop Stops all axes operations. 

Normal axis 
operation 
continuance 
(Degraded 
operation) 

Stops the operation of the axis an error 
occurred. The operations of normal axes 
continue. 

Deceleration stop 
operation 

Deceleration 
stop 

The function when the deceleration stop request of unit memories 
(output control area) turns on is set. 
Deceleration stop / Pause 

RUN->PROG. operation Deceleration 
stop 

The operation when the operation mode of CPU unit changes 
from RUN to PROG is set. 

Operation 
continuance The operation of each axis continues. 

Deceleration 
stop 

Each axis decelerates and stops in a 
specified deceleration stop time in the current 
control mode. 

Immediate stop Each axis decelerates and stops in a 
specified emergency stop deceleration time. 

Error alarm to CPU unit Yes 

The error annunciation method to FP7 MC Unit when an error 
occurs is set. 

Yes Announces errors to the CPU unit. 

No Not announce errors to the CPU unit. 

Interpolation operation 
control_P-point operation 

Allow 
directional 
shift 

Set whether or not to allow the shift between the moving direction 
(vector) to a target point from the operation starting point and the 
moving direction (vector) to the next target point during the P-
point operation of interpolation operation control. 

Allow 
directional shift 

P-point operation continues even when the 
moving direction is displaced. 

Not allow 
directional shift 

Operation is performed by replacing P point 
with C point when the moving amount shifts. 

Tool operation monitoring 
time (s) 10 

The communication timeout period between CMI and FP7 MC 
Unit is set. 
Range: 1 to 240 (s) 

 
  To the next page 
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 EtherCAT communication 
Parameter name Default Description 
EtherCAT communication 
cycle (µs) 500 Select the EtherCAT communication cycle. 

500 / 1000 / 2000 / 4000 (µs) 

(Note): Set the EtherCAT communication cycle in accordance with the following contents. The installation condition is 
the case by our measurement condition. 

Control method No. of used axes Setting value 

Single axis control 
Interpolation control 

Up to 16 axes From 500 [µs] 

Up to 32 axes From 1000 [µs] 

Up to 64 axes From 2000 [µs] 

Synchronous control 

Up to 16 axes From 1000 [µs] 

Up to 32 axes From 2000 [µs] 

Up to 64 axes From 4000 [µs] 

 Debug function 
Parameter name Default Description 

EC packet monitor 
request flag setting Disabled 

The operation of packet monitor request flag of EC(EtherCAT) 
communication is set. 

Disabled Packet monitor is not executed when the EC 
packet monitor request flag turns ON. 

Enabled Packet monitor is executed when the EC 
packet monitor request flag turns ON. 

Execute EC Packet 
Monitor after Power ON Not executed 

The operation of the EC (EtherCAT) packet monitor when FP7 
MC Unit is powered on is set. 

Not executed EC packet monitoring is not executed after 
the power turns on. 

Executed EC packet monitoring is executed after the 
power turns on. 

REFERENCE  
• For details of "EC packet monitor" function, refer to "13.9 EC Packet 

Monitor Function". 
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5.2 Axis Parameter Settings 

5.2.1 Setting by CMI 

The parameters common to each axis, such as the motor rotation direction and the logics of 
home input and limit input, are set by CMI. The following procedure is explained on the 
condition that CMI has already started. 

PROCEDURE  
1. Select "Parameter" > "Axis parameter settings" from the menu bar. 

The "Axis parameter settings" dialog box is displayed. 

 
2.  Set necessary parameters in accordance with the intended use. 

3. Select "File" > "Save As" from the menu bar. 

4. Enter an arbitrary file name, and press the [Save] button. 

KEY POINTS
 

• Although the data being edited is held until finishing CMI even when the 
dialog box is closed with the X mark during the editing, save parameters by 
executing "File" > "Save As". 
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5.2.2 Axis Parameters (Basic Setup) 

 Basic setup 
Parameter name Default Description 

Comment Blank Arbitrary comments can be input. However, they cannot be 
written into the unit. 

Positioning repeat count 0 The number of repetitions of positioning control is set. 
Range: 0 to 255 (times) 

Unit setting P：pulse 

The units for specifying position command values and speed 
command values are set. 
P: pulse 
M: μm  [Min 0.1], M: μm  [Min 1] 
I: inch [Min 0.00001 inches]、I: inch [Min  0.0001 inches ] 
D: degree [Min 0.1], D: degree [Min 1] 

Number of pulses per 
revolution 1 

Only when the unit is set to um, inch, or degree, the pulse 
number and movement amount per rotation are set. Movement per 

revolution 1 

CW/CCW direction 
setting 

0: CW direction 
+ 

0: CW direction +: Set the direction that an elapsed value is + as 
CW. 
1: CCW direction +: Set the direction that an elapsed value is + 
as CCW. 

Limit switch N: Disabled 
When using the home return function using the limit switches or 
using the limit stop function, select "A: Enabled". 
N: Disabled, A: Enabled 

Limit switch connection S: Standard 

When the arrangement of the connected "limit +" and "limit -" is 
opposite to the input state loaded to the unit, select "R: Reverse 
connection". 
S: Standard, R: Reverse connection 

Limit + Switch logic 1: Normal Close 
(B contact) 

Select the input logic of the limit swtiches. 
0: Normal Open (A contact), 1: Normal Close (B contact) Limit - Switch logic 

KEY POINTS
 

• In FP7 MC Unit, CW refers to the rotating direction with a count increase 
and CCW refers to the direction with a count decrease. Therefore, limit input 
in the CW direction is limit + input and that in the CCW direction is limit -. 

• In the system using FP7 MC Unit, limit switches are connected to the 
general-purpose inputs (SI-MON3 and SI-MON4) of Servo Amplifier A5B. 
When the "Limit switch" is set to "Enabled" in the above parameter, the 
state of the general-purpose inputs (SI-MON3 and SI-MON4) of Servo 
Amplifier A5B is reflected as the limit inputs of FP7 MC Unit. 

• It is recommended to select "Normal Open (A contact)" for "Limit + Switch 
logic" and "Limit - Switch logic". The input logic selected on the servo 
amplifier A5B side is reflected as is. 
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5.2.3 Axis Parameters (Options) 

These parameters are set according the used functions. 

 Software limit setting 
Parameter name Default Description 
Software limit (Positioning 
control) N: Disabled 

Select whether to enable or disable the software limit when 
executing the positioning control, home return or JOG operation. 
N: Disabled, A: Enabled 

Software limit (Home 
return) N: Disabled 

Software limit (JOG 
operation) N: Disabled 

Software limit Upper limit 
value 2147483647 

Set the upper or lower limit of the software limit. 
Software limit Lower limit 
value -2147483648 

 Auxiliary output setting 
Parameter name Default Description 

Auxiliary output mode N: Not use 
Select the operation mode of auxiliary output contact and 
auxiliary output code. 
N: Not use, W: With mode, D: Delay mode 

Auxiliary output ON time 
(ms) 10 Set the time period that auxiliary output contact is ON. 

Range: 0 to 255 ms 

Auxiliary output Delay 
ratio (%) 0 

When using the delay mode for the auxiliary output, specify the 
ratio to output. 
Range: 0 to 100 % 

 Monitor setting 
Parameter name Default Description 

Movement check 
operation 2: None 

Select the operation when exceeding the movement amount 
automatic check threshold. 
0: Error, 1: Warning, 2: None 

Movement check value 
(pulse) 10000 

Set the threshold for the movement amount automatic check 
operation. 
Range: 0 to 65535 pulses 

Monitor error  
- Torque judgment N: Disabled 

Select the operation of FP7 MC Unit when the torque value of the 
amplifier is monitored and exceeds the judgement value. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error  
- Torque judgment value 
(%) 

500.0 Set the torque judgement value. 
Range: 0 to 500.0 (%) 

Monitor error  
- Actual speed judgement N: Disabled 

Select the operation of FP7 MC Unit when the actual speed of the 
amplifier is monitored and exceeds the judgement value. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error  
- Actual speed judgement 
value (rpm) 

5000 Set the actual speed judgement value. 
Range: 0 to 5000 rpm 

REFERENCE  
• For details of each function of software limit, auxiliary output and monitor 

setting, refer to "13 Supplementary Functions".  
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5.2.4 Axis Parameters (Operation) 

Common parameters to each axis related to operations are set. 

 Home return setting 
Parameter name Default Description 

Return setting code 0: DOG method 1 

Select the pattern of home return. 
0:DOGmethod 1 (Based on front end + Z phase) 
1: DOG method 2 (Based on front end) 
2: DOG method 3 (Based on back end + Z phase) 
9: DOG method 4 (Based on back end) 
3: Limit method 1 (Limit signal + Z phase) 
4: Limit method 2 (Limit signal) 
5: Z-phase method 
6: Stop-on-contact method 1 
7: Stop-on-contact method 2 (Stop-on-contact + Z phase) 
8: Data set method 

Home position 
proximity logic 

Normal Open  
(A contact) 

Select the near home input logic. 
Normal Open (A contact) 
1: Normal Close (B contact) 

Stop-on-cotnact 
torque value (%) 100 

This parameter is used for selecting the stop-on-contact method 
as the home return method. It is regarded as a criterion for 
judging the home return once the torque value of the servo 
amplifier exceeded this set value by the stop-on-contact. 
Range: 0.0 to 500.0 (%) 

Stop-on-contact 
judgment time (ms) 100 

This parameter is used for selecting the stop-on-contact method 
as the home return method. When using the stop-on-contact 
method, it is regarded as a criterion for judging the home return 
once this set time has passed after the torque value of the servo 
amplifier exceeded the stop-on-contact torque value. 
Range: 0 to 10000 (ms) 

Return direction 0: Limit (-) 
direction 

Select the operation direction of home return. 
0: Elapsed value decreasing direction (Limit - direction) 
1: Elapsed value increasing direction (Limit "+" direction) 

Return acceleration 
time (ms) 100 Set the acceleration time when performing the home return. 

Range: 0 to 10000 (ms) 

Return deceleration 
time (ms) 100 Set the deceleration time when performing the home return. 

Range: 0 to 10000 (ms) 

Return target speed 1000 Set the target speed when performing the home return. 
Range: 1 to 32767000 

Return creep speed 100 
Set the creep speed to search the home position in the home 
return operation. 
Range: 1 to 32767000 

Home coordinates 0 
Set the home coordinates to be set after the completion of the 
home return. 
Range: -2147483648 to +2147483647 

KEY POINTS
 

• It is recommended to select "Normal Open (A contact)" for "Home position 
proximity logic". The input logic selected on Servo Amplifier A5B is 
reflected as is. 
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 JOG operation setting 
Parameter name Default Description 

Acceleration/deceleration 
pattern setting 

0: Linear acceleration/ 
deceleration 

Select the acceleration/deceleration pattern when 
performing the JOG operation. 
0: Linear acceleration/deceleration 
1: S-shaped acceleration/deceleration 

JOG acceleration time 
(ms) 100 

Set the acceleration time when performing the JOG 
operation. 
Range: 0 to 10000 (ms) 

JOG deceleration time 
(ms) 100 

Set the deceleration time when performing the JOG 
operation. 
Range: 0 to 10000 (ms) 

JOG target speed 1000 Set the target speed for performing the JOG operation. 
Range: 1 to 32767000 

JOG operation - Inching 
movement 1 

Set the movement amount when starting JOG inching 
operation. 
Range: 1 to 2147483647 

 Stop function setting 
Parameter name Default Description 
Emergency stop 
deceleration time (ms) 100 Set the deceleration time at the time of emergency stop. 

Range: 0 to 10000 (ms) 

Limit stop deceleration 
time (ms) 100 Set the deceleration time at the time of limit stop. 

Range: 0 to 10000 (ms) 

Error stop deceleration 
time (ms) 100 Set the deceleration time at the time of error stop. 

Range: 0 to 10000 (ms) 

 J-point operation setting 
Parameter name Default Description 

Operation setting code 0: Linear acceleration/ 
deceleration 

Select the acceleration/deceleration pattern when 
performing the J-point control 
0: Linear acceleration/deceleration 
1: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 
Sets the acceleration time when performing the J-point 
control. 
Range: 0 to 10000 (ms) 

Deceleration time (ms) 100 
Sets the deceleration time when performing the J-point 
control. 
Range: 0 to 10000 (ms) 

Target speed 1000 
Set the target speed when performing the J-point 
control. 
Range: 1 to 32767000 

REFERENCE  
• For details of the home return operation, refer to "11 Manual Operation 

(Home Return)". 

• For details of the JOG operation, refer to "10 Manual Operation (JOG 
Operation)". 

• For details of the stop functions, refer to "12 Stop Functions". 

• For details of the J-point control, refer to "8.1.5 Setting and Operation of J-
point Control". 
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5.3 Positioning Table Setting 

5.3.1 Construction of Positioning Tables 

Positioning tables are assigned using CMI. The following procedure is explained on the 
condition that CMI has already started. 

 Positioning table setting screen of CMI 
• Sheets are divided for each axis, and 1000 tables ranging no. 1 to no. 1000 can be set. 

• By double-cliking an arbitrary axis of the project tree in CMI, the positioning data table opens. 

• When setting the interpolcation control, the cell for "Interpolation operation" as a selection 
item is added between Operation pattern and Control method. Also, the input cells for 
Movement amount and Auxiliary point are added according to the number of axes. 

 
In the above example, the real axes 1 to 16 and virtual axes 1 to 8 are displayed. 

REFERENCE  
• For details of each control, refer to "8 Automatic Operation (Position 

Control)". 
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 Setting items (Common) 
Parameter 
name Default Description 

Operation pattern E: End point Select one from the following operation patterns. 
E: End point, C: Continuance point, P: Pass point, J: Speed point 

Control method I: Increment Select the control method. 
I: Increment, A: Absolute 

1st axis (n) 
Movement 
amount 

0 

Input the movement amount (position command value). The movement 
amount depends on the unit system specified in the parameter settings. 
Axis numbers are displayed in (L). 
Range: -2147483648 to 2147483647 

Acceleration/ 
deceleration type L: Linear Select the acceleration/deceleration method. L: Linear, S: S shape 

Acceleration time 
(ms) 100 Set the acceleration time. Range: 1 to 10000 (ms) 

Deceleration time 
(ms) 100 Set the deceleration time. Range: 1 to 10000 (ms) 

Target speed 1000 Set the target speed. Range: 1 to 32767000 
Unit: pps, µm/s, inch/s, rev/s 

Dwell time [ms] 0 

Set the time from the completion of the positioning instruction in theE-point 
control until the positioning done flag turns ON. For the C-point control, it is 
the wait time between each table. For the P-point control, the dwell time is 
ignored. 

Auxiliary output 0 Set the auxiliary output code. When the auxiliary output is set to be enabled 
in the parameter settings, the auxiliary output code specified here is output. 

Comment - Arbitrary comments can be input for each table. However, they cannot be 
written into the unit. 

 Setting items (Additional items for 2-axis interpolation) 
Parameter 
name Default Description 

Interpolation 
operation 

0: Linear 
(Composite 
speed) 

Select one from the following operation patterns. 
0: Linear (Composite speed), 1: Linear (Long axis speed), S: Circular 
(Center piont/CW direction), T: Circular (Center point/CCW direction), U: 
Circular (Pass point). 

1st axis (L) 
Movement 
amount 

0 

Input the movement amount (position command value). The auxiliary point 
is input for hte circular interpolation. 
The axis numbers allocated to interpolation groups are displayed in (L) and 
(m) in the ascending order from the smaller number. 

1st axis (L) 
Auxiliary point 0 

2nd axis (m) 
Movement 
amount 

0 

2nd axis (m) 
Auxiliary point 0 
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 Setting items (Additional items for 3-axis interpolation) 
Parameter 
name Default Description 

Interpolation 
operation 

0: Linear 
(Composite 
speed) 

Select one from the following operation patterns. 
0: Linear (Composite speed), 1: Linear (Long axis speed), A: Spiral (Center 
point/ CW direction/1st axis movement), B: Spiral (Center point/CCW 
direction/1st axis movement), C: Spiral (Center point/CW direction/2nd axis 
movement), D: Sprial (Center point/CCW direction/2nd axis movement), E: 
Spiral (Center pont/CW direction/3rd axis movement), F: Spiral (Center 
point/CCW direction/3rd axis movement), L: Spiral (Pass point/1st axis 
movement), M: Spiral (Pass pont/2nd axis movement), N: Spiral (Pass 
point/3rd axis movement) 

1st axis (L) 
Movement 
amount 

0 

Input the movement amount (position command value). The auxiliary point 
is input for hte spiral interpolation. 
The axis numbers allocated to interpolation groups are displayed in (L), (m) 
and (n) in the ascending order from the smaller number. 

1st axis (L) 
Auxiliary point 0 

2nd axis (m) 
Movement 
amount 

0 

2nd axis (m) 
Auxiliary point 0 

3rd axis (n) 
Movement 
amount 

0 

3rd axis (n) 
Auxiliary point 0 
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5.3.2 Operation Patterns and Tables 

• Use a number of tables if the positioning patterns consist of P-point control (pass point 
control), C-point control (continuance point control), and J-point control (JOG positioning 
control). 

• In these types of control, the tables are created continuously on CMI, and "E-point control" is 
selected for the operation pattern for the last table. 

• Start requests are made by specifying the starting data table numbers for each control in 
user programs. 

Example) When performing three-speed positioning control by P-point control (speed 
change control) 

Create three positioning tables, and select "E:End point" for the last table. Also, start requests 
are made by specifying the starting table numbers in user programs. 

 

 

REFERENCE  
• For details of each control, refer to "8 Automatic Operation (Position 

Control)". 
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5.4 Synchronous Parameter and Cam Pattern Settings 

5.4.1 Synchronous Parameter Settings 

Parameters required for the synchronous control are assigned using CMI. The following 
procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select and double-click the axis for setting the parameters from the project 

tree. 

The synchronous parameter dialog box is displayed. 

  
2. Set necessary parameters in accordance with the intended use. 

REFERENCE  
• For details of the methods of setting parameters related to synchronous 

control, refer to "9 Automatic Operation (Synchronous Control)". 
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5.4.2 Cam Pattern Setting 

Make electronic cam settings in the case of using an electronic cam. Necessary parameters 
are assigned using CMI. The following procedure is explained on the condition that CMI has 
already started. 

PROCEDURE  
1. Select "Parameter" > "Cam pattern setting" from the menu bar. 

The cam pattern setting dialog box is displayed. 

 
2. Set necessary parameters in accordance with the intended use. 

KEY POINTS
 

• The saved parameter information can be read on CMI. 

• In the case of synchronous control, it also operates according to the 
parameters specified in "5.2 Axis Parameter Setting". 
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5.5 Confirmation of Setting Contents 

5.5.1 Check on Parameter Data 

The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "Debug" > "Check parameters and data values" from the menu bar. 

A message box is displayed to show the check result. 

(In normal state) (In abnormal state) 

  

2.  Press the [OK] button. 

The screen returns to the editing screen of CMI. 

5.5.2 Comparison of Parameter Information 

The following items can be verified using CMI. 

• Verifying the data being edited with saved cmi files 

• Verifying the data being edited with the unit memory (RAM) data in the unit 

The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "Debug" > "Compare" > "File" or "Unit" from the menu bar. 

When "File" is selected, the "Select verification file" dialog box is displayed. 

When "Unit" is selected, the "Verify - Unit selection" dialog box is displayed. 

 

2.  Select a target (file or unit) to be verified, and press the [OK] button. 

The verification result is displayed. 
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(In normal state) (In abnormal state) 

  

3.  Press the [Close] button. 

The screen returns to the editing screen of CMI. 

KEY POINTS
 

• When selecting "Unit" for the verification target, the contents of the unit 
memories (RAM) in the unit are verified. The contents of the FROM in the 
unit may not match the contents of the unit memories (RAM). 
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5.6 Transfer of Parameters 

5.6.1 Writing Parameters to Unit 

The set parameter information is downloaded to the memory of FP7 MC Unit. The following 
procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "File" > "Download to Unit" from the menu bar. 

A confirmation message is displayed. 

 
2.  Confirm the message, and press the [Yes] button. 

When the CPU is in RUN mode, the following message is displayed. 

 
3.  Select a unit to which the setting data is downloaded, and press the [Yes] 

button. 

The FROM confirmation message is displayed. 
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4.  Press the [Yes] button to write data to the FROM in the unit, and press the 
[No] button not to perform the writing. 

When the processing is finished, the following message is displayed.  

 
5.  Press the [OK] button. 

The message for confirming the mode switching of the CPU unit is displayed. 

 
6.  Press the [Yes] or [No] button. 

KEY POINTS
 

• Execuitng "Writing to FROM" writes set parameters to the FROM in FP7 MC 
Unit. When the power turns on again, the parameters are read into the unit 
memory (RAM) from the FROM. 

• When "Write to FROM" is not executed, the set parameters are temporarily 
written to the unit memories (RAM) in the unit and used as data during 
operations. However, when the power turns on again, they are overwritten 
by the parameters written into the FROM. 

• It is also possible to execute "Online" > "Write to FROM" on CMI. 

• "Write to FROM" can also be executed by turning on the FROM write 
request (Y3) of user programs. However, we recommend using differential 
execution with this instruction to prevent the writing from being executed 
continuously. 

 
• Writing to FROM can be performed up to 10000 times. Do not write data to 

FROM more than 10000 times. 
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6.1 Before Turning On the Power 
System configuration example 

1

32

4
5

AMP

Power supply

Power supply

Power supply for I/O

Over limit
switch

Over limit
switch

  

 Items to check before turning on the power 
No. Item Description 

①  Checking connections to 
the various devices 

Check to make sure the various devices have been connected as 
indicated by the design. 

②  Checking the servo 
amplifier Check the wiring of servo amplifier and parameter settings. 

③  Checking the installation of 
the safety circuit 

Check the connection between the servo amplifier and over limit 
switches. Check the installation condition of the over limit switches. 
Check if the limit input can be monitored on PLC. 

④  
Checking the procedure 
settings for turning ON the 
power supplies 

Check to make sure settings have been entered so that power supplies 
are turned on according to the procedure outlined in the section 
"Procedure for Turning On the Power" on the next page. 

⑤  

Setting configuration data Check if the parameters and positioning data are configured in MC Unit 
as designed. 

Checking the CPU mode 
selection switch 

Set the CPU unit to PROG. mode. Setting it in RUN mode can cause 
inadvertent operation. 

Checking user programs 
Create programs to turn off the start request of each operation when 
switching the mode to RUN mode. If they are on, they may activate 
improperly. 
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6.2 Procedure for Turning On the Power 

6.2.1 Procedure for Turning On the Power 

When turning on the power to the system incorporating the unit, consider the nature and 
states of any external devices connected to the system, and take sufficient care so that 
turning on the power will not initiate unexpected movements. 

PROCEDURE  
1. Turn on the power supplies for the input and output devices connected to 

the PLC. 

2. Turn on the power supply for the servo amplifier. 

3. Turn ON the power supply for the PLC. 

6.2.2 Procedure for Turning Off the Power 

PROCEDURE  
1. Check to make sure the rotation of the motor has stopped, and then turn off 

the power supply for the PLC. 

2. Turn off the power supply for the servo amplifier. 

3. Turn off the power supplies for the input and output devices connected to 
the PLC. 
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6.3 Checking While the Power is ON 

6.3.1 Items to Check When the Power is ON 

System configuration example 

Check each item in the following four major steps. 

21 3

4

AMP

Near home
switch

Over limit
switch

Over limit
switch

 

 Items to check after turning on the power 
No. Item Description 

① Checking the 
communication state 

Check if the communication between P7 MC Unit and Servo Amplifier is 
performed properly. 

② Checking the safety circuit 
by the PLC unit 

Check the connection between the servo amplifier and over limit 
switches. Check the installation condition of the over limit switch. Check 
if the over limit switch is loaded as the limit input of FP7 MC Unit and 
activated properly by performing JOG operation. 

③ Checking the near home 
input 

Check the connection between the servo amplifier and near home 
input. Check the installation condition of the near home input. Check if 
the near home input is loaded as the near home input of FP7 MC Unit 
and activated properly by performing JOG operation or home return 
operation. 

④ 
Checking the rotation, 
moving direction, and 
moving distance. 

Check the rotation, moving direction and moving distance by performing 
JOG operation or positioning operation. 
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6.3.2 Checking Network Communication State 

Procedure 1 
Turn on the powers of the servo amplifier and FP7 MC Unit in this order, and check if no error 
occurs. 

Procedure 2 
If an error occurs, check if the settings agree with the actual network configuration on CMI. 

Points to check 
After turning on FP7 MC Unit, the time until slaves participate in the network can be confirmed 
and changed in the axis parameter setting menu of CMI. 
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6.3.3 Checking the safety circuit by the PLC unit 

Procedure 1 
Check if the input of the over limit switches connected to the servo amplifier is loaded to the 
unit by operating them forcibly. 

Points to check 
Check if the limit setting is Enabled, input logic is correct in the parameter setting menu of 
CMI. 

Procedure 2 
Check if the limit stop is activated at the time of limit input by the tool operation function of 
CMI or performing the JOG operation with a program. 

Procedure 3 
Using the JOG operation, check if the over limit switch is functioning properly. 

 Operation at Over limit input (Limit is Enabled) 
Condition Direction Limit status Operation 

When JOG operation is 
started 

Forward 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Executable 

Reverse 
Over limit input (+): ON Executable 

Over limit input (-): ON Not executable, Error occurs. 

During JOG operation 
Forward Over limit input (+): ON Limit stops, Error occurs. 

Reverse Over limit input (-): ON Limit stops, Error occurs. 
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6.3.4 Checking the Operation of Near Home Switch 

Procedure 1 
Check if the near home input is loaded as an input signal on the PLC properly by operating 
the input forcibly. 

Procedure 2 
Start the home return by the tool operation function of CMI or inputting the home return 
program, and check if the operation transits to the deceleration operation by the near home 
input. 

Points to check 
The logic of near home input depends on the settings of Servo Amplifier and FP7 MC Unit. 

Procedure 3 
Check if the home stop position shifts by repeating the JOG and home return operations. 

Procedure 4 
If the home stopping position is shifted, change the position of near home input or reduce the 
home return speed. 

6.3.5 Checking Rotating and Moving Directions and Moving Distance 

Procedure 1 
Execute the JOG operation to confirm the rotating direction and moving direction of the motor. 
Use the tool operation function of CMI and perform the JOG operation. 

Points to check 
The rotating direction is determined according to the installation of the ball screw or the 
"CW/CCW direction setting" of the axis parameter. 

Procedure 2 
Check if the moving distance is that as designed by performing the JOG operation or 
positioning operation. 

Points to check 
The moving distance is determined according to the pitch of the ball screw, deceleration gear 
ratio or setting movement amount of the positioning data. 
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6.4 Monitor Function of CMI 

6.4.1 Status Monitor 

• The connection state of each axis and input state of external terminals can be monitored. 

• The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "Online" > "Status Monitor" from the menu bar. 

The status monitor dialog box is displayed. 
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 Monitoring item 

Item Description Related 
page 

Revision Indicates the revision number of Servo Amplifier A5B.  

Station address Indicates the station address of Servo Amplifier A5B allocated to each 
axis.  

Connection status 
Indicates the connection status of each axis. 
Not connected / During stop / During operation / Warning occurs / Error 
occurs 

 

Servo ready 
Indicates the servo ready status on the servo amplifier side. 
Ready (Green): Indicates that the servo is ready. 
Off (White): Indicates the servo is off. 

 

Home position 
proximity 

Indicates the status of the near home input (HOME). 
Near home (Green): Indicates the input is valid. 
Off (White): Indicates the input is invalid. 

 

Limit + 
Indicates the status of the limit input. Monitored signals vary according 
to the settings of "Axis parameter settings" of FP7 MC Unit. 
Limit + (Green) or limit - (Green): Indicates the input is enabled. 
Off (White): Indicates the input is disabled. 

 
Limit - 

FROM write count Indicates the number of times of writing to FROM in FP7 MC Unit. 
Writing can be performed up to 10000 times.  

Firmware version Indicates the firmware version of FP7 MC Unit.  

Hardware version Indicates the hardware version of FP7 MC Unit.  

KEY POINTS
 

• The input logics of the near home, limit + and limit - depend on the settings 
of Servo Amplifier A5B and FP7 MC Unit. 

• The target limit inputs to be monitored vary according to the settings of axis 
parameters as below. Confirm them with CMI. 
Parameter 
name Selection Description 

Axis parameters 
- Basic setup 
- Limit switch 

N: Disabled 
Indicates the POT/NOT status of Servo Amplifier A5B. 
Limit +: POT (CW over-travel inhibit input) 
Limit -: NOT (CCW over-travel inhibit input) 

A: Enabled 
Indicates the SI-MON3/SI-MON4 status of Servo Amplifier A5B. 
Limit +: SI-MON3 (General-purpose monitor input 3) 
Limit -: SI-MON4 (General-purpose monitor input 4) 
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6.4.2 Data Monitor 

The operating state can be monitored. 

PROCEDURE  
1.  Select "Online" > "Data Monitor" from the menu bar. 

The data monitor dialog box is displayed. 

 

KEY POINTS
 

• If a recoverable error occurs in FP7 MC Unit, click the [Clear errors] button 
to clear the error. 

• If a warning occurs in FP7 MC Unit, click [Clear warning] to clear the 
warning. 

• The difference between the value of the position specified in FP7 MC and 
the value of the position fed back from Servo Amplifier A5B is calculated on 
the FP7 MC Unit side as a deviation. This value is not the same as the value 
of the deviation counter of the servo amplifier. 
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 Monitoring item 

Item Description Related 
page 

Control mode Displays the control mode. 
Positioning control / J-point control / Home return / JOG operation  

Synchronous 
master axis 

When an axis has been set as master axis, "Master" is displayed. 
When an axis has been set as slave axis, the master axis which this axis 
follows is displayed. Example) When the second axis has been set as a 
slave axis for the master of first axis, "1 axis" is displayed in the column of 2 
axis. 
For axes that are not used for the synchronous control, "--------" is displayed. 

9.2 Settings 
for Master 
and Slave 
Axes 

Synchronous 
output 

Displays the functions of synchronous operation that have been set for slave 
axes. 
Gear, Clutch, Cam 
Gear+Clutch, Gear+Cam, Clutch+Cam 
Gear+Clutch+Cam 
For axes that are not used for the master axes and synchronous control, "---
-----" is displayed. 

9.1 
Synchronous 
Control 

Synchronous 
state 

Displays the states (synchronous/asynchronous) that have been set for 
each axis.  

Table number 
executing 

Displays the table number that the positioning data is being executed or has 
been executed.  

Auxiliary output 
code 

When the auxiliary output function is enabled, output code is output within 
the range of 0 to 65535. 

13.3 Auxiliary 
Output Code 
and Auxiliary 
Output 
Contact 

Repeat count 
current value Displays the current value of the repeat count. 

8.3 Repeat 
Function 

Repeat count When setting to repeat operations, the repeat count is displayed ( 0 to 255). 
When this function is not set, the repeat count is "0". 

Current value 
(pulse) 

Displays the current value of FP7 MC Unit. It will return to "0" on the 
completion of home return. 13.4 Current 

Value Update 
13.5 Home 
Coordinates 

Unit conversion 
current value 

Displays the unit-converted current value of FP7 MC Unit. 
It will return to "0" on the completion of home return. When the home 
coordinate has been set, it will be preset to the home coordinate on the 
completion of home return. 

Deviation 
The difference value between the value of the position specified in FP7 MC 
Unit and the value of the position fed back from the amplifier is stored. 
In the case of virtual axes, "------" is displayed. 

 

Torque value 
(%) Displays the current value of the torque value.  

Actual speed 
(rpm) Displays the current value of the actual speed.  

Axis state Displays "During operation" or "During stop". 
Displays "Error occurs" when an error occurs.  

Error code Displays the latest error code when an error has occurred.  
Pressing the "Clear errors" button clears errors. 

 
Warning code Displays the latest warning code when a warning has occurred. 

Pressing the "Clear warning" button clears warnings. 
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6.5 Tool Operation Function of CMI 

6.5.1 Tool Operation Function 

You can perform commissioning with CMI before actually starting user programs. The 
following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "Online" > "Tool Operation" from the menu bar. 

A confirmation message is displayed. 

 
2.  Press the [Yes] button. 

The "Tool operation" dialog box is displayed. 
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 Type of tool operation 
Item Description 
Serve 
ON/OFF Specify the servo ON/OFF setting for each axis. 

Home 
return 

A home return is performed to the home of the machine coordinates according to the specified 
parameter. 

Positioning Moves from the start table number according to the set contents of the positioning table. 

JOG 
operation 

The specified axis can be moved to the specified direction at the specified speed while the 
operation command is on. 

Teaching Controls the axis manually like JOG operation, and reflects the resulting positioning address on 
the data editing screen. 

KEY POINTS
 

• The unit cannot go into the tool operation while the unit is operated with a 
user program. 

• Operation requests using unit memories (output control area) are disabled 
during the tool operation. 

• If any communication error occurs during the tool operation, FP7 MC Unit 
will detect the error and stop automatically. Also, if the previous tool 
operation does not finish properly due to any error such as communication 
error, the tool operation mode will be cancelled forcibly when the next tool 
operation starts. Exit the operation once, and start the tool operation again. 
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6.5.2 Serve ON/OFF with Tool Operation Function 

The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1 Select "Online" > "Tool Operation" from the menu bar. 

The "Tool operation" dialog box is displayed. 

2. Select "Servo ON/OFF" in the "Tool operation" dialog box. 

The "Servo ON/OFF" dialog box is displayed. 

 
3.  Select a desired axis, and press the [Change ON/OFF] button. 

The state is switched between servo lock and servo free. 

  
4. Confirm the servo ON/OFF states of arbitrary axes, and press the "Exit" 

button. 

This returns to the "Tool operation" dialog box. 



6.5 Tool Operation Function of CMI 

 
6-15 

KEY POINTS
 

• If the servo ON/OFF has been controlled using user programs, the servo-
lock or servo-free state before the start of the tool operation is kept and the 
operation shifts to the tool operation. 

• The servo-lock or servo-free state before the completion will be kept even 
after finishing the tool operation mode. 
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6.5.3 JOG Operation with Tool Operation Function 

• You can perform commissioning with CMI before actually starting user programs. 

• The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "Online" > "Tool Operation" from the menu bar. 

The "Tool operation" dialog box is displayed. 

2.  Select "JOG operation" from the tool operation dialog box. 

The "Tool operation - JOG operation" dialog box is displayed. 

 
3.  Press [+] or [-] button in the JOG field. 

The JOG operation is executed. 

4.  Press [Exit] button to terminate the JOG operation. 
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KEY POINTS
 

• If a recoverable error occurs in FP7 MC Unit, click the [Clear errors] button 
to clear the error. 

• If a warning occurs in FP7 MC Unit, click [Warning clear] to clear the 
warning. 

 Items of dialog box 

Item Description Related 
page 

Synchronous 
master axis 

When an axis has been set as master axis, "Master" is displayed. 
When an axis has been set as slave axis, the master axis which this axis 
follows is displayed. Example) When the second axis has been set as a slave 
axis for the master of first axis, "1 axis" is displayed in the column of 2 axis. 
For axes that are not used for the synchronous control, [- - - - - -] is displayed. 

9.2 Settings 
for Master 
and Slave 
Axes 

Synchronous 
output 

The functions of synchronous operation that have been set for slave axes are 
displayed. 
Gear, Clutch, Cam 
Gear+Clutch, Gear+Cam, Clutch+Cam 
Gear+Clutch+Cam 
For axes that are not used for the master axes and synchronous control, [- - - - 
- -] is displayed. 

9.1 
Synchronous 
Control 

Synchronous 
state 

The states (synchronous/asynchronous) that have been set for each axis are 
displayed. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

 

Current value 
Displays the current value after the unit system conversion. Click [Current 
value update] to display the dialog for inputting value to change the preset 
value. 

13.4 Current 
Value Update 

Unit The units of position for each axis specified in the parameter settings are 
displayed.  

Deviation 
(pulses) 

The difference value between the value of the position specified in FP7 MC 
Unit and the value of the position fed back from the amplifier is stored. For 
virtual axes, [- - - - - -] is always displayed. 

 

JOG target 
speed 

Monitors and displays the target speed in the JOG operation. Click [Change] 
to change the target speed for the JOG operation. 

10.1 Setting 
and 
Operation of 
Home Return 
10.3 Setting 
and 
Operation of 
JOG Inching 
Operation 

Inching 
movement The inching movement amount is set. 

Inching Check the box for performing the inching operation. 

JOG [+] Click [+] to perform the forward rotation of the JOG operation. 

JOG [-] Click [-] to perform the reverse rotation of the JOG operation. 

Axis state 
Displays "During operation" or "During stop". 
Displays "Error occurs" when an error occurs. 
Displays "Warning occurs" when a warning occurs. 

 

Error code Displays the latest error code when an error has occurred.  
Pressing the "Clear errors" button clears errors. 

 
Warning code Displays the latest warning code when a warning has occurred. 

Pressing the "Clear warning" button clears warnings. 

Speed rate 

The target speed of the JOG operation specified in the parameter settings for 
each axis is regarded as 100%, and the operation is executed in the specified 
speed rate. Clicking [Change Speed Rate] shows the dialog for inputting the 
value. 
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6.5.4 Home Return by Tool Operation Function 

• When the power is turned on, the coordinates of FP7 MC Unit do not coincide with those of 
the machine position. Execute a home return before starting positioning. 

• You can perform commissioning with CMI before actually starting user programs. 

• The following procedure is explained on the condition that CMI has already started. 

PROCEDURE  
1.  Select "Online" > "Tool Operation" from the menu bar. 

The "Tool operation" dialog box is displayed. 

2.  Select "Home Return" from the tool operation dialog box. 

The "Tool operation - Home return " dialog box is displayed. 

 
3.  Click [Start] for the axis to execute the home return. 

Execute the home return operation. 

4.  Press [Exit] button to terminate the home return operation. 
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KEY POINTS
 

• If a recoverable error occurs in FP7 MC Unit, click the [Clear errors] button 
to clear the error. 

• If a warning occurs in FP7 MC Unit, click [Warning clear] to clear the 
warning. 

• This dialog box cannot be closed during the operation. 

 Items of dialog box 

Item Description Related 
page 

Synchronous 
master axis 

When an axis has been set as master axis, "Master" is displayed. 
When an axis has been set as slave axis, the master axis which this axis 
follows is displayed. Example) When the second axis has been set as a slave 
axis for the master of first axis, "Axis 1" is displayed in the column of Axis 2. 
For axes that are not used for the synchronous control, [- - - - - -] is displayed. 

9.2 Settings 
for Master 
and Slave 
Axes 

Synchronous 
output 

The functions of synchronous operation that have been set for slave axes are 
dipslayed. 
Gear, Clutch, Cam 
Gear+Clutch, Gear+Cam, Clutch+Cam 
Gear+Clutch+Cam 
For axes that are not used for the master axes and synchronous control, [- - - - 
- -] is displayed. 

9.1 
Synchronous 
Control 

Synchronous 
state 

The states (synchronous/asynchronous) that have been set for each axis are 
displayed. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

 

Current value 
Displays the current value after the unit system conversion. Click [Home 
position coordinate] to display the dialog box for inputting value to change the 
value after home return. 

13.5 Home 
Coordinates 

Unit The units of position for each axis specified in the parameter settings are 
displayed.  

Deviation 
(pulses) 

The difference value between the value of the position specified in FP7 MC 
Unit and the value of the position fed back from the amplifier is stored. For 
virtual axes, [- - - - - -] is always displayed. 

 

Home return 
mode 

Displays the content of the home return setting code registered in the 
positioning setting data.  

Start/Stop 

Executes the operation to start/stop the home return. 
- Click [Start] to execute the home return operation. The button name changes 
to [Stop]. 
- Click [Stop] to execute the deceleration stop operation. The button name 
changes to [Start]. 

 

Axis state 
Displays "During operation" or "During stop". 
Displays "Error occurs" when an error occurs. 
Displays "Warning occurs" when a warning occurs. 

 

Error code Displays the latest error code when an error has occurred.  
Pressing the "Clear errors" button clears errors. 

 
Warning code Displays the latest warning code when a warning has occurred. 

Pressing the "Clear warning" button clears warnings. 

Speed rate 

The target speed of the home return specified in the parameter settings for 
each axis is regarded as 100%, and the operation is executed in the specified 
speed rate. Clicking [Change Speed Rate] shows the dialog for inputting the 
value. 
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6.5.5 Positioning by Tool Operation Function 

Specifying a starting table number enables to check if positioning from the starting table 
operates properly. 

PROCEDURE  
1.  Select "Online" > "Tool Operation" from the menu bar. 

The "Tool operation" dialog box is displayed. 

2.  Select "Positioning" from the tool operation dialog box. 

The "Tool operation - Positioning" dialog box is displayed. 

 
3.  Press the [Change] button under the target start table number field. 

The starting table no. setting dialog box is displayed. 

4.  Input a starting table number. 

5.  Press the [Operate] button. 

Positioning starts from the specified start table number. 

6.  Press [Exit] button to terminate the positioning operation. 
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 Items of dialog box 

Item Description Related 
page 

Synchronous 
master axis 

When an axis has been set as master axis, "Master" is displayed. 
When an axis has been set as slave axis, the master axis which this axis 
follows is displayed. Example) When the second axis has been set as a 
slave axis for the master of first axis, "Axis 1" is displayed in the column of 
Axis 2. 
For axes that are not used for the synchronous control, [- - - - - -] is 
displayed. 

9.2 Settings 
for Master 
and Slave 
Axes 

Synchronous 
output 

The functions of synchronous operation that have been set for slave axes 
are dipslayed. 
Gear, Clutch, Cam 
Gear+Clutch, Gear+Cam, Clutch+Cam 
Gear+Clutch+Cam 
For axes that are not used for the master axes and synchronous control, [- - 
- - - -] is displayed. 

9.1 
Synchronous 
Control 

Synchronous 
state 

The states (synchronous/asynchronous) that have been set for each axis 
are displayed. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

 

Repeat count 
current value Displays the current value of the repeat count. 8.3 Repeat 

Function 
Repeat count Displays the setting value of the repeat count. 

Current value 
Displays the current value after the unit system conversion. Click [Current 
value update] to display the dialog for inputting value to update the current 
value. 

13.4 Current 
Value Update 

Unit The units of position for each axis specified in the parameter settings are 
displayed.  

Deviation 
(pulse) 

The difference value between the value of the position specified in FP7 MC 
Unit and the value of the position fed back from the amplifier is stored. For 
virtual axes, [- - - - - -] is always displayed. 

 

Table number 
executing Displays the table number during the operation or when it completes. 

 
Start table 
number 

The starting table number for the positioning control. 
Click [Change] to change the starting table number. 

Operate/Stop 

Execute the operation to start/stop the home return. 
- Click [Operate] to execute the positioning operation. The button name 
changes to [Stop]. 
- Click [Stop] to execute the deceleration stop operation. The button name 
changes to [Operate]. 

 

Axis state 
Displays "During operation" or "During stop". 
Displays "Error occurs" when an error occurs. 
Displays "Warning occurs" when a warning occurs. 

 

Error code Displays the latest error code when an error has occurred.  
Pressing the "Clear errors" button clears errors. 

 
Warning code Displays the latest warning code when a warning has occurred. 

Pressing the "Clear warning" button clears warnings. 

Speed rate 
The target speed specified in the parameter settings for each axis is 
regarded as 100%, and the operation is executed in the specified speed 
rate. Clicking [Change Speed Rate] shows the dialog for inputting the value. 
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KEY POINTS
 

• Even in the tool operation, the unit operates in accordance with the data of 
the positioning table downloaded to FP7 MC Unit. The operations after the 
starting table number vary depending on operation patterns. 

• If a recoverable error occurs in FP7 MC Unit, click the [Clear errors] button 
to clear the error. 

• If a warning occurs in FP7 MC Unit, click [Clear warning] to clear the 
warning. 

• The positioning operation of an interpolation group starts and stops the 
axis with the smallest number in the group. In the case of the tool operation 
function, the "Operate" buttons other than that for the smallest axis number 
cannot be pressed  

• This dialog box cannot be closed during the operation. 

• When conditions are changed during the tool operation, the operation 
continues by updating the unit memories temporarily, however, the 
changes are not reflected in the configuration data written in the FROM 
within FP7 MC Unit. Therefore, when the power is turned on again, the unit 
is booted based on the cofniguration data written in the FROM within FP7 
MC Unit. 
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6.5.6 Teaching by Tool Operation Function 

Activate each axis manually by the tool operation, and register the positioning addresses 
where each axis stops as the point data. 

PROCEDURE  
1.  Select "Online" > "Tool Operation" from the menu bar. 

The "Tool operation" dialog box is displayed. 

2.  Select "Teaching" from the tool operation dialog box. 

The "Tool operation - Teaching" dialog box is displayed. 

 
3.  Stop at the positioning point by the JOG operation. 

4.  Press the [Teaching] button. 

5.  Input the table number where the desired positioning information is 
registered, and click the [OK] button. 

The current value is registered for the amount of movement of the table number 
specified. Also, if the axis that the teaching operation is performed is an 
interpolation axis, the current value is registered for the movement amount of the 
equivalent coordinate in the interpolation group. 

6.  Press [Exit] button to terminate the teaching operation. 
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 Items of dialog box 

Item Description Related 
page 

Synchronous 
master axis 

When an axis has been set as master axis, "Master" is displayed. 
When an axis has been set as slave axis, the master axis which this axis 
follows is displayed. Example) When the second axis has been set as a 
slave axis for the master of first axis, "Axis 1" is displayed in the column of 
Axis 2. 
For axes that are not used for the synchronous control, [- - - - - -] is 
displayed. 

9.2 Settings 
for Master 
and Slave 
Axes 

Synchronous 
output 

The functions of synchronous operation that have been set for slave axes 
are dipslayed. 
Gear, Clutch, Cam 
Gear+Clutch, Gear+Cam, Clutch+Cam 
Gear+Clutch+Cam 
For axes that are not used for the master axes and synchronous control,  
[- - - - - -] is displayed. 

9.1 
Synchronous 
Control 

Synchronous 
state 

The states (synchronous/asynchronous) that have been set for each axis 
are displayed. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

 

Current value 
Displays the current value after the unit system conversion. Click [Current 
value update] to display the dialog for inputting value to change the preset 
value. 

13.4 Current 
Value Update 

Unit The units of position for each axis specified in the parameter settings are 
displayed.  

Deviation 
(pulses) 

The difference value between the value of the position specified in FP7 MC 
Unit and the value of the position fed back from the amplifier is stored. For 
virtual axes, [- - - - - -] is always displayed. 

 

JOG target 
speed 

Monitors and displays the target speed in the JOG operation. 
Click [Change] to change the target speed for the JOG operation. 10.1 Setting 

and 
Operation of 
Home Return 

JOG [+] Click [+] to perform the forward rotation of the JOG operation. 

JOG [-] Click [-] to perform the reverse rotation of the JOG operation. 

Table number Displays the table number to perform the teaching. Click [Teaching] to 
change the table number for the teaching and register the current value.  

Axis state 
Displays "During operation" or "During stop". 
Displays "Error occurs" when an error occurs. 
Displays "Warning occurs" when a warning occurs. 

 

Error code Displays the latest error code when an error has occurred.  
Pressing the "Clear errors" button clears errors. 

 
Warning code Displays the latest warning code when a warning has occurred. 

Pressing the "Clear warnings" button clears warnings. 

Speed rate 

The target speed of the JOG operation specified in the parameter settings 
for each axis is regarded as 100%, and the operation is executed in the 
specified speed rate. Clicking [Change Speed Rate] shows the dialog for 
inputting the value. 
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KEY POINTS
 

• If a recoverable error occurs in FP7 MC Unit, click the [Clear errors] button 
to clear the error. 

• If a warning occurs in FP7 MC Unit, click [Clear warning] to clear the 
warning. 

• The control method for the table number that the teaching operation was 
performed is automatically changed to “Absolute”. 

• The result of the teaching becomes effective once the tool operation quits 
and the setting data is downloaded to FP7 MC Unit. 

• This dialog box cannot be closed during the operation. 
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7.1 How to Create User Programs 

7.1.1 Basic Configuration of Program 

The user programs which control FP7 MC Unit are created by the tool software "FPWIN GR7". 

• To support the multi-axis control through network, for FP7 MC Unit, main input and output 
signals required for the control are allocated to the unit memories (input control area/output 
control area). 

• For various controls, the processes of reading flags from unit memories (input control area) 
and wriitng operation results to unit memories (output control area) are created as programs. 

• As exceptions, the "link establishment flag (X0)" for storing the link establishment of network 
and "system stop request (Y0)" for stopping the whole system are allocated to the area of 
I/O signals (XY). 

 

 Configuration of program 
 Item Description 

①  
Reading from unit 
memories UM (input 
control area) 

Reads information required for confirming states from the unit memories (input 
control area) to an arbitrary operation memories (such as internal relay area 
WR). 
Example) Connection confirmation flag, servo lock annunciation flag, busy flag, 
error annunciation flag 

②  Servo control Ouputs the requests for the servo ON and servo OFF controls to the operation 
memories (such as internal relay area WR). 

③  Start enabled control 
Checks the states of read flags if each control (such as position control, JOG 
operation, home return) can be started, and outputs the start enabled states to 
internal relays. 

④  
Various control 
programs (such as 
position control, JOG 
operation, home return) 

Checks the results of start enabled controls, and outputs the start requests for 
position control, JOG operation or home return to the operation memories (such 
as internal relays). 

⑤  
Writing to unit 
memories UM (output 
control area) 

Writes the results of the operation memories (such as internal relay area) in 
which the above operation results are reflected to the unit memories (output 
control area).  
Example) Startup of positioning, JOG operation, or home return, stop control 



7.1 How to Create User Programs 

 
7-3 

 Program example 
The following program is simplified to show the whole configuration. The reading data from 
the input control area is inserted in the beginning of the program, and the writing data to the 
output control area is inserted at the end of the program. 

R4060R1100

Axis 1 Servo 
ON request

②

Axis 1 Servo 
lock 

annunciation

R100

Servo ON

R4060

Axis 1 Servo 
ON request

（ ）DF

SR14

①

WR106BKMV.US S1:UM00089S1:UM00086

WR158BKMV.US S1:UM000BFS1:UM000BA

WR110BKMV.US S1:UM0008DS1:UM0008A

1-16
Connection 
confirmation

1st scan OFF 49-64
Connection 
confirmation

1-16
Connection 
confirmation

1-16
Servo lock 
annunciation

49-64
Servo lock 
annunciation

1-16
Error occurrence

Virtual 17-32
Error occurrence

R4180R110 R1160

Axis 1 Start 
enabled flag Axis 1 

Positioning Start

Axis 1 Busy 
annunciation

X100

Link 
Establish-

ment

R120

Position control 
start

R4180

Axis 1 
Positioning Start

（ ）DF

⑤

SR14
S1:UM00186BKMV.US WR409WR406

1st scan OFF

X100

Link 
Establish-

ment

1-16
Servo ON

49-64
Servo ON

1-16
Servo ON

X100 X104

Link 
Establish-
ment

Tool 
operation

R1060 R1100

Axis 1 
Connection 
confirmation

Axis 1 
Servo lock 

annunciation

R1580

Axis 1 Error 
occurrence

R110

Axis 1 Start 
enabled flag

③

（ ）DF
R120

S1:UM00990DT110MV.US
Axis 1 Position 

control starting table
Position control 
start

④
Position 
control 

starting table

R4120R1100R101

Servo OFF

R4120

Axis 1 Servo OFF

（ ）DF

S1:UM0018CBKMV.US WR415WR412
1-16
Servo OFF

49-64
Servo OFF

1-16
Servo OFF

S1:UM00192BKMV.US WR423WR418
1-16
Positioning start

Virtual 17-32
Positioning start

1-16
Positioning start

Axis 1 Servo OFFAxis 1 Servo 
lock 

annunciation

1-16
Servo lock 
annunciation

1-16
Error occurrence

 

 



Creation of User Programs 

7-4 
 

7.2 Overview of Programs 

7.2.1 Reading Data From Input Control Area 

• The reading program from the unit memories (input control area) reads and stores flags in 
the operation memories such as internal relays to enable them to be treated easily in 
consecutive control programs.  

• Most flags are allocated to 1-word (16-bit) unit memory for 16 axes. As for the limit inputs, 2 
bits (+ and - sides) are required for 1 axis, therefore, flags for 8 axes are allocated to 1-word 
(16-bit) unit memory. 

SR14
WR106BKMV.US S1:UM00089S1:UM00086

WR116BKMV.US S1:UM00095S1:UM00090

WR110BKMV.US S1:UM0008DS1:UM0008A

1-16
Connection 
confirmation

1st scan 
OFF

1-16
Servo lock 
annunciation

1-16
Busy 
annunciation

Virtual 17-32
Busy 
annunciation

X100

Link 
establish-

ment

WR128BKMV.US S1:UM000A1S1:UM0009C

WR122BKMV.US S1:UM0009BS1:UM00096
1-16
Operation done

Virtual 17-32
Operation done

1-16
Home return

Virtual 17-32
Home return

WR164BKMV.US S1:UM000C5S1:UM000C0

WR158BKMV.US S1:UM000BFS1:UM000BA
1-16
Error occurrence

Virtual 17-32
Error occurrence

1-16
Warning 
occurrence

Virtual 17-32
Warning 
occurrence

49-64
Connection 
confirmation

49-64
Servo lock 
annunciation

 

REFERENCE  
• For details of the configuration and contents of input control area, refer to 

"15.4.1 Configuration of Input Control Area" and "15.4.3 List of Input Control 
Area Functions". 
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7.2.2 Servo ON/OFF Control Program 

• The servo ON/OFF is controlled by writing requests into the unit memories (output control 
area). 

• Create a program to turn on each bit of the unit memories allocated to the servo ON request 
signal or servo OFF request signal. The part of the following ○2E

A indicates the control program 
of axis no. 1. 

SR14

①WR110BKMV.US S1:UM0008DS1:UM0008A
1-16
Servo lock 
annunciation

49-64
Servo lock 
annunciation

1-16
Servo lock 
annunciation

X100

⑤

SR14
S1:UM00186BKMV.US WR409WR406

X100

1-16
Servo ON 
request

49-64
Servo ON 
request

1-16
Servo ON 
request

S1:UM0018CBKMV.US WR415WR412
1-16
Servo OFF 
request

49-64
Servo OFF 
request

1-16
Servo OFF 
request

R4060R1100

Axis 1 Servo 
ON request

②

Axis 1 Servo 
lock 

annunciation

R100

Servo ON

R4060

Axis 1 Servo 
ON request

（ ）DF

R4120R1100

Axis 1 Servo 
OFF

Axis 1 Servo 
lock 

annunciation

R101

Servo OFF

R4120

Axis 1 Servo 
OFF

（ ）DF

1st scan 
OFF

Link 
establish-

ment

1st scan 
OFF

Link 
establish-

ment

 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Servo lock annunciation UM0018A UM0018B UM0018C UM0018D - - 
Servo ON request UM00186 UM00187 UM00188 UM00189   
Servo OFF request UM0018C UM0018D UM0018E UM0018F - - 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●

 



Creation of User Programs 

7-6 
 

7.2.3 Start Enabled Program 

• The start enabled control program is inserted to check flags read from the unit memories 
(input control area) to confirm if each consecutive control (such as position control, JOG 
operation and home return) can be started. 

• Collected start conditions are output as arbitrary start enabled flags (internal relays). 

SR14
WR106BKMV.US S1:UM00089S1:UM00086

WR158BKMV.US S1:UM000BFS1:UM000BA

WR110BKMV.US S1:UM0008DS1:UM0008A

R110X100 X104 R1060 R1100 R1580

Axis 1 Start 
enabled flag

1st scan OFF

X100

Link 
establish-

ment

Program of each control (such as positioning control, JOG operation, and home return)

1-16
Connection 
confirmation

49-64
Connection 
confirmation

1-16
Connection 
confirmation

1-16
Servo lock 
annunciation

49-64
Servo lock 
annunciation

1-16
Error occurrence

Virtual 17-32
Error occurrence

1-16
Servo lock 
annunciation

1-16
Error occurrence

Link 
Establish-
ment

Tool 
operation

Axis 1 
Connection 
confirmation

Axis 1 
Servo lock 

annunciation

Axis 1 Error 
occurrence

 

7.2.4 Each Control Programs 

Each control programs (such as position control, JOG operation and home return) operates 
the start requests which require the output result of the above start enabled program. 

REFERENCE  
• For details of poritioning control programs, refer to "8.4.1 Sample Programs 

(E-point, C-point and C-point Controls)". 

• For details of JOG operation programs, refer to "10.4.1 Sample Program 
(JOG Operation)". 

• For details of home return programs, refer to "11.3.1Sample Program (Home 
Return)". 
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7.2.5 Writing Data to Output Control Area 

• The values of the operation memories (such as WR) in which the results operated in each 
control program are reflected are written to the unit memories (output control area). 

• Most flags are allocated to 1-word (16-bit) unit memory for 16 axes. As for JOG operation, 2 
bits (forward anc reverse) are required for 1 axis, therefore, flags for 8 axes are allocated to 
1-word (16-bit) unit memory. 

SR14
S1:UM00186BKMV.US WR409WR406

S1:UM00192BKMV.US WR423WR418

S1:UM0018C BKMV.US WR415WR412

1-16
Servo ON request

49-64
Servo ON request

1-16
Servo OFF

49-64
Servo OFF

1-16
Positioning start

Virtual 17-32
Positioning start

X100

S1:UM0019EBKMV.US WR441WR430

S1:UM00198BKMV.US WR429WR424
1-16
Home return start

Virtual 17-32
Home return start

1-16
JOG operation 
start

Virtual 25-32
JOG operation 
start

S1:UM001B0BKMV.US WR453WR448

S1:UM001AABKMV.US WR447WR442
1-16
Inching operation

Virtual 17-32
Inching operation

1-16
Emergency stop

Virtual 17-32
Emergency stop

S1:UM001B6BKMV.US WR459WR454
1-16
Deceleration 
stop

Virtual 17-32
Deceleration 
stop

S1:UM001C8BKMV.US WR477WR472
1-16
Error clear 
request

Virtual 17-32
Error clear 
request

S1:UM001CEBKMV.US WR483WR478
1-16
Warning clear

Virtual 17-32
Warning clear

1st scan 
OFF

Link 
establish-

ment

 

REFERENCE  
• For details of the configuration and contents of output control area, refer to 

"15.4.2 Configuration of Output Control Area" and "15.4.4 List of Output 
Control Area Function". 
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7.3 Precautions On Programming 

7.3.1 Turning Off Power Supply Clears Contents in Unit Memories 

• Data in unit memories are cleared when the power is turned off. 

• When the powe is turned on again, data is preset in the parameters saved in the FROM 
within FP7 MC Unit. 

7.3.2 Operation Cannot be Switched Once One Operation Has Started 

• If any of the startup requests for position control, synchronous control, JOG operation and 
home return turns ON and the operation is initiated, this operation cannto be switched to 
another operation even if another request turns on. 

• Busy flags corresponding to each axis turn on during operation. Insert them as interlock 
signals for each start request on user programs. 

• The stop operations (system stop, limit stop, emergency stop and deceleration stop) are 
preferentially activated even in other operations. 

7.3.3 Operation When PLC Mode Changes From RUN To PROG. 

The operation when the mode of the CPU unit changes from RUN to PROG. varies depending 
on the setting of "RUN > PROG operation" of "MC common setting". 
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8.1 Basic Operation 

8.1.1 Patterns of Position Control 

• The automatic operation is an operation mode to be perform a position control. For the 
position control, there are a single axis control and an interpolation control that starts and 
stops multiple axes simultaneously. 

• For the operaions of position controls, there are E-point, P-point and C-point controls which 
are performed regardless of single axis control or interpolation axis control. Also, there is J-
point control which is activated only by the single axis control. The operation patterns of 
each control are as follows. 

 Operation pattern 

Name Time chart Operation and application Repeat 
Inter-
pola-
tion 

E
-p

oi
nt

 c
on

tro
l 

t

f

E

 

 This is a method of control which is 
initiated up to an end point, and is 
called “E-point control". 

 This method is used for a single-
speed acceleration/deceleration. 

  

P
-p

oi
nt

 c
on

tro
l 

t

f

P
E

 

t

f

P E
P

 

 This refers to control which passes 
through a “Pass Point”, and is called 
“P-point control”. 
 This method is used for performing 
acceleration/deceleration by two-
speed control or more. 
 After the P-point control is 
performed for a specified movement 
amount, it shifts to the E-point control. 
 The last table should be set to E: 
End point. 

  

C
-p

oi
nt

 c
on

tro
l 

t

f

C
E

 

t

f

C E
C

 

 This refers to control which passes 
through a “Continuance Point”, and is 
called "C-point control”. 
 This method is used for performing 
two successive single-speed 
positioning control with different target 
speeds or acceleration/deceleration 
times. 
 The time taken until the operation 
shifts to the next table is specified as 
a dwell time. 
 The last table should be set to E: 
End point. 

  
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Name Time chart Operation and application Repeat 
Inter-
pola-
tion 

J-
po

in
t c

on
tro

l 

No speed change 

t

f

J E

①

 

 This refers to control which passes 
through a speed point “JOG Operation 
Point”, and is called "J-point control”. 
 After the start, it is controlled at 
specified speeds. 
 Once the J-point positioning 
request turns on, the positioning 
control (E-point control) starts. 
 When the J-point speed change 
request is set, the speed changes. 

① J-point positioning start request 

② J-point speed change contact 

 The last table should be set to E: 
End point. 

－ － Speed changes 

t

f

J E

①
②

 

 
 Selection of operation patterns 

The positioning operation mode is selected in the "Positioning table setting" menu of CMI. 

• For the E-point control, input settings in one row. 

• For P-point, C-point and J-point controls, input settings to make the last table to be the E-
point control in combination. 

 

 Settings of J-point control 
• Set the positioning unit to increment mode to implement P-point control, C-point control, or 

E-point control with positions specified after J-point control is implemented. 

• For changing the speed during the J-point control, set the acceleration/deceleraiton time and 
target speed when the speed is changed in the "Axis parameter" menu of CMI. 
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8.1.2 Setting and Operation of E-point Control 

In the following example, a single-speed acceleration/deceleration control is performed by a 
single-axis control. 

Table 10000 pulses

(-) side (+) side

Ball screw

 

 Settings 
Item Setting example 
Operation pattern E: End point 

Control method I: Increment 

1st axis (L) movement amount 10000 pulses 

Acceleration/deceleration type L: Linear 

Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 

Target speed 10000 pps 

(Note): The (L) in the above table is an axis number. 

 Operation diagram 

100 100

f [pps]

10000

t [ms]

3000020000

10000 pulses

Positioning start request

Current value

Operation done flag

BUSY flag
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 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the positioning control starts, and 
it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Positioning start request UM00192 UM00193 UM00194 UM00195 UM00196 UM00197 

Busy flag UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Operation done flag UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bits is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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8.1.3 Setting and Operation of P-point Control 

In the following example, a three-speed acceleration/deceleration control is performed by a 
single-axis control. 

Table 18000 pulses

(-) side (+) side

Ball screw

 

 Settings 

Item 
Setting example 
Table 1 Table 2 Table 3 

Operation pattern P: Pass point P: Pass point E: End point 

Control method I: Increment I: Increment I: Increment 

1st axis (L) movement amount 5000 pulses 10000 pulses 3000 pulses 

Acceleration/deceleration type L: Linear L: Linear L: Linear 

Acceleration time (ms) 100 ms 200 ms 30 ms 

Deceleration time (ms) 10 ms 20 ms 150 ms 

Target speed 10000 pps 20000 pps 5000 pps 

(Note): The (L) in the above table is an axis number. 

 Operation diagram 

100 150

f [pps]

10000

20000

5000

200 150 t [ms]

3800020000

Table 1
5000

pulses

Table 2
10000
pulses

Table 3
3000
pulses

Positioning start request

Current value

Operation done flag

BUSY flag
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 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the positioning control starts, and 
it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Positioning start request UM00192 UM00193 UM00194 UM00195 UM00196 UM00197 

Busy flag UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Operation done flag UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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8.1.4 Setting and Operation of C-point Control 

In the following example, three successive acceleration/deceleration control is performed by a 
single-axis control. 

Table 18000 pulses

(-) side (+) side

Ball screw

 

 Settings 

Item 
Setting example 
Table 1 Table 2 Table 3 

Operation pattern C: Continuance point C: Continuance point E: End point 

Control method I: Increment I: Increment I: Increment 

1st axis (L) movement amount 5000 pulses 10000 pulses 3000 pulses 

Acceleration/deceleration type L: Linear L: Linear L: Linear 

Acceleration time (ms) 100 ms 200 ms 30 ms 

Deceleration time (ms) 10 ms 20 ms 150 ms 

Target speed 10000 pps 20000 pps 5000 pps 

(Note): The (L) in the above table is an axis number. 

 Operation diagram 

100

f [pps]

10000

20000

5000

20010
20

30 150 t [ms]

3800020000

Table 1
5000

pulses

Table 2
10000
pulses

Table 3
3000
pulses

Positioning start request

Current value

Operation done flag

BUSY flag
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 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the positioning control starts, and 
it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Positioning start request UM00192 UM00193 UM00194 UM00195 UM00196 UM00197 

Busy flag UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Operation done flag UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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8.1.5 Setting and Operation of J-point Control 

In the following example, a J-point control is performed by a single-axis control. The unit 
operates at the target speed and J-point target speed until the J-point positioning start request 
turns ON, and will start the position control when the J-point positioning start request turns ON. 

 Settings 

Item 
Setting example 

Table 1 J point axis 
parameter setting Table 2 Table 3 

Operation pattern J: Speed point － P: Pass point E: End point 

Control method I: Increment － I: Increment I: Increment 

1st axis (L) movement amount 5000 pulses － 10000 pulses 3000 pulses 

Acceleration/deceleration type L: Linear － L: Linear L: Linear 

Acceleration time (ms) 100 ms － 200 ms 30 ms 

Deceleration time (ms) 10 ms － 20 ms 150 ms 

Target speed 10000 pps － 20000 pps 5000 pps 

J-point operation setting code － Linear acceleration/ 
deceleration － － 

J-point acceleration time (ms) － 10 ms － － 

J-point deceleration time (ms) － 10 ms － － 

J-point target speed － 30000 pps － － 

(Note): The (L) in the above table is an axis number.。 

 Operation diagram 

f [pps]

t [ms]

30000

20000

10000

5000

100 10 20 150 150

Positioning start request

J-point speed change request

J-point positioning start request

Operation done flag

Current value

BUSY flag

Table 1

J-point
parameter

Table 2 Table 3
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 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the positioning control starts, and 
it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

• When a J-point speed change request (corresponding bit allocated to UM001BC to 
UM001C1) turns ON, the target speed will change. The speed change request will be 
enabled at the edge where it turns ON. 

• When a J-point positioning start request (corresponding bit allocated to UM001C2 to 
UM001C7) turns ON, the next positioning control will start. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Positioning start request UM00192 UM00193 UM00194 UM00195 UM00196 UM00197 
Busy flag UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 
Operation done flag UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 
J-point speed change request UM001BC UM001BD UM001BE  UM001BF UM001C0 UM001C1 
J-point positioning start 
request UM001C2 UM001C3 UM001C4 UM001C5 UM001C6 UM001C7 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●

 

 Behaviors when the speed change request turns ON while the positioning unit is 
accelerating or decelerating the speed 

A speed change is possible during J-point control, but impossible during acceleration or 
deceleration. A speed change will be made after the unit goes to constant speed when the 
speed change signal turns ON during acceleration or deceleration. Be sure to input the 
amount of movement for positioning with a value that can secure a target constant-speed area. 

J point speed change contact is not effective.
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8.2 Interpolation Control 

8.2.1 Type of Interpolation Control (Two-axis Interpolation) 

• The following types and operation specification methods are available for the 2-axis 
interpolation. 

• The axes in the relation of an interpolation are called 1st axis and 2nd axis for the 2-axis 
interpolation. Also, the 1st axis and 2nd axis are automatically allocated from the smalles 
axis number in axcending order. 

 Type and operation specification method 
Type Operation specification method Necessary data 

2-axis linear 
interpolation 
control 

Composite speed Composite speed of 1st axis and 2nd axis 

Long axis speed Speed of long axis (Axis of which moving 
distance is long) 

2-axis circular 
interpolation 
control 

Center point/CW direction Coordinates of 1st axis and 2nd axis of 
center point 

Center point/CCW direction Coordinates of 1st axis and 2nd axis of 
center point 

Pass point Coordinates of 1st axis and 2nd axis of 
pass point on arc 

 Positioning table and operation characteristics 
• When specifying the long axis speed method, the composite speed is faster than the long 

axis speed. 

• In the case of the center point specification, the coordinate of the center point on arc is 
specified as the data of 1st-axis (X-axis) auxiliary point and 2nd-axis (Y-axis) auxiliary point 
of positioning data. Also, in the case of the pass point specification, the coordinate of the 
pass point on arc is specified as the data of 1st-axis (X-axis) auxiliary point and 2nd-axis (Y-
axis) auxiliary point of positioning data 

• When the control method is increment, for the both center point and pass point, the 
increment coordinate from the start point is specified. 

• When the start point and the operation done point is the same, it performs one circular 
operation when using the center point method. However, when using the pass point method, 
an error occurs. 

• In case of the pass point method, when the start point, pass point and operation done pont 
exsit in the same straight line, an arc is not comprised, and an error occurs. 

• In each interpolation control, the E-point control which uses one table, P-point control and C-
point control which uses multiple tables can be combined arbitrarily as positioning data. For 
the P-point and C-point controls, the last table should be set as an end point. 

REFERENCE  
• For details of E-point, P-point, and C-point controls, refer to "8.1.1 Patterns 

of Position Control". 
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8.2.2 Type of Interpolation Control (Three-axis Interpolation) 

• The following types and operation specification methods are available for the 3-axis 
interpolation. 

• The axes in the relation of an interpolation are called 1st axis, 2nd axis and 3rd axis for the 
3-axis interpolation. Also, the 1st, 2nd and 3rd axes are automatically allocated from the 
smallest axis number in ascending order. 

 Type and operation specification method 
Type Operation specification method Necessary data 

3-axis linear 
interpolation 
control 

Composite speed Composite speed of 1st, 2nd and 3rd 
axes 

Long axis speed Speed of long axis (Axis of which moving 
distance is long) 

3-axis spiral 
interpolation 
control 

Center point/CW direction/1st axis movement Coordinates of 2nd and 3rd axes of center 
point 

Center point/CCW direction/1st axis movement Coordinates of 2nd and 3rd axes of center 
point 

Center point/CW direction/2nd axis movement Coordinates of 1st and 3rd axes of center 
point 

Center point/CCW direction/2nd axis movement Coordinates of 1st and 3rd axes of center 
point 

Center point/CW direction/3rd axis movement Coordinates of 1st and 2nd axes of center 
point 

Center point/CCW direction/3rd axis movement Coordinates of 1st and 2nd axes of center 
point 

Pass point/1st axis movement Coordinates of 2nd and 3rd axes of pass 
point on arc 

Pass point/2nd axis movement Coordinates of 1st and 3rd axes of pass 
point on arc 

Pass point/3rd axis movement Coordinates of 1st axis and 2nd axis of 
pass point on arc 

 Positioning table and operation characteristics 
• When specifying the long axis speed method, the composite speed is faster than the long 

axis speed. 

• In the case of the center point specification, the coordinates of the center point for two axes 
which draw an arc is specified as the data of 1st-axis (X-axis) auxiliary point and 2nd-axis 
(Y-axis) auxiliary point of positioning data. Also, in the case of the pass point specification, 
the coordinate of the pass point on arc is specified as the data of 1st-axis (X-axis) auxiliary 
point and 2nd-axis (Y-axis) auxiliary point of positioning data 

• When the control method is increment, for the both center point and pass point, the 
increment coordinate from the start point is specified. 

• When the start point and the operation done point is the same, it performs one circular 
operation when using the center point method. However, when using the pass point method, 
an error occurs. 

• In case of the pass point method, when the start point, pass point and operation done point 
exist in the same straight line, an arc is not comprised, and an error occurs. 
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• In each interpolation control, the E-point control which uses one table, P-point control and C-
point control which uses multiple tables can be combined arbitrarily as positioning data. For 
the P-point and C-point controls, the last table should be set as an end point. 

REFERENCE  
• For details of the position control patterns, refer to "8.1.1 Patterns of 

Position Control". 
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3-axis spiral interpolation (Center point specification/
CW direction/Z-axis movement)

3-axis spiral interpolation (Center point specification/
CCW direction/Z-axis movement)

The center
position can be
specified.

The center
position can be
specified.

The interpolation speed is the tangential
velocity of arc.

The interpolation speed is the tangential
velocity of arc.

3-axis spiral interpolation (Pass point specification/
Z-axis movement)

The pass point on an arc can be specifed.

The interpolation speed is the tangential
velocity of arc.

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

(X axis)
1st axis

(Y axis)
2nd axis

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

(Z axis)
3rd axis

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

3-axis linear interpolation
(Composite speed specification)

The composite speed
can be specified.

3-axis linear interpolation
(Long axis speed specification)

The axis speed for
the axis to be a long
axis can be specified.

 
(Note): The following explanatory drawings for 3-axis spiral interpolation control show the cases that an arc is drawn 

with the 1st axis (X-axis) and 2nd axis (Y-axis) and moves toward the 3rd axis (Z-axis). 
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8.2.3 Setting and Operation of Two-Axis Linear Interpolation 

In the following example, a 2-axis linear interpolation control is performed by a composite 
speed. 

10000 pulses

5000 pulses

(Ｙ axis)

(Ｘ axis)

2nd axis

1st axis

 

 Settings 
Item Setting example Remarks 
Operation pattern E: End point  

Interpolation operation 0: Linear (Composite speed)  

Control method I: Increment  

1st axis (L) movement amount 10000 pulses 
Axis numbers are put in (L) and (m). 
The values of auxiliary points are 
invalid for the linear interpolation. 

1st axis (L) Auxiliary point 0 pulse 

2nd axis (m) Movement amount 5000 pulses 

2nd axis (m) Auxiliary point 0 pulse 

Acceleration/deceleration type L: Linear  

Acceleration time (ms) 100 ms  

Deceleration time (ms) 100 ms  

Interpolation speed 10000 pps  
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

3000020000

1500010000

Composite speed

Positioning start request of 1st axis

Current value of 1st axis

Current value of 2nd axis

Operation done flag of 1st axis

Operation done flag of 2nd axis

BUSY flag of 1st axis

BUSY flag of 2nd axis

 

 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. In the interpolation control, turn ON the 
positioning start request of the smallest axis number in the same interpolation group. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
motor is running, will turn ON when the positioning control starts, and it will turn OFF when 
the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 
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8.2.4 Setting and Operation of Two-Axis Circular Interpolation 

In the following example, a 2-axis circular interpolation control is performed by specifying the 
center point. 

Center point (X axis: 0, Y axis: 10000)

10000 pulses

20000 pulses

(Ｘ axis)
1st axis

(Y axis)
2nd axis

 

 Settings 
Item Setting example Remarks 
Operation pattern E: End point  

Interpolation operation S: Circular (Pass point/CW direction)  

Control method I: Increment  

1st axis (L) movement amount 0 pulse Axis numbers are put in (L) and (m). 
For the auxiliary points, specify the 
coordinate (0, 10000) to be the center 
of an arc. 

1st axis (L) Auxiliary point 0 pulse 

2nd axis (m) Movement amount 20000 pulses 

2nd axis (m) Auxiliary point 10000 pulses 

Acceleration/deceleration type L: Linear  

Acceleration time (ms) 100 ms  

Deceleration time (ms) 100 ms  

Interpolation speed 10000 pps Specify the speed of a tangent of an 
arc. 
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

2000020000

3000010000

Composite speed

Positioning start request of 1st axis

Current value of 1st axis

Current value of 2nd axis

Operation done flag of 1st axis

Operation done flag of 2nd axis

BUSY flag of 1st axis

BUSY flag of 2nd axis

 

 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. In the interpolation control, turn ON the 
positioning start request of the smallest axis number in the same interpolation group. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
motor is running, will turn ON when the positioning control starts, and it will turn OFF when 
the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 
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8.2.5 Setting and Operation of Three-Axis Linear Interpolation 

In the following example, a 3-axis linear interpolation control is performed by a composite 
speed. 

20000 pulses

5000 pulses

10000 pulses

(Ｘ axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

 

 Settings 
Item Setting example Remarks 
Operation pattern E: End point  

Interpolation operation 0: Linear (Composite speed)  

Control method I: Increment  

1st axis (L) movement amount 10000 pulses 

Axis numbers are put in (L), (m) and 
(n). 
The values of auxiliary points are 
invalid for the linear interpolation. 

1st axis (L) Auxiliary point 0 

2nd axis (m) Movement amount 5000 pulses 

2nd axis (m) Auxiliary point 0 

3rd axis (n) Movement amount 20000 pulses 

3rd axis (n) Auxiliary point 0 

Acceleration/deceleration type L: Linear  

Acceleration time (ms) 100 ms  

Deceleration time (ms) 100 ms  

Interpolation speed 10000 pps Specify the speed of a tangent of an 
arc. 
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

3000020000

200000

1500010000

Composite speed

Positioning start request of 1st axis

Current value of 1st axis

Current value of 2nd axis

Current value of 3rd axis

Operation done flag of 1st axis

Operation done flag of 2nd axis

Operation done flag of 3rd axis

BUSY flag of 1st axis

BUSY flag of 2nd axis

BUSY flag of 3rd axis

 

 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. In the interpolation control, turn ON the 
positioning start request of the smallest axis number in the same interpolation group. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
motor is running, will turn ON when the positioning control starts, and it will turn OFF when 
the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 
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8.2.6 Setting and Operation of Three-Axis Spiral Interpolation 

In the following example, an arc is drawn with the 1st axis (X-axis) and 2nd axis (Y-axis), and 
a 3-axis spiral interpolation control is performed with 3rd axis (Z-axis) movement. 

10000 pulses

5000 pulses20000 pulses

Center point (X axis: 0, Y axis: 10000)

(Ｘ axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

 

 Settings 
Item Setting example Remarks 
Operation pattern E: End point  

Interpolation operation E: Spiral (Center point/CW 
direction/3rd axis movemet)  

Control method I: Increment  

1st axis (L) movement amount 0 pulse Axis numbers are put in (L) and (m). 
For the auxiliary points, specify the 
coordinate (0, 10000) to be the center 
of an arc. 

1st axis (L) Auxiliary point 0 pulse 

2nd axis (m) Movement amount 20000 pulses 

2nd axis (m) Auxiliary point 10000 pulses 

3rd axis (n) Movement amount 5000 pulses Axis numbers are put in (n). 
Specify the movement amount of 3rd 
axis (Z-axis). 3rd axis (n) Auxiliary point 0 pulse 

Acceleration/deceleration type L: Linear  

Acceleration time (ms) 100 ms  

Deceleration time (ms) 100 ms  

Interpolation speed 10000 pps  
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

2000020000

50000

3000010000

Composite speed

Positioning start request of 1st axis

Current value of 1st axis

Current value of 2nd axis

Current value of 3rd axis

Operation done flag of 1st axis

Operation done flag of 2nd axis

Operation done flag of 3rd axis

BUSY flag of 1st axis

BUSY flag of 2nd axis

BUSY flag of 3rd axis

 

 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. In the interpolation control, turn ON the 
positioning start request of the smallest axis number in the same interpolation group. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
motor is running, will turn ON when the positioning control starts, and it will turn OFF when 
the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 
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8.3 Repeat Function 

8.3.1 Overview of Repeat Operation 

• This function is used to execute continuous positioning control by specifying a repeat count.  

• The repeat count is set in the "positioning repeat count area" in the unit memories. The 
continuous positioning control can be executed in the range of 2 to 254 times or unlimitedly 
according to the setting. 

• The operation from the positioning control starting table to the E-point table is repeated. 

 Overview of positioning repeat function 
The positioning unit operates as shown below in the case of repeating positioning control 
three times. 

P P P EP P P E

 

If a dwell time of 0 is set for E-point control, i.e., the end point of positioning control, the unit 
processes E-point control as P-point control, and finishes the operation after repeating the 
positioning control three times continuously. 

P P P P P P P P P P P EP P P P P P P P P P P E

 

If the dwell time is set to a value other than 0 for E-point control, i.e., the end point of 
positioning control, the control unit processes E-point control as C-point control, and executes 
the positioning control after stopping for the specified dwell time (ms). The positioning unit 
finishes the operation after repeating the positioning control three 
times.

P P P C P P P C P P P E

Dwell time Dwell time
 

 



Automatic Operation (Position Control) 

8-26 
 

 Setting area for positioning repeat count (Unit memories) 

Axis 
no. 

Unit 
memory 
no. (Hex) 

Name Default Description 

Axis 1 UM 009F0 

Positioning 
repeat 
count 

U0 

Stores the number of times for repeating the operation starting from 
the positioning control starting table number until the E point. 

Value Operation 

0 or 1 Execute only once. 

2-254 Execute for a specified number of times. 

255 Execute unlimitedly until performing the stop 
operation. 

 

Axis 2 UM 009F1 

  

Axis 64 UM 00A2F 

Virtual 
axis 1 UM 00A30 

 - 

Virtual 
axis 32 UM 00A4F 

(Note 1): As for the unit memories in which "positioning repeat count" is set, 1-word area is allocated for each axis. 

8.3.2 Stop Operation During Repeat Operation 

The unit operates as follows when the deceleration stop is executed during the repeat 
operation. 

 When repeating E-point control 
When the unit detects a deceleration stop, it stops the operation after repeating the 
positioning control N+3 times. 

E E E E

N-1 N N+1 N+2

E

N+3

Deceleration
stop request

Repeat count

Deceleration stop request signal

Busy

Operation done

Stop

 
(Note): The above figure shows the case that the dwell time is 0 ms. 

 When executing multiple positioning tables continuously 
When the unit detects a deceleration stop, it stops the operation after repeating the 
positioning control N+2 times (when the number of tables is 2) or N+1 times (when the 
number of tables is 3 or more). 

N-1 N N+1

P P P E

Deceleration
stop request

Repeat count

Deceleration stop
request signal

Busy

Operation done

Stop
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8.3.3 Setting and Operation of Repeat 

In the following example, the positioning control with three tables (P + P + E points) is 
repeated three times by a single axis control. 

Table

(-) side (+) side

Ball screw

54000 pulses
(18000 x 3)

 

 Settings 

Item 
Setting example 
Table 1 Table 2 Table 3 

Operation pattern P: Pass point P: Pass point E: End point 

Control method I: Increment I: Increment I: Increment 

1st axis (L) movement amount 5000 pulses 10000 pulses 3000 pulses 

Acceleration/deceleration type L: Linear L: Linear L: Linear 

Acceleration time (ms) 100 ms 200 ms 30 ms 

Deceleration time (ms) 10 ms 20 ms 150 ms 

Target speed 10000 pps 20000 pps 5000 pps 

Dwell time 0 ms 0 ms 0 ms 

Positioning repeat count 3 (Write in the setting area of unit memories.) 

(Note): The (L) in the above table is an axis number. 
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 Operation diagram 
f [pps]

10000

5000

20000

t [ms]100 150200

Positioning start request

Operation done flag

BUSY flag

 
(Note): The above figure shows the case that the dwell time is 0. 

 Operation of input control/output control signals 
• When a positioning start request (corresponding bit allocated to UM00192 to UM00197) 

turns ON by a user program, the positioning control will start. The positioning start request 
will be enabled at the edge where it turns ON. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
motor is running, will turn ON when the positioning control starts, and it will turn OFF when 
the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 
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8.4 Sample Programs 

8.4.1 Sample Programs (E-point, C-point and C-point Controls) 

The operation for starting the positioning operation is mainly divided into five steps on a user 
program. 

• Read flags stored in the unit memories (input control area). 

• Control the servo ON/OFF. 

• Check the condition if the control of each axis can be started. 

• Set positioning table numbers, check the conditions, and start the positioning operation. 

• Write operation results in the unit memories (output control area). 
(Note): The sample program on the next page is for activating the positioning operation with the table number 1 of the 

axis number 1 for the FP7 MC Unit installed in the slot number 1. To simplify the explanation, the part related to 
the positioning operation is extracted. 

 Contents of sample program 
Mark Description 

① 
Read flags indicating states from the input control area of the unit memories (UM) to arbitrary areas 
(WR). 
Read flags such as connection confirmation flag, servo lock confirmation flag, busy flag, and error 
flag. 

② Servo ON/OFF control program 

③ Check required conditions and replace it with the start enabled flag (R110) in the program. 

④ 

 Positioning operation start program 

ⓐ Set the repeat count as necessary. 

ⓑ Specify positioning table numbers. 

ⓒ Start the positioning operation. 

⑤ 
Write flags to the output control area of the unit memoires (UM) from arbitrary area (WR) where the 
start conditions are written. 
Start the positioning operation. 
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 Sample program 

R4180R110 R1160

Axis 1 Start 
enabled flag

Axis 1 
Positioning start

Axis 1 Busy 
annunciation

R120

R4180

Axis 1 
Positioning 
start

（ ）DF

SR14
S1:UM00192BKMV.US WR423WR418

1st scan OFF

X100

Link 
establishment

1-16
Positioning start

Virtual 17-32
Positioning start

1-16
Positioning start

（ ）DF
R120

DT100U1MV.US
Axis 1 Repeat 

count ④-ⓐ
（ ）DF

R120
S1:UM009F0DT100MV.US

Axis 1 Repeat 
count

（ ）DF
R120

DT100U1MV.US
Position 
control 

starting table

Axis 1 Repeat 
count

（ ）DF
R120

S1:UM00990DT110MV.US
Axis 1 Position 
control starting 

table

Position 
control 

starting table

SR14

①

WR106BKMV.US S1:UM00089S1:UM00086

WR110BKMV.US S1:UM0008DS1:UM0008A

WR116BKMV.US S1:UM00096S1:UM00090
1-16
BUSY

Virtual 17-32
BUSY

1-16
BUSY

X100

X100 X104 R1060 R1100 R1580 R110

Axis 1 Start 
enabled 

flag

③

②Servo ON/OFF control program

WR158BKMV.US S1:UM000BFS1:UM000BA

④-ⓑ

④-ⓒ

⑤

Position control 
start

1-16
Connection 
confirmation

1st scan OFF 49-64
Connection 
confirmation

1-16
Connection 
confirmation

1-16
Servo lock 
annunciation

49-64
Servo lock 
annunciation

Link 
Establish-

ment

1-16
Servo lock 
annunciation

1-16
Error occurrence

Virtual 17-32
Error occurrence

1-16
Error occurrence

Link 
Establish-
ment

Tool 
operation

Axis 1 
Connection 
confirmation

Axis 1 
Servo lock 

annunciation

Axis 1 Error 
occurrence

Position control 
start

Position control 
start

Position control 
start
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8.4.2 Precautions on Programming 

 Precautions on programming 
• If any value such as a movement amount, acceleration time, deceleration time or target 

speed is out of the specified range, a setting value error will occur when the position control 
starts. 

• Unit memory numbers allocated to flags and start requests vary depending on axis numbers. 

• A specified slot number varies depending on the installation position of the unit. 

 Operation at Over limit input (Limit is Enabled) 
Condition Direction Limit status Operation 

When each control 
starts 

Forward 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Not executable, Error occurs. 

Reverse 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Not executable, Error occurs. 

When each control is 
performed 

Forward Over limit input (+): ON Deceleration stop, Limit error occurs. 

Reverse Over limit input (-): ON Deceleration stop, Limit error occurs. 
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8.5 Rewriting Positioning Data by User Programs 

8.5.1 Overview of Function 

• Positioning data set by CMI is downloaded to the FROM of FP7 MC Unit. 

• The positioning data stored in the FROM is transferred to the system area of FP7 MC Unit 
when the power is turned on. The system area cannot be directly accessed using user 
programs. 

• When positioning data (such as movement amount or target speed) varies according to 
operation results, the positioning data should be rewritten using user programs. 

• In the system area of FP7 MC Unit, the positioning data for 32 words x 1000 tables x 96 
axes (64 real axes + virtual axes) are stored. 

• When rewriting positioning data using user programs, the data is read and written from/to the 
system area through the 24 buffer areas allocated to the unit memories. 

• The data that can be read or written in a single operation using a user program is data for 32 
words x Max. 500 tables x 1 axis. 

 



8.5 Rewriting Positioning Data by User Programs 

 
8-33 

8.5.2 Procedure of Rewriting 

The following flowchart shows the flow of the operation required in a user program. 

• For reading and writing, the operations to be executed (read, write) and targets (axis number, 
table number, table size) are specified in the buffer control area of the unit memories. 

• By executing "Recalculation" after the operation, the positioning data stored in the system 
area of FP7 MC Unit is updated. Once the "Recalculation" is completed, the positioning 
operation can be started for the rewrtten positioning data. 

START

Axis no. / Table control setting

Setting value 
partial change

Buffer control read request

All parameter settingsParameter partial change

Buffer control write request

Recalculation request : Y7=ON

Recalculation done: X7=ON

END

No

Yes

Recalculation table specification
Starting number and size

Request code: H0081
Request flag: H0001

Request code: H0080
Request flag: H0001

Recalculate

Write

Read

Set

Select target

 

 Recalculation 
Recalculation is necessary after rewriting positioning data using user porgrams. The 
procedure of recalculation is as follows. When recalculation is not performed, the operation is 
executed with the positioning table before rewriting. 

1．Change the positioning table in the unit memories. 

2．Turn on the recalculation request (Y4) in the I/O area. 

3．Confirm that the recalculation done flag (X7) in the I/O area is on. (Confirm that the 
recalculation process is completed.) 
(Note): I/O numbers of the recalculation request (Y7) and recalculation done flag (X7) vary according to the value of 

the "Starting word number" allocated to the unit. 
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8.5.3 Sample Program (Rewritign Positioning Tables) 

The operation for rewriting positioning tables using a user program is mainly divided into five 
steps. 

• Specify the axis number, table number and table size to rewrite the positioning table. 

• Set the positioning data to be rewritten. 

• Set the positioning data in the positioning data setting area in buffers. 

• Execute reading or writing the data in accordance with the requests stored in buffers. 

• Execute recalculation. 
(Note): The sample program on the next page is for rewriting the positioning data of one table from the table number 

1 of the axis number 1 for the FP7 MC Unit installed in the slot number 1. 

 Contents of sample program 
Mark Description 

①  

 Set the axis number, table number and table size to be rewritten. 

ⓐ Set the axis number, table number and table size. 

ⓑ Set the axis number, table number and table size in the unit memory (control area for buffer control). 

② Set the positioning data (14 words) to be rewriten in an arbitrary area. 

②  Set the positioning data in the unit memory (positioning data setting area in the buffer). 

④ 

 Execute reading and writing the data in accordance with the requests stored in the buffer. 

ⓐ Specify reading or writing in the unit memory (control area for buffer control). 

ⓑ Set request flags in the unit memory (control area for buffer control). 

⑤ 

 Execute recalculation. 

ⓐ Set the table number and table size to be recalculated in the unit memory (setting parameter control 
area). 

ⓑ Request recalculation until it is completes. 

ⓒ Reset the recalculation table size stored in the unit memory (setting parameter control area) to zero. 

 

 



8.5 Rewriting Positioning Data by User Programs 

 
8-35 

 Program example 

R500

①-ⓑ
S1:UM06243BKMV.US DT502DT500

Axis number 
control

Table size Buffer no.1
Axis 
number

（ ）DF
R500

DT500U1MV.US
Axis number 

control
Setting value read

①-ⓐ（ ）DF
R501

DT501U1MV.US
Starting table 

number
Setting value write

DT502U1MV.US
Table size

（ ）DF

（ ）DF
R501

R501
S1:UM06248BKMV.US DT533DT520（ ）DF

Buffer no.1
Table no. 1

（ ）DF
R500

S1:UM06241H80MV.US
Buffer no.1

Request code ④-ⓐ
（ ）DF

R501
S1:UM06241H81MV.US

Buffer no.1
Request code

S1:UM06240H1MV.US
Buffer no.1

Request flag ④-ⓑ
（ ）DF

R500

（ ）DF
R501

⑤-ⓑ
（ ）DF/

R501

Y107

Recalculation 
request

③

R501
S1:UM00284BKMV.US DT502DT501

Starting table 
number

Table size
（ ）DF/

1st axis 
Recalculation start

⑤-ⓐ

（ ）DF
X107

S1:UM00285U0MV.US
1st axis 

Recalculation table
Recalculation 

done

⑤-ⓒ

Y107X107

Recalculation 
request

Recalculation 
done

（ ）DF
R501

DT520H0MV.US
Control code

②

DT521H1MV.US
Operation 

pattern

DT526U1000MV.UL
Target speed

DT528K10000MV.SL
Movement 

amount

DT532U0MV.US
Dwell time

DT533U0MV.US
Output code

Setting value read

Setting value write

Setting value write

Setting value write

Setting value read

Setting value write

Setting value read

Setting value write

Setting value write

Setting value write
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9.1 Synchronous Control 

9.1.1 Overview of Synchronous Control 

 What is synchronous control? 
In the synchronous control, by operating a reference axis (master axis), the axes (slave axes) 
interlocking (synchronizing) with the master axis are activated. The advantages of using the 
synchronous control are as follows. 

1. Ease of setting 

A number of related axes can be operated with ease by designing the operation of the axes 
based on the master axis. 

2. Ensuring operational safety 
If an axis comes to a stop for some reason while the positioning unit is in synchronous control, 
all the relevant axes under synchronous control will come to a stop. Therefore, you can easily 
increase the safety of the positioning unit. 

 Functions of control output 
The synchronous control provides the following functions. These functions are executed in 
order, and the slave axes operate according to the operation result of each function. 

Function Overview 

Electronic gear The number of pulses multiplied by the preset electronic gear ratio is output according to the 
operation of the master axis. 

Electronic 
clutch 

The operation of the slave axes can be separated from the operation of the master axis by 
disengaging the clutch.  

Electronic cam 

A function to output pulses according to the preset cam pattern. 
Calculates the operation phase of the master axis and outputs cam pulses according to the 
phase. 
The cam pattern is set by CMI. 
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 Execution order of synchronous control and setting procedures 
The following section provides information on the outline of functions achieved by 
synchronous control and setting procedures for the functions. 

Master axis operation Master axis
settings

Slave axis output

Electronic gear
settings

Electronic clutch
settings

Electronic cam
settings

Make master axis settings for each operating axis.
Each operating axis will work as a slave axis if master axis settin
are made for the operating axis.

Select the use or non-use of the electronic gear. Various electro
gear settings are required if the electronic gear is used.

Select the use or non-use of the electronic clutch. Various
electronic cutch settings are required if the electronic gear is use

Select the use or non-use of the electronic cam. Various electron
cam settings are required if the electronic gear is used.
In addition, electronic cam pattern settings are required in the ca
of using the electronic cam.
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9.2 Settings for Master and Slave Axes 

9.2.1 Selection of Master Axis and Settings 

The master axis serves as a reference for synchronization control. Start and stop requests for 
various operations are made to the master axis under synchronous control. It is possible to 
select one of the following master axes. 

 Types of master axis 
Master axis 
type Description 

Real axis 
Use one of them if the master axis needs to be an object of control as well. 
If a real axis is used as the master axis, the rest of the real axes can be used as slave axes. 

Virtual axis 
It is a virtual axis controlled within FP7 MC Unit. 
The virtual axis can be used only as the master axis. 
Real axes can be used effectively by using the virtual axis. 

 Types of master axis and restrictions 

Operation mode 
Usable axis 

Remarks Real 
axis 

Virtual 
axis 

Home return ○ △ Virtual axes are available only for "Data set" 
method". 

JOG operation ○ ○  

Positioning 

Single axis ○ ○  

Interpolation ○ ○ 

Available in any of the following combinations. 
Real axis + Real axis 
Virtual axis + Real axis 
Virtual axis + Virtual axis 

Stop 
function 

System stop 
Emergency stop 
Deceleration stop 

○ ○  

Limit stop ○ △ For virtual axes, only the stop by softwrae limit is 
available. 

Error stop ○ ○  

KEY POINTS
 

• While the unit is in synchronous control, slave axes set to use the master 
axis operate only in synchronization with the master axis, i.e., the slave 
axes cannot operate independently. 
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9.2.2 Selection of Slave Axes and Settings 

 Selection of slave axes 
• Axes that can be used as slave axes are real axes. Virtual axes can be used only as the 

master axis. 

• When "Synchronous master axis" is selected in the synchronous parameter dialog box of 
CMI, the corresponding axis operates as a slave axis for the specified master axis. 

• Axes set as slave axes operate in synchronization with the master axis. Slave axes cannot 
be controlled independently during synchronization. 

 Settings for slave axes 
Slave axes operate in synchronization with the master axis. Set the following items, however, 
for each individual slave axis. 

• Unit setting 

• Pulse number per rotation 

• Movement amount per rotation 

9.2.3 Unit Type and Number of Axes 

FP7 MC Unit model 
number 

Number of usable axes 
Real axis Virtual axis 

AFP7MC16EC Max. 16 axes Max. 8 axes 

AFP7MC32EC Max. 32 axes Max. 16 axes 

AFP7MC64EC Max. 64 axes Max. 32 axes 
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9.2.4 Setting by CMI 

Master and slave axes are allocated using CMI. The following procedure is explained on the 
condition that CMI has already started. In the following example, AFP7MC16EC (16-real axes, 
8-virtual axes) type is used, and the axis 1 is allocated to the master and the axes 2 and 3 are 
allocated to slave axes. 

PROCEDURE  
1. Select "File" > "New" from the menu bar of CMI. 

The Axis settings dialog box is displayed. 

 
2. Select an interpolation group, and press the [OK] button. 

For performing the synchronous control, only the master axis can be selected for 
the interpolation group. 

3. Select "Parameter" > "Synchronous parameter settings" > "Axis 2" from the 
menu bar. 

The "Synchronous parameter Axis 2" window opens. 

 
4.  Select "Axis 1" from the drop-down list of "Basic setup" > "Synchronous 

master axis". 

The hierarchy of "Axis 2" in the project tree is changed. Also, the items in the 
electronic gear, electronic clutch and electronic cam settings of "Synchronous 
parameter Axis 2" become available. 
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5. Select "Parameter" > "Synchronous parameter settings" > "Axis 3" from the 
menu bar. 

The "Synchronous parameter Axis 3" window opens. 

6.  Select "Axis 1" from the drop-down list of "Basic setup" > "Synchronous 
master axis". 

The hierarchy of "Axis 3" in the project tree is changed. Also, the items in the 
electronic gear, electronic clutch and electronic cam settings of "Synchronous 
parameter Axis 3" become available. 
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9.3 Start and Cancel of Synchronous Control 

9.3.1 Start and Cancel of Synchronous Control 

 Start and cancel operations 
• The synchronous control can be temporarily canceled by turning on "Synchronous cancel 

request" in the output control area of unit memories. 

• It is possible to operate any slave axes individually while the synchronous state is canceled. 

• The synchronous control can be started again with the sync cancel request signal turned 
OFF. 

 Synchronous cancel request/annunciation signals 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Synchronous cancel request 
Corresponding bit ON: 
Synchronization is canceled. 
Corresponding bit OFF: 
Synchronization is executed 

UM001DA UM001DB UM001DC UM001DD UM001DE UM001DF 

Synchronous cancel active 
annunciation 
Corresponding bit ON: 
Synchronization is being 
canceled. 
Corresponding bit OFF: 
Synchronization is being 
processed. 

UM000CC UM000CD UM000CE UM000CF UM000D1 UM000D2 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  
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 Operations while synchronous control is performed/canceled 

Operation mode 

Operation during synchronization 
Operation while 
synchronization is 
being canceled 

When requesting 
operation for 
master axis 

When requesting 
operation for slave 
axis 

When requesting 
operation for 
master/slave axis 

Home return 

Home return operation 
is performed on the 
master axis. 
Hoe return operation is 
not performed on slave 
axes. Synchronous 
operation is performed 
in synchronization with 
output from the master 
axis. 
For performing home 
return operation on 
slave axes, cancel the 
synchronous operation. 

The slave axes do not 
operate in response to 
operation requests. 

Regardless of master or 
slave axes, home return 
operation is performed 
only on the axes are so 
requested. 

JOG operation 
The slave axes operate 
in synchronization with 
the operation request 
of the master axis. 

Regardless of master or 
slave axes, JOG operation 
is performed only on the 
axes are so requested. 

Positioning 

Single axis 

Interpolation 

Interpolation is 
executed upon request 
if the master axis is the 
start axis of 
interpolation. 
The slave axes operate 
in synchronization with 
the master axis. 

Interpolation is executed 
upon request if the 
requested axis is the start 
axis of interpolation. 

Stop 
function 

System stop All the axes come to a stop regardless of the synchronization settings. 

Emergency 
stop 

The master axis comes 
to a stop upon request. 
The slave axes come 
to a stop in 
synchronization with 
the master axis. 

Only axes requested 
come to a stop. 
The master axis and 
other slave set on the 
same master axis 
continue operating. 

Only axes requested 
come to a stop. 
(All the target axes in 
interpolation operation 
come to a stop.) 

Deceleration 
stop 

Limit stop 
The master axis and all the slave axes come to a 
stop. 

Only axes resulting in a 
limit error come to a stop. 

Error stop Only axes resulting in an 
error come to a stop. 
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9.3.2 Precautions When Canceling or Starting Synchronous Control 

 Precautions when canceling synchronous control 
• The synchronous control can be canceled during  the master operation, however, slave axes 

will stop immediately. 

• It is recommended to cancel the synchronous control after stopping slave axes using the 
clutch function. 

• When the synchronous control is canceled, flags related to the synchronous control 
(synchronous slave gear ratio change state notification, synchronous slave clutch connection 
state notification) will turn off. 

 Conditions for starting synchronous control 
Only when the following conditions are met, the synchronous control can be started. 

• Slave axes stop. 

• No stop request for slave axes is generated. 

• No error occurs in slave axes. 

When these conditions are not met, the unit does not become the synchronous state and the 
synchronous control cancel active annumciation relay does not turn off. If the synchronous 
cancel request kept off while the conditions are not met, the synchronous control will start 
once the condition to start the synchronous control is met. 
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 Phase when starting synchronous control 
It is calculated from the "current value after unit conversion" of master axis and the "cam 
control synchronous master axis cycle" of synchronous parameter. The remainder obtained by 
dividing "current value after unit conversion" by "cam control synchronous master axis cycle" 
is used as a phase. 

t

t

0

0

Master axis
Current value
after unit conversion

Phase of slave axis

The phase does not change
in the section that the clutch is off.

Synchronous control
canceled

Clutch ON

Cam control synchronous master cycle

Under synchronous control

Clutch
OFF

Calcuate the phase based
on the current position of
master axis when starting
synchronous control.
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9.4 Electronic Gear Function 

9.4.1 Overview of Electronic Gear Function 

 Electronic gear function 
The electronic gear function operates the positioning unit at the speed of the master axis 
multiplied by a preset gear ratio. 

Speed [V] Output speed

Input speed

Gear ratio: Set to 2x

Time [T]
Speed [V]

Output speed
Input speed Gear ratio: Set to 0.5x

Time [T]

Master axis
operation

Electronic gear
output

Output speed       =       Input speed       x　
(Speed after gear change) (Information on master axis speed)

Gear ratio numerator
Gear ratio denominator

 

 Cautions when using the electronic gear function 
The use of the electronic gear function makes it possible to set the salve axes to a desired 
speed relative to the master axis. 

Movement amount of slave axes  
= Movement amount of master axis x (gear ratio numerator/Gear ratio denominator) 
                                                             * On the condition that the gear ratios are constant 

Do not use the electronic gear function if the movement amount of the master axis needs to 
coincide with that of the slave axes. 

 
• Keep in mind that the slave axes may come to a sudden stop if an 

emergency stop or deceleration stop is executed while make a gear ratio 
change. 
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9.4.2 Types and Contents of Setting Parameters 

For using the electronic gear, set the following parameters in the "Synchronous parameter 
settings" menu. 

 
Parameter name Default Description 

Electronic gear 
setting - Use Not use 

Select the operation of the electronic gear function. 
Use / Not use 
The gear ratio of the electronic gear is set to 1:1 if the electronic gear is 
not used, and the operation of the master axis is input as it is into the 
electronic clutch. 

Gear ratio numerator 1 Determines the gear ratio of the electronic gear. 
Electronic gear ratio is determined by the following formula. Output 
speed of electronic gear = Operating speed of master axis x (Gear ratio 
numerator/Gear ratio denominator) 

Gear ratio 
denominator 1 

Gear ratio change 
time 1 The time required to change the current gear ratio to a new gear ratio if 

the new gear ratio is set for the electronic gear in operation. 

KEY POINTS
 

• The gear ratio of the electronic gear is set to 1:1 when selecting "Not use" 
for the electronic gear, and the operation of the master axis is input as it is 
into the electronic clutch. 
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9.4.3 Gear Ratio Changes while in Operation 

 Precautions for gear ratio changes while the positioning unit is in operation 
• If the gear ratio is changed with a new gear ratio while the electronic gear is in operation, the 

new gear ratio will be effective with an elapse of a preset gear change time. 

• If the gear ratio change time is 1, the gear ratio will be changed at an 
acceleration/deceleration time of 0. 

• Acceleration or deceleration during the gear ratio change results in linear acceleration or 
deceleration. S-shaped acceleration or deceleration cannot be used. 

Speed [V] Gear ratio change time
(1 ms)

Gear ratio change time
(100 ms)

Gear ratio change request signal

Gear ratio numerator/Gear ratio denominator 200 ／ 100

1 100

50 ／ 100100 ／ 100

Gear ratio change time

Input speed
Output speed

Time [T]

 

 Programming method 
Follow the procedure below and write a user program in the case of changing the gear ratio 
while the positioning unit is in operation. 

1. Gear ratio change 
• Change the gear ratio numerator and denominator of the electronic gear in the setting area 

for the electronic gear. 

• The gear ratio at the time of starting the unit is set for this area. It is recommended to save 
the initial gear ratio before change so that the initial gear ratio can be reused with ease. 

1. Gear ratio change request 
• Turn ON an I/O signal (electronic gear ratio change request) for the target axis allocated to 

the unit. 

• This signal becomes enabled by the "edge type" operation. Starts the gear ratio change 
triggered by the gear ratio change request signal turned ON. 

• Turn OFF the gear ratio change request signal after changing the gear ratio. 
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 Gear ratio change request signal 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Slave axis gear ratio change 
request UM001E0 UM001E1 UM001E2 UM001E3 UM001E4 UM001E5 

Slave axis gear ratio change 
state annunciation UM001D2 UM001D3 UM001D4 UM001D5 UM001D6 UM001D7 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word). When the value of each bit 
is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  

REFERENCE  
• For details of the gear ratio setting area, refer to "15.8.1 Configuration of 

Synchronous Control Setting Area". 
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9.5 Electronic Clutch Function 

9.5.1 What is Electronic Clutch Function? 

The electronic clutch function is used to engage or disengage the clutch for output from the 
electronic gear. When the electronic clutch is disengaged, the master axis is separated from 
the slave axes and the slave axes not in synchronization with the master axis come to a stop. 
When the electronic clutch is engaged, the master axis and slave axes operate in 
synchronization. 

Synchronized Stop

Electronic gear
output

Electronic clutch
output

Speed [V]

Output speed

ON

OFF
Clutch

Input speed

Time [T]

 

 
• Keep in mind that the slave axes may come to a sudden stop if the clutch is 

disengaged while making a gear ratio change. 

KEY POINTS
 

• The electronic clutch is by default disengaged. Be sure to engage the 
electronic clutch in response to the operation. 
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9.5.2 Types and Contents of Setting Parameters 

For using the electronic clutch, set the following parameters in the "Synchronous parameter 
settings" menu. 

  
Parameter name Description 

Clutch setting - Use Select the operation of the electronic clutch function. 
Use / Not use 

Clutch ON trigger type Set an I/O clutch ON request as a trigger to be detected. 

Clutch ON edge selection Select "Level", "Leading edge" or "Trailing edge" for the method of detecting 
trigger signals. 

Clutch ON method Select "Direct" or "Slip" for the engagement of the clutch. 

Clutch ON slip method Select "Slip time specification". 

Clutch ON slip time If "Slip" is selected, set the slip time. 
Range: 1 to 10000 ms 

Clutch ON slip curve selection Select "Linear". 

Clutch OFF trigger type Select "I/O clutch OFF request" as a trigger to be detected. 

Clutch OFF edge selection Select "Disabled", "Leading edge" or "Trailing edge" for the method of detecting 
trigger signals. 

Clutch OFF method Select "Direct" or "Slip" for the engagement of the clutch. 

Clutch OFF slip time If "Slip" is selected, set the slip time.。 
Range: 1 to 10000 ms 

Clutch OFF slip curve 
selection Select "Linear". 

(Note 1): "Clutch OFF trigger type" is selectable when "Clutch ON trigger type" is set to "Leading edge" or "Trailing 
edge". 

KEY POINTS
 

• The electronic clutch is always engaged when setting the electronic clutch 
setting to "Not use", and output data from the electronic gear is input as it 
is into the electronic cam. At that time, the master axis always operates in 
synchronization with the slave axes. 
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9.5.3 Trigger Types for Electronic Clutch 

The electronic clutch is connected (ON) or disconnected (OFF) by controlling the ON request 
or OFF request in the output control area of the unit memories using user programs. 

3-axis spiral interpolation (Center point specification/
CW direction/Z-axis movement)

3-axis spiral interpolation (Center point specification/
CCW direction/Z-axis movement)

The center
position can be
specified.

The center
position can be
specified.

The interpolation speed is the tangential
velocity of arc.

The interpolation speed is the tangential
velocity of arc.

3-axis spiral interpolation (Pass point specification/
Z-axis movement)

The pass point on an arc can be specifed.

The interpolation speed is the tangential
velocity of arc.

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

(X axis)
1st axis

(Y axis)
2nd axis

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

(Z axis)
3rd axis

(X axis)
1st axis

(Y axis)
2nd axis

(Z axis)
3rd axis

3-axis linear interpolation
(Composite speed specification)

The composite speed
can be specified.

3-axis linear interpolation
(Long axis speed specification)

The axis speed for
the axis to be a long
axis can be specified.

 
(Note): The above shows an example of the direct method selected for the engagement of the clutch. 

 Clutch request signal 

Signal name 
Real axis Virtual axis 

Axes 
1-16 

Axes  
17-32 

Axes  
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Slave axis clutch ON request UM001E6 UM001E7 UM001E8 UM001E9 UM001EA UM001EB 

Slave axis clutch OFF 
request UM001EC UM001ED UM001EE UM001EF UM001F0 UM001F1 

Slave axis clutch operation 
annunciation UM001D8 UM001D9 UM001DA UM001DB UM001DC UM001DD 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word). When the value of each bit 
is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  

 Edge selection 
Edge selection Operation 

Level 
The clutch operation is switched by turning on or off the slave axis clutch ON request. The 
slave axis clutch OFF request signal is not used. When the edge selection is level, the 
slave clutch OFF request is disabled. 

Leading edge The clutch turns ON by the leading edge of the slave clutch ON request. Also, the clutch 
turns OFF by the leading edge of the slave clutch OFF request. 

Trailing edge The clutch turns on by the trailing edge of the slave clutch ON request. Also, the clutch 
turns OFF by the trailing edge of the slave clutch OFF request. 

 



9.5 Electronic Clutch Function 

 
9-19 

9.5.4 Engagement Method of Electronic Clutch 

The electronic clutch function engages the clutch to start operating the slave axes and 
disengages the clutch to stop operating the slave axes, the acceleration or deceleration of the 
slave axes can be set as shown below. 

 Direct method 
This method detects the engagement or disengagement of the clutch to adjust the operating 
speed of the master axis to coincide with that of the slave axes. In the direct method, the 
speed of the slave axes with the clutch engaged or disengaged coincides with the operating 
speed of the master axis with the acceleration and deceleration time set to 0. 

ON
OFF

Master axis operation

Slave axis operation

Clutch request signal
 

 Slip method 
This method detects the engagement or disengagement of the clutch and set the slip time to 
acceleration time and deceleration time so that the operating speed of the slave axes to follow 
the operation speed of the master axis. Linear acceleration and deceleration will apply. 

ON
OFF

Master axis motion

Slave axis operation

Clutch request signal

Slip time Slip time
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9.6 Electronic Cam Function 

9.6.1 Overview of Electronic Cam Function 

 What is Electronic cam function? 
The electronic cam function uses a preset cam pattern, determines the movement amount of 
the slave axes according to the operation of the master axis (phase information) and cam 
pattern, and outputs the movement amount. 

Electronic clutch
output

Slave axis output

Input axis
phase

Output axis
displacement

Input value
Current value [L]

Time [T]

Time [T]

Time [T]

Cam pattern

 

 Cam pattern 
The cam pattern uses one rotation of the master axis as an operation reference, based on 
which the displacement of the slave axes in each phase (rotation angle) is defined. The cam 
pattern is defined with the phase (rotation angle) of the master axis on the X-axis and the 
displacement on the Y-axis in percent. The cam pattern is set in the "Cam pattern setting" 
menu of CMI. 
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 Cam pattern specifications 
Setting item Specifications 
Resolution 1024, 2048, 4096, 8192, 16384, 32768 

No. of cam patterns 

 AFP7MC16EC AFP7MC32EC AFP7MC64EC 

Resolutions of 1024, 
2048, 4096, and 
8192: 

64 128 256 

Resolution of 16384: 32 64 128 

Resolution of 32768: 16 32 64 

Section setting 100%/cycle, 20 sections max. 

Displacement setting 100% setting 

Cam curve 

Constant speed / Constant acceleration / Simple harmonic / Cycloid /Modified 
trapezoid / Modified sine / Modified constant speed / Asymmetric cycloid / Asymmetric 
modified trapezoid / Trapecloid / One-dwell cycloid, m=1 / One-dwell cycloid, m=2/3 / 
One-dwell modified trapezoid, m=1 / One dwell modified trapezoid, Ferguson / One-
dwell modified trapezoid, m=2/3 / One-dwell modified sine / One-dwell trapecloid / No-
dwell modified trapezoid / No-dwell constant speed / NC2 curve 

Adjustment function Function to adjust the displacement of desired point data: Max. 1,000 points (in units of 
cam data) 

Shift function Phase shift in created cam data: 0 to 100% 

Display Displacement / Speed / Acceleration / Jerk 
The display can be changed arbitrarily by the check box of CMI. 

9.6.2 Types and Contents of Setting Parameters 

For using the electronic cam, set the following parameters in the "Synchronous parameter 
settings" menu. 

 
Parameter name Default Description 

Electronic cam setting 
- Use Not use 

Select the operation of the electronic cam. When selecting "Not use", the 
electronic cam function does not operate and the output from the 
electronic clutch is output. 
Use / Not use 

Cam control 
synchronous master 
cycle 

1 
Set the number of pulses corresponding to the all phases of the cam 
pattern used (one-rotation data on the master axis). 
Range: 1 to 2147483647 

Used cam pattern 
number 1 Specify the cam pattern number to be used from cam patterns created. 

Range: 1 to 256 

Cam stroke amount 1 
Set the number of pulses corresponding to the total displacement (100%) 
of the cam pattern to use. 
Range: 1 to 2147483647 
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9.6.3 Cam Pattern Setting Method 

The following procedure is explained on the condition that CMI has already started. 

 Starting Cam Pattern Setting Screen 
Select "Parameter" > "Cam pattern setting" from the menu bar. The cam patter setting screen 
is displayed. A blank screen is displayed for a new file, and settings of cam pattern 1 is 
displayed when data already exists. 

 

 Resolution setting 
Press the [Resolution] button on the Cam Pattern screen. The Resolution Settings screen will 
be displayed. Select the desired resolution and press the [OK] button. 
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KEY POINTS
 

• The resolution is valid for all cam patterns. You cannot set a different 
resolution per cam pattern. 

• The number of cam patterns available varies with each resolution. The 
current resolution cannot be changed to a new resolution if the number of 
cam patterns already set exceeds the number of cam patterns available for 
the new resolution. Delete the cam pattern and change the resolution. 

 

 Making/duplicating new cam pattern 
The Cam No. Selection screen is displayed by pressing the [Add] button from the Cam field. 

Select the desired can number and press the [OK] button. 

 

Cam patterns can be copied. Press the "Copy" button and select the cam pattern numbers of 
copy destination and copy source. 

 

For changing the cam number, press the "Change" button and select a cam number after the 
change. 

 

Note) Cam pattern numbers that have been already set cannot be set. 
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 Cam pattern setting 
Press the "Insert" button from the "Section" field. Set the start phase, and press the [OK] 
button. 

In the default condition, only one section whose phase is 0 to 100% can be set for the cam 
pattern. 

By setting the start phase, the above section is divided into multiple sections. 

 

The background of the selected sections is displayed in white, and the background of the 
unselected sections is displayed in gray. 

 
 

 
The start phase may not be a specified phase value due to the relation with resolution. 
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 Edit of cam table 
Data of created cam tables is edited. 

Set the following items in each set section; 
- Start phase (%) 
- Displacement (%) 
- Cam curve  
The cam curve changes according to the settings. 

 

KEY POINTS
 

• The end phase cannot be set. The end phase is automatically changed 
when changing the start phase. 

• Do not make a rapid change in displacement for the set cam curve. In the 
case of rapid displacement, a motor may not be able to follow the output. 

• Also, set the 0% and 100% of the phase to be the same displacement. 
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 Confirmation of cam table 
Confirm the set cam table (cam curve). In the synchronous control, slave axes operate 
following the cam curve. Therefore, a motor may not be able to follow the output if the change 
in the cam curve is rapid. For the change in the cam curve, not only the information on 
displacement but also the information such as acceleration information is important. In the 
cam table setting screen, the following information except displacement can be displayed. 

Display item Description 
Displacement This is set in the cam table. 

Speed 
The operation speed of the cam table with a set displacement amount is displayed. 
Also , the display is displayed by relative values. 

Acceleration 
Accelerations at each phase are displayed. 
Care is necessary in the area where acceleration largely changes as a rapid change in the 
speed occurs. 

Jerk It is obtained by differentiating an accleration by a time. It indicates a rate of change of 
acceleration. 

Each display item can be set by checking the following check boxes in the cam table setting 
screen. Refer to each display items, and change the cam table settings. 
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 Adjustment of cam table 
There is a function to finely adjust the data of set cam curves in the cam table setting screen. 
Rapid change can be lessened by performing find adjustment of the set cam data using the 
adjustment function. To perform adjustment, select a section number to be adjusted and press 
the [Adjust] button. The adjustment screen is displayed. The adjustment screen shows the 
table of the part corresponding to the specified section number among sections divided by the 
resolution that all sections (0 to 100%) are set. 

 
Select the data of a phase (control point) you want to adjust and change the displacement 
data. Select "OK" to reflect the adjustment. Select "Clear Adjustment" to clear the set 
adjustment data. The cam curve of the section number that the adjustment was executed is 
displayed in red so that it can be identified. 
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 Shift of cam table 
Although created cam patterns are defined for the phases of 0 to 100%, phases used as a 
reference for created cam patterns may be different in actual operations. The shift of cam 
table is a function to set the phase of the position of current value coordinate system 0 to be a 
percentage of a created cam pattern. 

Image of shifting electronic cam 

0 100 0-100 0

0 100 0-100 0
８１９/１０２４

0 100 0-100 0

Cam pattern
example
• Cycle: 1000
• Resolution:

1024

Current
coordinate position
after the clutch.

• In the case of setting coordinate 0 to 0% phase (0/1024).

Current
coordinate
system after
the clutch.

Current
coordinate
system after
the clutch.

• In the case of setting coordinate 0 to 80% phase (819/1024).

To what value
the phase of
coordinate 0 is
set?

 

Select Shift from "Section", and set a shift amount. 

  

The created cam pattern is shifted by 10% and the display is updated. 

Before change 

 

After change 

 

 Storage of cam table 
The created cam table is stored as a file together with other parameter data set by CMI. 
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10.1 Setting and Operation of Home Return 
In this example, a forward or reverse operation is performed in the JOG operation. 

Table
Forward JOGReverse JOG

Ball screw

(-) side (+) side  

 Settings 
Item Setting example 
Acceleration/deceleration pattern 0: Linear acceleration/deceleration 

Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 

Target speed 10000 pps 

 Operation diagram 

100 100

f [pps]

10000

100 100 t [ms]

Forward Reverse

Operation done flag

Forward JOG request

Reverse JOG request

BUSY flag
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 Operation of input control/output control signals 
• When a JOG operation forward or reverse request (corresponding bit allocated to UM0019E 

to UM001A9) is ON by a user program, the JOG operation control is performed. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the JOG operation control starts, 
and it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes 
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

JOG operation 
forward/reverse request  
(Note 1) 

UM0019E 
(Axes  
1 to 8) 

UM000A0 
(Axes  

17 to 24) 

UM000A2 
(Axes  

33 to 40) 

UM000A4 
(Axes  

49 to 56) 

UM000A6 
(Axes  
1 to 8) 

UM000A8 
(Axes  

17 to 24) 
UM0019F 

(Axes  
9 to 16) 

UM000A1 
(Axes  

25 to 32) 

UM000A3 
(Axes  

41 to 48) 

UM000A5 
(Axes  

57 to 64) 

UM000A7 
(Axes  

9 to 16) 

UM000A9 
(Axes  

25 to 32) 
Busy flag (Note 2) UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Operation done flag (Note 2) UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 

(Note 1): Request flags for 8 axes are allocated to each unit memory (1 word). When the value of each bit is 1, it turns 
on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

Axis no.

F● ● ● ● RFRF● ● ● ● RFR

● ● 912● ● 1316
● ● 1720● ● 2124
● ● 2528● ● 2932
● ● 3336● ● 3740
● ● 4144● ● 4548
● ● 4952● ● 5356
● ● 5760● ● 6164

JOG direction

● ● 14● ● 58F : Forward
R： Reverse

 
(Note 2): Flags or request signals for 16 axes are allocated to each unit memory (1 word). When the value of each bit 

is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  
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10.2 Changing Speed During JOG Operation 
The target speed can be changed during the JOG operation. 

 Settings 
Item Setting example 
Acceleration/deceleration pattern 0: Linear acceleration/deceleration 

Acceleration time 1 (ms) 100 ms 

Deceleration time 1 (ms) 50 ms 

Target speed 1 10000 pps 

Target speed 2 20000 pps Write a set value for the target speed after the speed change in 
the unit memory on a program. 

 Operation diagram 

100

f [pps]

10000

20000

200 150 t [ms]

Writing the target speed 2

Operation done flag

JOG forward request

BUSY flag

 

KEY POINTS
 

• Only in the case of "JOG operation (Infinite rotation)", the speed during the 
JOG operation can be changed. It cannot be changed in the case of "JOG 
operation inching operation". 

• The acceleration time and deceleration time when changing the target 
speed are the same as the values at the startup. 
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 Operation of input control/output control signals 
• When a JOG operation forward or reverse request (corresponding bit allocated to UM0019E 

to UM001A9) is ON by a user program, the JOG operation control is performed. 

• The speed is changed by rewriting "JOG operation target speed" in the parameter setting 
area of unit memories (for axis 1: UM0326C-UM0326D) using a user program during the 
JOG operation. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the JOG operation control starts, 
and it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes 
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

JOG operation 
forward/reverse request  
(Note 1) 

UM0019E 
(Axes 
1-8) 

UM000A0 
(Axes 
17-24) 

UM000A2 
(Axes 
33-40) 

UM000A4 
(Axes 
49-56) 

UM000A6 
(Axes 
1-8) 

UM000A8 
(Axes 
17-24) 

UM0019F 
(Axes 
9-16) 

UM000A1 
(Axes 
25-32) 

UM000A3 
(Axes 
41-48) 

UM000A5 
(Axes 
57-64) 

UM000A7 
(Axes 
9-16) 

UM000A9 
(Axes 
25-32) 

Busy flag (Note 2) UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Operation done flag (Note 2) UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 

(Note 1): Request flags for 8 axes are allocated to each unit memory (1 word). When the value of each bit is 1, it turns 
on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

Axis no.

F● ● ● ● RFRF● ● ● ● RFR

● ● 912● ● 1316
● ● 1720● ● 2124
● ● 2528● ● 2932
● ● 3336● ● 3740
● ● 4144● ● 4548
● ● 4952● ● 5356
● ● 5760● ● 6164

JOG direction

● ● 14● ● 58F : Forward
R： Reverse

 
(Note 2): Flags or request signals for 16 axes are allocated to each unit memory (1 word). When the value of each bit 

is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  
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10.3 Setting and Operation of JOG Inching Operation 
In this example, a forward or reverse operation is performed in the JOG operation by the 
inching operation. 

Table
Forward JOGReverse JOG

Ball screw

(-) side (+) side  

 Settings 
Item Setting example 
Acceleration/deceleration pattern 0: Linear acceleration/deceleration 

Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 

Target speed 10000 pps 

JOG inching movement amount 10000 pulses 

 Operation diagram 

100 100

f [pps]

10000

100 100 t [ms]

Operation done flag

BUSY flag

JOG inching
operation request

JOG operation
Forward/Reverse request

 

KEY POINTS
 

• The inching operation starts at the leading edge of the JOG forward/reverse 
request. Also, when the request signal is short, it operates until the pulse 
set for "inching movement amount" is output. 
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 Operation of input control/output control signals 
• When a JOG inching request (corresponding bit allocated to UM001AA to UM001AF) is ON 

by a user program and a JOG operation forward or reverse request (corresponding bit 
allocated to UM0019E to UM001A) turns ON, the JOG inching operation will be performed. 
The JOG inching operation starts when the edge of the JOG operation forward or reverse 
request changes to ON from OFF. 

• A busy flag (corresponding bit allocated to UM00090 to UM00095), which indicates that a 
requested operation is being controlled, will turn ON when the JOG inching operation control 
starts, and it will turn OFF when the operation completes. 

• An operation done flag (corresponding bit allocated to UM00096 to UM0009B), which 
indicates the completion of operation, will turn ON when the current operation is completed, 
and it will be held until the next positioning control, JOG operation, home return, or pulser 
operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes 
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

JOG inching operation 
request (Note 1) UM001AA UM001AB UM001AC UM001AD UM001AE UM001AF 

JOG operation 
forward/reverse request  
(Note 2) 

UM0019E 
(Axes 
1-8) 

UM000A0 
(Axes 
17-24) 

UM000A2 
(Axes 
33-40) 

UM000A4 
(Axes 
49-56) 

UM000A6 
(Axes 
1-8) 

UM000A8 
(Axes 
17-24) 

UM0019F 
(Axes 
9-16) 

UM000A1 
(Axes 
25-32) 

UM000A3 
(Axes 
41-48) 

UM000A5 
(Axes 
57-64) 

UM000A7 
(Axes 
9-16) 

UM000A9 
(Axes 
25-32) 

Busy flag (Note 1) UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Operation done flag (Note 1) UM00096 UM00097 UM00098 UM00099 UM0009A UM0009B 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word). When the value of each bit 
is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  
(Note 2): Request flags for 8 axes are allocated to each unit memory (1 word).When the value of each bit is 1, it turns 

on. When the value of each bit is 0, it turns off. 
bit no.15 08 7

Axis no.

F● ● ● ● RFRF● ● ● ● RFR

● ● 912● ● 1316
● ● 1720● ● 2124
● ● 2528● ● 2932
● ● 3336● ● 3740
● ● 4144● ● 4548
● ● 4952● ● 5356
● ● 5760● ● 6164

JOG direction

● ● 14● ● 58F : Forward
R： Reverse
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10.4 Sample Programs 

10.4.1 Sample Program (JOG Operation) 

The operation for starting the JOG operation is mainly divided into five steps on a user 
program. 

• Read flags stored in the unit memories (input control area). 

• Control the servo ON/OFF. 

• Check the state if the control of each axis can be started. 

• Set the condition for the JOG operation (option), confirm the required start condition and 
start the JOG operation. 

• Write operation results in the unit memories (output control area). 
(Note): The sample program on the next page is for activating the JOG operation of the axis number 1 for the FP7 MC 

Unit installed in the slot number 1. To simplify the explanation, the part related to the JOG operation is extracted. 

 Contents of sample program 
Mark Description 

① 
Read flags indicating states from the input control area of the unit memories (UM) to arbitrary areas 
(WR). 
Read flags such as connection confirmation flag, servo lock confirmation flag, busy flag, and error 
flag. 

② Servo ON/OFF control program 

③ Check required conditions and replace it with the start enabled flag (R110) in the program. 

④ 

 JOG operation program 

ⓐ 
Set the following operations as necessary. 
Changing the speed during the JOG operation, setting and switching the JOG inching operation.  

ⓑ Start the JOG operation (forward), start JOG operation (reverse). 

⑤ 
Write flags to the output control area of the unit memoires (UM) from arbitrary area (WR) where the 
start conditions are written. 
JOG operation start, JOG inching operation. 

KEY POINTS
 

• In the case of "JOG operation (Infinite rotation)", the unit operates by the 
level signals of "JOG forward/reverse request".  

• The "JOG inching operation" starts at the leading edge of the "JOG 
forware/reverse request". 

• It is possible to switch between "JOG operation (Infinite rotation)" and "JOG 
inching operation" by turning ON/OFF the corresponding bit to the "JOG 
inching operation request" area in the unit memories. 
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 Sample program 

R4300R1160 R110R230

R4300

（ ）DF

SR14
S1:UM0019EBKMV.US WR441WR430

X100

（ ）DF
R200

S1:UM0326CDT202MV.UL

④-ⓐ（ ）DF
R210

S1:UM0326EDT204MV.UL

R4420R220

R240R230
（ ）DF/

R241R231
（ ）DF/

R240

R4301R1160 R110R231

R4301

（ ）DF
R241

S1:UM001AABKMV.US WR447WR442
⑤

④-ⓑ

SR14

①

WR106BKMV.US S1:UM00089S1:UM00086

WR110BKMV.US S1:UM0008DS1:UM0008A

1st scan OFF

WR116BKMV.US S1:UM00096S1:UM00090
1-16
BUSY

Virtual 17-32
BUSY

1-16
BUSY

X100

X100 X104 R1060 R1100 R1580 R110

Axis 1 Start 
enabled 

flag

③

②Servo ON/OFF control program

WR158BKMV.US S1:UM000BFS1:UM000BA

1-16
Connection 
confirmation

49-64
Connection 
confirmation

1-16
Connection 
confirmation

1-16
Servo lock 
annunciation

49-64
Servo lock 
annunciation

Link 
Establish-

ment

1-16
Servo lock 
annunciation

1-16
Error occurrence

Virtual 17-32
Error occurrence

1-16
Error occurrence

Link 
Establish-
ment

Tool 
operation

Axis 1 
Connection 
confirmation

Axis 1 
Servo lock 

annunciation

Axis 1 Error 
occurrence

Axis 1 JOG 
operation 

target speed

Axis 1 
Speed change

Axis 1 JOG 
operation 

target speed

Axis 1 Inching 
movement 

amount

Axis 1 Inching 
movement 

amount change

Axis 1 Inching 
movement 

amount

Axis 1 Inching 
operation

Axis 1 Inching 
operation

Axis 1 Forward 
OFF edge

Axis 1 JOG 
forward

Axis 1 Reverse 
OFF edge

Axis 1 JOG 
reverse

Axis 1 
Start 

enabled 
flag

Axis 1 JOG 
forward

Axis 1 
Busy 

annunciation

Axis 1 JOG 
forward

Axis 1 
Forward 

OFF edge

Axis 1 JOG 
forward

Axis 1 JOG 
reverse

Axis 1 
Reverse 

OFF edge

Axis 1 JOG 
reverse

Axis 1 
Start 

enabled 
flag

Axis 1 
Busy 

annunciation

1st scan OFF Link 
establish-

ment

1-8
JOG operation 
start

Virtual 25-32
JOG operation 
start

1-8
JOG operation 
start

Axis 1 JOG 
reverse

1-16
Inching 
operation

Virtual 17-32
Inching 
operation

1-16
Inching 
operation  
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10.4.2 Precautions on Programming 

 Precautions on programming 
• If any value such as a movement amount, acceleration time, deceleration time or target 

speed is out of the specified range, a setting value error will occur at the time of startup. 

• Unit memory numbers allocated to flags and start requests vary depending on axis numbers. 

• The specified slot number varies depending on the installation position of the unit. 

 Operation at Over limit input (Limit is valid) 
Condition Direction Limit status Operation 

When JOG 
operation is started 

Forward 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Executable 

Reverse 
Over limit input (+): ON Executable 

Over limit input (-): ON Not executable, Error occurs. 

During JOG 
operation 

Forward Over limit input (+): ON Deceleration stop, Limit error occurs. 

Reverse Over limit input (-): ON Deceleration stop, Limit error occurs. 

 

 



 

 

11 
 Manual Operation (Home 

Return) 
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11.1 Types of Home Return 

 DOG method 1 (Based on front end + Z phase) 
• The leading edge of the first home position (Z phase) is set as a home position after the 

detection of the leading edge of a near home input (HOME). 

• In the case of the DOG method 1, the operation stops once after the detection of the leading 
edge of a near home input (HOME) as the home return positioning control mode 
(Method33/34) of Servo Amplifier A5B is used. The home position is searched at a home 
return creep speed again, and the operation stops when the leading edge of the first home 
position (Z phase) is detected. 

(Note): The home return positioning control mode (Method33/34) of Servo Amplifier A5B is a mode to detect an index 
pulse as a home position. The home return direction of Method33 is the - direction, and that of Method 34 is the 
+ direction. 

①

The starting point is
between the near home
input and limit (-) input.

③

The starting point is on the
near home input.

Limit (-) input

Z phase

Target speed

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed

Target speed Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Limit stop
deceleration time

Limit (+) inputNear home input

Home return direction

②

The starting point is on the
limit (-) input.

④

Temporary stop

The starting point is
between the near home
input and limit (+) input.
(including the starting point
on the limit (+) input)
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 DOG method 2 (Based on front end) 
• The leading edge of a near home input (HOME) is detected and it is set as a home position. 

• After the leading edge of a near home input (HOME) is detected, the deceleration stop is 
performed in the home return deceleration time. After reversing, the near home input 
(HOME) is searched at a home return creep speed, and the operation stops at a detected 
position. 

Target speed

Target speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return creep speed

Home return creep speed

Home return creep speed

Home return creep speed

Limit (-) input Limit (+) inputNear home input

Home return direction

The starting point is
between the near home
input and limit (+) input.
(including the starting point
on the limit (+) input)

The starting point is
between the near home
input and limit (-) input.

The starting point is on the
near home input.

The starting point is on the
limit (-) input.

①

③

②

④
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 DOG method 3 (Based on back end + Z phase) 
• The leading edge of the first home position (Z phase) in the home return direction set as a 

home position after the detection of a trailing edge (back end) of the near home input 
(HOME). 

• In the case of the DOG method 3, the operation stops once after the detection of the trailing 
edge of a near home input (HOME) as the home return positioning control mode 
(Method33/34) of Servo Amplifier A5B is used. The home position is searched at a home 
return creep speed again, and the operation stops when the leading edge of the first home 
position (Z phase) is detected. 

(Note): The home return positioning control mode (Method33/34) of Servo Amplifier A5B is a mode to detect an index 
pulse as a home position. The home return direction of Method33 is the - direction, and that of Method 34 is the 
+ direction. 

Limit (-) input Limit (+) inputNear home input

Home return direction

The starting point is
between the near home
input and limit (-) input.

The starting point is on the
near home input.

The starting point is on the
limit (-) input.

①

③

②

④

Z phase

Home return creep speed

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration timeThe starting point is

between the near home
input and limit (+) input.
(including the starting point
on the limit (+) input)

Temporary stop  
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 DOG method 4 (Based on back end) 
• The trailing edge of a near home input (HOME) is detected and it is set as a home position. 

• After the trailing edge of a near home input (HOME) is detected, the deceleration stop is 
performed in the home return deceleration time. After reversing, the near home input 
(HOME) is searched at a home return creep speed, and the operation stops at a detected 
position. 

Limit (-) input Limit (+) inputNear home input

The starting point is
between the near home
input and limit (-) input.

The starting point is on the
near home input.

The starting point is on the
limit (-) input.

①

③

②

④

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed
Home return
deceleration time

Home return
deceleration time

Home return creep speed

The starting point is
between the near home
input and limit (+) input.
(including the starting point
on the limit (+) input)
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 Limit method 1 (Limit signal + Z phase) 
• Reverses after detecting the leading edge of the limit switch on the opposite side of the 

home return direction. After that, the operation stops at the first leading edge of the home 
position (Z phase). It is set as a home position.  

• In the case of the limit method 1, the operation stops once in the home return deceleration 
time after the detection of the trailing edge of the limit input as the home return positioning 
control mode (Method33/34) of Servo Amplifier A5B is used. The home position is searched 
at a home return creep speed again, and the operation stops when the leading edge of the 
first home position (Z phase) is detected. 

(Note): The home return positioning control mode (Method33/34) of Servo Amplifier A5B is a mode to detect an index 
pulse as a home position. The home return direction of Method33 is the - direction, and that of Method 34 is the 
+ direction. 

Limit (-) input Limit (+) input

Home return direction

Z phase

The starting point is
between the near home
input and limit (+) input.

The starting point is on the
near home input.

①

②

Home return creep speed

Home return creep speed

Target speed Home return
deceleration time

Temporary stop  

 Limit method 2 (Limit signal) 
• Detects the leading edge of the limit switch in the home return direction and stops. It is set 

as a home position. 

Limit (-) input Limit (+) input

Home return direction

Home switch
The starting point is
between the near home
input and limit (+) input.

The starting point is on the
near home input.

①

②

Home return creep speed

Home return creep speed

Target speed

Limit stop
deceleration time
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 Z phase method 
The home position is searched at a home return creep speed from the current position, and 
the operation stops when the leading edge of the first home position (Z phase) is detected. 
For the Z phase method, the home return positioning control mode (Method33/34) of Servo 
Amplifier A5B is used. 
(Note): The home return positioning control mode (Method33/34) of Servo Amplifier A5B is a mode to detect an index 

pulse as a home position. The home return direction of Method33 is the - direction, and that of Method 34 is the 
+ direction. 

Home return direction

Z phase

Home return creep speed

 

 Stop-on-contact Method 1 
Stops by a mechanical stopping mechanism such as a stopper. A position when the stop-on-
contact time (ms) elapses at a torque value larger than "Stop-on-contact torque value (%)" set 
in the axis parameter of CMI is regarded as a home position. 

Home return direction

Home return creep speed

Stopper, etc.

 

 Stop-on-contact method 2 (Stop-on-contact + Z phase) 
Performs the reverse operation after the stop by a stopper and stops at the position where the 
first home position (Z phase) is detected although the operation is similar to the stop-on-
contact method. This position is set as a home position. 

Home return direction

Z phase

Home return creep speed

Stopper, etc.

 

 Data set method 
The current value is set as a home position. 

Home position (= Current value)
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11.2 Operation of Home Return 
In this example, the leading edge of the first home position (Z phase) is set as a home 
position after the detection of the leading edge of a near home input (DOG). 

Table

Ball screw

Home return

Near home switch(-) side

Z phase

(+) side

 

 Settings 
Item Setting example 
Return setting code 0: DOG method 1 

Return direction 0: Limit (-) direction 

Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 

Target speed 10000 pps 

Return creep speed 1000 pps 

 Operation diagram 
Target speed

Home return creep speed

Home return start request

Near home switch (DOG)

Z phase

Home return done flag

BUSY flag

Temporary stop  
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 Operation of input control/output control signals 
• When the home return request (corresponding bit allocated to UM00198 to UM0019D) turns 

ON by a user program, the home return will start. The home return request will be enabled at 
the edge where the contact turns ON. 

• The BUSY flag (corresponding bit allocated to UM00090 to UM00095), which indicates that 
a requested operation is being controlled, will turn ON when the control starts, and it will turn 
OFF when the operation completes. 

• The home return done annunciation flag (corresponding bit allocated to UM0009C to 
UM000A1), which indicates the completion of operation, will turn ON when the current 
operation is completed, and it will be held until the next positioning control, JOG operation, 
home return, or pulser operation starts. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes 
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Request home return UM00198 UM00199 UM0019A UM0019B UM0019C UM0019D 

Busy flag UM00090 UM00091 UM00092 UM00093 UM00094 UM00095 

Home return done 
annunciation flag UM0009C UM0009D UM0009E UM0009F UM000A0 UM000A1 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●

 

KEY POINTS
 

• In the case of the DOG method 1, the operation stops once after the 
detection of the leading edge of a near home input (HOME) as the home 
return positioning control mode (Method33/34) of Servo Amplifier A5B is 
used. The home position is searched at a home return creep speed again, 
and the operation stops when the leading edge of the first home position (Z 
phase) is detected. 
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11.3 Sample Programs 

11.3.1 Sample Program (Home Return) 

The operation for starting the JOG operation is mainly divided into five steps on a user 
program. 

• Read flags stored in the unit memories (input control area). 

• Control the servo ON/OFF. 

• Check the condition if the control of each axis can be started. 

• Confirm the condition and start the home return. 

• Write operation results in the unit memories (output control area). 
(Note): The sample program on the next page is for activating the home return of the axis number 1 for the FP7 MC 

Unit installed in the slot number 1. To simplify the explanation, the part related to the home return operation is 
extracted. 

 Contents of sample program 
Mark Description 

① 
Read flags indicating states from the input control area of the unit memories (UM) to arbitrary areas 
(WR). 
Read flags such as connection confirmation flag, servo lock confirmation flag, busy flag, and error 
flag. 

② Servo ON/OFF control program 

③ Check required conditions and replace it with the start enabled flag (R110) in the program. 

④ Home return start program. 

⑤ 
Write flags to the output control area of the unit memoires (UM) from arbitrary area (WR) where the 
start conditions are written. 
Home return start 

KEY POINTS
 

• Parameters related to the home return operation are set in the axis 
parameter of CMI. Refer to “5.2.4 Axis Parameters (Operation)”. 
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 Sample program 

R4240R110 R1160

Axis 1 
Home return 
start request ④

R300

Axis 1 Home 
return start

R4240

（ ）DF

SR14
S1:UM00198BKMV.US WR429WR424

X100

1-16
Home return 
start

Virtual 17-32
Home return 
start

SR14

①

WR106BKMV.US S1:UM00089S1:UM00086

WR110BKMV.US S1:UM0008DS1:UM0008A

WR116BKMV.US S1:UM00096S1:UM00090
1-16
BUSY

Virtual 17-32
BUSY

1-16
BUSY

X100

X100 X104 R1060 R1100 R1580 R110
③

②Servo ON/OFF control program

WR158BKMV.US S1:UM000BFS1:UM000BA

⑤

1st scan OFF Link 
establish-

ment

1-16
Connection 
confirmation

49-64
Connection 
confirmation

1-16
Connection 
confirmation

1-16
Servo lock 
annunciation

49-64
Servo lock 
annunciation

1-16
Servo lock 
annunciation

1-16
Error occurrence

Virtual 17-32
Error occurrence

1-16
Error occurrence

Axis 1 Start 
enabled flag

Link 
Establish-
ment

Tool 
operation

Axis 1 
Connection 
confirmation

Axis 1 
Servo lock 

annunciation

Axis 1 Error 
occurrence

Axis 1 Start 
enabled flag

Axis 1 Busy 
annunciation

Axis 1 
Home return 
start request

1st scan OFF Link 
establish-

ment

1-16
Home return 
start
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11.3.2 Precautions on Programming 

 Precautions on programming 
• If any value such as an acceleration time, deceleration time or target speed is out of the 

specified range, a setting value error occurs at the time of start. 

• Unit memory numbers allocated to flags and start requests vary depending on axis numbers. 

• The specified slot number varies depending on the installation position of the unit. 

 Operation at over limit input (Limit is valid) 
Condition Direction Limit status Operation 

When Home return 
operation is 
executed 

Forward 
Over limit input (+): ON Executable 

Over limit input (-): ON Executable 

Reverse 
Over limit input (+): ON Executable 

Over limit input (-): ON Executable 

During Home 
return operation 

Forward Over limit input (+): ON Automatic reverse operaiton 

Reverse Over limit input (-): ON Automatic reverse operaiton 
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12.1 Type of Stop Functions 

12.1.1 Type of Stop Operations 

• The following seven stop operations are available. 

• The system stop, emergency stop, deceleration stop, and pause will be effective when 
allocated request signals turn ON by user programs. 

• The limit stop, software limit stop, and error stop will be effective when corresponding 
conditions are established. 

 Type of stop operations 
Name Time chart Occurrence condition and operation 

System stop 
E

 

 Once a system stop request (Y0) turns 
ON, an active operation will stop and the 
operation of all axes will stop. 
 Stops in the deceleration time of 1 ms. 

Emergency 
stop 

E

Emergency stop deceleration time

 

 When an emergency stop request 
(corresponding bit allocated to UM001B0 to 
UM001B5) turns ON, an active operation will 
stop and the operation of corresponding 
axes will stop. 
 Performs a deceleration stop in the 
"emergency stop deceleration time" specified 
in the positioning parameter. 

Limit stop 

E

Limit stop deceleration time

 

 Once a limit + input and limit - input turns 
ON, an active operation will stop and the 
operation of corresponding axes will stop.  
"Limit switch" under "Axis parameter 
settings" > "Basic setup" should be set to "A: 
Enabled". 
 Performs a deceleration stop in the "limit 
stop deceleration time" specified in the 
positioning parameter. 

Software 
limit stop 

 When the software limit function is 
effective, an active operation will stop and 
the corresponding axes will stop when it 
exceeds the range of the software limit. 
 Performs a deceleration stop in the "limit 
stop deceleration time" specified in the 
positioning parameter. 

Error stop 

E

Error stop deceleration time

 

 When a unit error occurs, the operation of 
corresponding axes (all axes or axis in which 
the error occurs) will stop. 
 Target axes vary depending on the 
selection of the parameter "MC operation" > 
"Operation when an error occurs". 
 Performs a deceleration stop in the "error 
stop deceleration time" specified in the 
positioning parameter. 
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Name Time chart Occurrence condition and operation 

Deceleration 
stop 
(Note 1) 

E

Deceleration time

 

 When a deceleration stop request 
(corresponding bit allocated to UM001B6 to 
UM001BB) turns ON, an active operation will 
stop and the operation of corresponding 
axes will stop. 
 Performs a deceleration stop in the 
deceleration time specified for the active 
positioning operation. 

Pause 
(Note 1) 

Deceleration time

Stop is cancelled.  

 When a deceleration stop request 
(corresponding bit allocated to UM001B6 to 
UM001BB) turns ON, an active operation will 
stop and the operation of corresponding 
axes will stop. 
 Performs a deceleration stop in the 
deceleration time specified for the active 
positioning operation. 
 Once a deceleration stop signal turns 
OFF, the deceleration stop will be canceled 
and the stopped control will restart. 

(Note 1): The deceleration stop and pause operations are switched by the "MC common setting" parameter. 

 Allocation of I/O Numbers 
Signal name I/O number 
System stop Y0 

(Note 1): The I/O numbers in the above table show relative addresses based on the base word number. The I/O 
numbers actually used vary according to the slot number where the unit is installed and the starting word 
number. 

 Allocation of unit memories 

Signal name 
Real axis Virtual axis 

Axes  
1-16 

Axes  
17-32 

Axes 
33-48 

Axes  
49-64 

Axes  
1-16 

Axes  
17-32 

Emergency stop UM001B0 UM001B1 UM001B2 UM001B3 UM001B4 UM001B5 

Deceleration stop UM001B6 UM001B7 UM001B8 UM001B9 UM001BA UM001BB 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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12.1.2 Characteristics of Pause Function 

• The pause function is a function to temporarily stop the control in operation. The pause 
function is used by switching between the pause and deceleration stop functions. 

• The pause function is used to perform the deceleration stop in the deceleration time of an 
active control when a deceleration stop request (corresponding bit allocated to UM001B6 to 
UM001BB) turns ON. After that, the stopped state will be kept while the deceleration stop 
request is on, and the control in the stopped state will be restarted when the deceleration 
stop request turns off. 

KEY POINTS
 

• The deceleration stop cannot be executed when using the pause function. 
Use the emergency stop function to execute the stop operation when using 
the pause function. 

• The pause function is available only when performing the automatic 
operation (positioning control). During a manual operation (JOG 
operation/home return), it is the same operation as a deceleraiton stop. 

• The pause function keeps the stopped state as well as other stop functions 
when a deceleration stop request signal is on. If executing the emergency 
stop or system stop in paused state, the pause will be cancelled and the 
state will change to the one of the emergency stop or system stop. 

12.1.3 Stop Operation During Interpolation Control 

• For executing the emergency stop, deceleration stop, or pause, turn on a request 
corresponding to the smallest axis number in an interpolation group. 

• In the case of limit stop, software limit stop or error stop, the stop operation will start once a 
corresponding condition is established on one of axes in an interpolation group. 

12.1.4 Stop Operation During Synchronous Control 

REFERENCE  
• For details of the stop operation during synchronous control, refer to "9.2 

Settings for Master and Slave Axes" and "9.3 Start and Cancel of 
Synchronous Control". 
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12.2 Settings Related to Stop Function 

12.2.1 MC Common Settings 

• An operation when an error occurs is specified in the "MC common settings" dialog box. 

• Specify the items in "Parameter" > "MC common settings" of CMI. 

 

Parameter name Default Description 

Operation when an error 
occurs All axes stop 

Set the operation performed when an error occurs in axes 
(nodes) connected to the network. 

All axes stop All axes operations stop. (Note 1) 

Normal axis 
operation 
continuance 

The operation of the axis an error occurred 
stops. The operations of normal axes 
continue. 

Deceleration stop 
operation 

Deceleration 
stop Deceleration stop / Pause 

RUN->PROG. operation Operation 
continuance 

Set the operation when the operation mode of CPU unit changes 
from RUN to PROG. 

Operation 
continuance The operation of each axis continues. 

Deceleration 
stop 

Each axis decelerates and stops in a 
specified deceleration stop time in the current 
control mode. 

Immediate stop Each axis decelerates and stops in a 
specified emergency stop deceleration time. 

Error alarm to CPU unit Yes 

Set the method of notifying errors to the CPU unit. The operation 
mode of the CPU unit when an error occurs is set from "CPU 
configuration" - "Unit error" in FPWIN GR7. 

Yes Announces errors to the CPU unit. 

No Not announce errors to the CPU unit. 

(Note 1): When setting "All axes stop", normal axes will stop once when an error occurs in the JOG/inching operation, 
however, if the JOG operation request is ON after they stopped, the JOG/inching operation will start again. 
Create a user program to use the error annunciation flag as an interlock signal to stop the JOG/inching 
operation. 
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12.2.2 Axis Parameter 

The time of a stop operation is specified in the axis parameter setting menu. 

Specify the items in "Parameter" > "Axis parameter" > "Stop function setting" of CMI. 

 

Item Default Description 
Emergency stop 
deceleration time 100 ms Set the deceleration time at the time of emergency stop. 0 to 10000 ms 

Limit stop 
deceleration time 100 ms Set the deceleration time at the time of limit stop and software limit 

stop. 0 to 10000 ms   

Error stop 
deceleration time 100 ms Set the deceleration time at the time of error stop. 0 to 10000 ms  
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12.3 Operation During Stop 

 Operation during stop 
• The stop request for the system stop is performed by an output signal (Y0) in the I/O area. 

The stop requests for the emergency stop, deceleration stop and pause are performed by 
the bits allocated to the unit memories (UM) area). 

• The stopped state is held while each request signal is on until each of them turns off. Any 
operation cannot be activated in the stopped state. It is also the same in the cases of limit 
stop, software limit stop and error stop. 

 Priority of stop operations 
• When stop control requests are made simultaneously, the stop operations are executed 

according to the following priority. 

(1) System stop > (2) Error stop > (3) Software limit stop > (4) Limit stop > (5) Emergency stop 
> (6) Pause > (7) Deceleration stop 

 Dwell time setting 
• The dwell time setting is invalid in the stop operations regardless of operation patterns. 

• However, the dwell time setting is valid in the positioning operation after a pause. 

 Flag processing 
• In the case of system stop, the busy flag turns off and the operation done flag turns on. 

• In the cases of emergency stop, limit stop, software limit stop, error stop and deceleration 
stop, the busy flag turns off and the operation done flag turns on after the completion of 
deceleration. 

 Current value coordinate 
• Even in a stop operation, the current value coordinate area is always updated. 

• After the emergency stop, limit stop, software limit stop, error stop, deceleration stop or 
pause, deceleration is performed in each specified deceleration time, and values at the time 
of stop are stored. 

• In the case of system stop, the value at the time of stop is stored. 
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13.1 Dwell Time 
The time taken until the next operation after the completion of an executed positioning table in 
the automatic operation is called dwell time. 

 For E-point control 
The dwell time is the time taken from the completion of the position command until the 
operation done flag turns on. 

BUSY flag

Operation done flag

Dwell time

 
 

 For P-point control 
In the P-point control, the positioning table operates consecutively, therefore, the dwell time is 
ignored. For the last table (E point), as well as the E-point control, the dwell time is the time 
taken from the completion of the position command until the operation done flag turns on. 

BUSY flag

Operation done flag

Dwell time

 
 

 For C-point control 
The dwell time is the waiting time for executing the next table from the completion of the 
positioning talble (deceleraiton stop). For the last table (E point), as well as the E-point control, 
the dwell time is the time taken from the completion of the position command until the 
operation done flag turns on. 

BUSY flag

Operation done flag

Dwell time Dwell time Dwell time
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13.2 Software Limit 
The system is designed to mechanically set the limit (+) and limit (-) to restrict the moving 
range of a motor. 

Separately from the mechanical limits (+) and (-), the software limit is a function to add the 
limits on software for the absolute coordinate managed within the unit. As the software limit is 
a function for the protection of motors and servo amplifiers, it is recommended to set them to 
the values within the range of the mechanical limits (+) and (-) as below. 

Table

(-) side (+) side

Limit (+)

Ball screw

Limit (-)

Lower  limit value of
software limit

Upper  limit value
of software limit

 

When exceeding the setting range of the software limit (upper and lower limit values), an error 
occurs, and the deceleration stop is executed. It is necessary to clear the error and move the 
motor into the range of the software limit using an operation such as JOG operation after the 
stop. 

Table

(-) side (+) side

Lower limit value of
software limit

The table can move within the setting
range of the software limit.

 

Whether the software limit is set to be available or not can be specified individually for the 
positioning control, JOG operation and home return each. For example, it is possible to set 
the limit software to be invalid only when returning to the current value. 
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13.3 Auxiliary Output Code and Auxiliary Output Contact 
The auxiliary output contact is a function to inform about which table's operation is performing 
when the automatic operation (E-point control, C-point control, P-point control, J-point control) 
is executed. 

The auxiliary output contact and the auxiliary output code can be used by setting the 
parameter “auxiliary output mode” of each axis to the With or Delay mode. 

 Auxiliary output contact 
The With mode and Delay mode are available for the operations of auxiliary output contacts. 

Auxiliary 
output mode 

Operation 

With mode At the same time that the automatic operation starts, the auxiliary contact flag of a 
corresponding axis allocated to the I/O area turns on. 

Delay mode 

The auxiliary contact flag of a corresponding axis allocated to the I/O area turns on 
according to the ratio (%) of the positioning movement amount of automatic operation. 
The setting of the ratio of turning on the flag in the delay mode is set in the auxiliary output 
delay ratio area in the unit memories. 
However, when the automatic operation is set to the J-point control, the operation is the 
same as that in the with mode. 

Also, the ON time of an auxiliary contact flag can be specified in the ms unit. 

KEY POINTS
 

In the case of the J-point control, the operation in the delay mode is the same as that 
in the with mode. 
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 Auxiliary output data 
The auxiliary output data (1 word) can be set for each table of the positioning data. The 
content of the process currently carried out can be confirmed by setting the auxiliary output. 

The values in the auxiliary output data are held until the next positioning table is executed. 
Also, the auxiliary output data that was output just before the completion of the automatic 
operation is held. 

P E

1H 2H

1H 2H

Busy flag

Operation done flag

Auxiliary output data

Auxiliary output data

Auxiliary contact flag

Auxiliary contact flag

Auxiliary contact flag

Delay mode

With mode

Delay rate
(%)

Delay rate
(%)

Auxiliary output
ON time

(ms)

Auxiliary output
ON time

(ms)

Auxiliary output
ON time

(ms)

Auxiliary output
ON time

(ms)

 

KEY POINTS
 

Auxiliary output data is stored at the same time that the positioning operation starts 
regardless of the type of the auxiliary output mode (with mode or delay mode). 
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13.4 Current Value Update 
The current value update is a function to set the "current value after unit conversion" stored in 
the unit memories within FP7 MC Unit to an arbitrary value. 

• A value is set in the current value update coordinate area (UM005A0 to UM0065F) in the 
unit memories as a current value using a user program. 

• The "current value after unit conversion" of each axis information area is changed to the 
specified current value by turning on the bit of a target axis in the current value update 
request flag area (UM00590 to UM00595). 

 Program example 
The following figure shows a program to preset an arbitrary value "K100000" in the current 
value update area in the unit memories and update the value for the current value after unit 
conversion of 1st axis. 

R0
（ ）DF

MV.US S1：UM00590H1

MV.SL S1:UM005A0K100000

 

KEY POINTS
 

• The "current value after unit conversion" area in the unit memories is 
updated by the "current value update" function. Values in the "AMP current 
value" area are not updated. 

• An integer equivalent to the current value after unit conversion is set to the 
unit memory. 
Example) When the unit is um (0.1 um), set to "10000" for making it be 
1000.0 um. 
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 Current value update data area (Unit memories) 

Axis 
no. 

Unit 
memory no. 

(Hex) 
Name  Default Description 

Axes 1-
16 UM 00590 

Current 
value 
update 
request 

H0 

Only when the corresponding bit for each axis changes to 1 from 
0, the current value coordinate controlled by FP7 MC Unit are 
changed to the the current value update coordinate. Afther the 
change, FP7 MC Unit clears the corresponding bits to 0 
automatically.

bit Name Descirption 

0 Axis 1+16n: Current value 
update request 

0: No change 
1: Update the current value 
after unit conversion of a 
target axis 

1 Axis 2+16n: Current value 
update request 

2 Axis 3+16n: Current value 
update request 

3 Axis 4+16n: Current value 
update request 

4 Axis 5+16n: Current value 
update request 

5 Axis 6+16n: Current value 
update request 

6 Axis 7+16n: Current value 
update request 

7 Axis 8+16n: Current value 
update request 

8 Axis 9+16n: Current value 
update request 

9 Axis 10+16n: Current value 
update request 

10 Axis 11+16n: Current value 
update request 

11 Axis 12+16n: Current value 
update request 

12 Axis 13+16n: Current value 
update request 

13 Axis 14+16n: Current value 
update request 

14 Axis 15+16n: Current value 
update request 

15 Axis 16+16n: Current value 
update request 

 

Axes 
17-32 UM 00591 

Axes 
33-48 UM 00592 

Axes 
49-64 UM 00593 

Virtual 
axes 1-
16 

UM 00594 

Virtual 
axes 
17-32 

UM 00595 

Axis 1 UM 005A0 
- UM 005A1 

Current 
value 
update 
coordinate 

K0 

Stores the coordinate value to be preset as the current value after 
unit conversion. 
Range: -2147483648 to +2147483647 
An integer equivalent to the current value after unit conversion is 
set to the unit memories. 
Example) When the unit is um (0.1 um), set to "10000" for making 
it be 1,000.0 um. 

Axis 2 UM 005A2 
- UM 005A3 

  

Virtual 
axis 1 

UM 00620 
- UM 00621 

 - 

Virtual 
axis 32 

UM 0065E 
- UM 0065F 

(Note 1): Request signals for 16 axes are allocated to each area (1 word) of current value update request. When the 
value of each bit is 1, it turns on. When the value is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●

 
(Note 2): As for the unit memory in which the current value update coordinate is set, 2-word area is allocated for each 

axis. 
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13.5 Home Coordinates 
The home coordinates is a function to set the coordinates after the home return processing to 
arbitrary values. 

• The coordinates after the home return processing can be set in the "Axis parameter setting" 
dialog box of CMI or user programs. 

•  Set coordinates become the home coordinates by executing the home return for target axes. 

 Setting of home coordinates 
The home coordinates can be set for each axis in the "Axis parameter setting" dialog box of 
CMI. 

 

 Program example 
The following figure shows a program to read the current value after system conversion of the 
1st axis and set it as home coordinates. 

R0
（ ）DF

MV.SL S1：UM0328EDT100

MV.SL DT100S1:UM02656

 

 Home coordinates area (Unit memories) 

Axis no. 
Unit 

memory 
no.(Hex) 

Name Default Description 

Axis 1 UM 0328E 
- UM 0328F 

Home 
coordinates K0 

Stores the home coordinates to be set on completion of 
home return. 
Range: -2147483648 to ＋2147483647 
An integer equivalent to the current value after unit 
conversion is set to the unit memory. 
Example) When the unit is um (0.1 um), set to "10000" for 
making it be 1000.0 um. 

- - 

Axis 2 UM 0330E 
- UM 0330F 

- - 

Axis 64 UM 0526E 
- UM 0526F 

- - 
Virtual 
axis 1 

UM 0528E 
- UM 0528F 

- - 
Virtual axis 

32 
UM 0620E 
- UM 0620F 

(Note 1): As for the unit memories in which the home coordinates are set, 2-word area is allocated for each axis. 
(Note 2): The difference between the unit memory number of the target axis number and the unit memory number of 

the adjacent axis number is H20 (for 32 words). 
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KEY POINTS
 

• An integer equivalent to the current value after unit conversion is set for 
home coordinates. 
Example) When the unit is um (0.1 um), set to "10000" for making it be 
1000.0 um. 
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13.6 Movement Amount Automatic Check 
This is a function to monitor the position deviation calculated in FP7 MC Unit and generate an 
error or warning on the FP7 MC Unit side when it exceeds a set judgement value. 

• The movement amount automatic check is set in the "Axis parameter setting" menu of CMI. 
Judgement values can be set by respective axes. 

• when an error occurs, the operation will stop in the "error stop deceleration time, and cannot 
be executed until the error is cleared.When a warning occurs, only the occurrence of 
warning will be informed, and the operation will continue. 

 Parameter setting by CMI 

 
Parameter name Default Description 

Movement check 
operation 2:  None 

Select the operation when exceeding the movement amount 
automatic check threshold. 
0: Error, 1: Warning, 2: Not check 

Movement check value 
(pulse) 10000 

Set the threshold for the movement amount automatic check 
operation. 
Range: 0 to 65535 pulse 

REFERENCE  
• For details of errors and warnings, refer to "14 Troubleshooting". 
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13.7 Monitor Error (Torque / Actual Speed Judgement) 
This is a function to monitor the actual speed/torque of servo amplifier and generate an error 
or warning on the FP7 MC Unit side when it exceeds a set judgement value. 

• The monitor error is set in the "Axis parameter setting" dialog box of CMI. Judgement values 
can be set for torque and actual speed separately by respective axes. 

• when an error occurs, the operation will stop in the "error stop deceleration time, and cannot 
be executed until the error is cleared. When a warning occurs, only the occurrence of 
warning will be informed, and the operation will continue. 

Actual speed judgment value
or Torque judgment value

Error stop
deceleration time

Error annunciation flag  
(Note): The above figure shows an operation diagram when error is set. 

 Parameter setting by CMI 

 

Parameter name Default Description 

Monitor error - Torque 
judgment N: Disabled 

Select the operation of FP7 MC Unit when the torque value of the 
amplifier is monitored and exceeds the judgement value. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error - Torque 
judgment value (%) 500.0 Set the torque judgement value. 

Range: 0 to 500.0 (%) 

Monitor error - Actual 
speed judgement N: Disabled 

Select the operation of FP7 MC Unit when the actual speed of the 
amplifier is monitored and exceeds the judgement value. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error - Actual 
speed judgement value 
(rpm) 

5000 Set the actual speed judgement value. 
Range: 0 to 5000 rpm 

REFERENCE  
• For details of errors and warnings, refer to "14 Troubleshooting". 
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13.8 EtherCAT Communication Setting 

13.8.1 EtherCAT Configurator  

EtherCAT Configurator is a menu to configure a system and set parameters of EtherCAT 
communication on CMI. 

 Configuration of EtherCAT Configurator 

 

 Names and functions 
No. Name Description 

①  Project Explorer Registered slaves (Servo Amplifier A5B) are displayed. The slaves are 
connected in the connection order from the slave closest to FP7 MC Unit. 

② 

Device Editor Three tabs are available. 

 General Addresses are set. Information registered in the ESI file and connection 
states are displayed. 

 PDO Mapping Information on the PDO map of EtherCAT communication can be monitored. 

 Distributed Clocks The setting state of Distributed Clocks can be monitored. 

③ Short Info The attribute information on slaves can be monitored. 

④ Message Messages are displayed. 

 

① ② 

③ ④ 
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13.8.2 Device Editor 

Registered slaves and parameter information can be confirmed in the device editor. 

 "General" tab 

 
The address, axis number settings and information on ESI files and topology are displayed. 

 "Distributed Clocks" tab 

 
The communication cycle of synchronous unit is "EtherCAT communication cycle". The 
communication cycle of synchronous unit is set in the "MC common setting" of CMI not in this 
screen. 
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13.8.3 Overview of PDO Mapping 

PDO (process data object) is data upated for each communication cycle via EtherCAT. "PDO 
Mapping" can be confirmed in the device editor of CMI "EtherCAT Configurator". 

 

 PDO mapping tab 
Item Description 

Select The Inputs 

The maps of (input) data that is sent by Servo Amplifier A5B and received by FP7 MC 
Unit is displayed. 
Transmit PDO mapping 1 to Transmit PDO mapping 4 are displayed. 
Transmit PDO mapping 4 is selected. 

Select The Outputs 

The maps of data sent (output) by FP7 MC Unit and received by Servo Amplifier A5B 
are displayed. 
Receive PDO mapping 1 to Receive PDO mapping 4 are displayed. 
Receive PDO mapping 4 is selected. 

 
• For using FP7 MC Unit in combination with Servo Amplifier A5B, Transmit 

PDO mapping 4 and Receive PDO mapping 4 is used. Do not change the 
setting unless the general-purpose output (EXOUT1) is added. Careless 
changes of PDF mapping may cause malfunction. 
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13.8.4 Change of PDO Mapping 

For using the general-purpose output (EXOUT1) of Servo Amplifier, it should be added to the 
PDO mapping. The following procedure is explained on the condition that servo amplifiers 
have already been registered in CMI. 

PROCEDURE  
1.  Select an arbitrary servo amplifier in the project explorer. 

2.  Select PDO mapping in the device editor window. 

3.  Select "Settings" > "Enable Slave Edit" > "PDO Mapping" from the menu bar, 
and check the checkbox. 

  
You can now edit the field of PDO map. 

 
4.  Select "Receive PDO mapping 4" from the "Select The Outputs" box, and 

press the "Edit" button. 

 The "Edit PDO" dialog box is displayed. 
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5.   Press the [Add] button. 

The "Add PDO" dialog box is displayed. 

6.  Input the following items, and press the [OK] button. 

It returns to the "Edit PDO" dialog box. 

 
Item Input content 
General Name Digital Outputs 

Settings 

Index 0x60FE 

Sub index 1 

Data type DINT 
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7.  Confirm that the added information is displayed, and press the [OK] button. 

8.  Select "Settings" > "Enable Slave Edit" > "PDO Mapping" from the menu bar, 
and uncheck the checkbox. 

  

 
• Carry out the operation of the above procedure 8 to prevent data from being 

rewritten carelessly after finishing the edit of PDO mapping. 
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13.9 EC Packet Monitor Function 

13.9.1 Overview of Function 

The packet monitor function is a function to store sent or received packet data between the 
master (FP7 MC Unit) and slaves (Servo Amplifier A5B) as files. Packet data can be 
confirmed using commercial analyzer software. An SD memory card is required for using the 
EC packet monitor function. 

 Specifications of FP7 MC Unit 
Item Description 
Storage destination SD memory card inserted in FP7 MC Unit 

Packet data file format TCPDump format (cap) 

Packet data file size Max. 6 Mbytes per file 

No. of packets Max. 3904 packets 

Storage timing EC packet data is stored right after the power is turned on. 
EC packet data is stored at an arbitrary timing using user programs. 

13.9.2 Stored Files 

Packet data files are stored in a format such as the following in SD memory cards. 

 Specifications of FP7 MC Unit 
Item Description 
Storage destination folder \ECpacketLog 

Stored file 
File name: yyyyMMddhhmm-*** 
yyyy: Year, MM: Month, hh: Hour, mm: Minute, ***: Generation (000-999) 
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13.9.3 How to Set 

For using the packet monitor function, the settings related to the EC packet monitor are 
configured in CMI. 

 MC common setting dialog box 

 
Item Default Description 

EC packet monitor 
request flag setting Disabled 

Set the operation of packet monitor request flag of EC 
(EtherCAT) communication.  

Disabled Packet monitor is not executed when EC 
packet monitor request flag turns ON. 

Enabled Packet monitor is executed when EC packet 
monitor request flag turns ON. 

Execute EC packet 
monitor after power ON Not executed 

Set whehter or not to execute the EC packet monitor after the 
power is turned on. 
Not executed / Executed 

 Executing by user programs 
For executing the packet monitor, turn on the EC packet monitor request (Y1) at an arbitrary 
timing. 

I/O 
allocation 

Target 
axis Name Description 

X1 All axes EC packet 
monitor active 

Turns on when the monitoring of EtherCAT communication packet is 
executed by the EC packet monitor request (Y1). 
ON: Monitoring is executed, OFF: Monitoring stops 

Y1 All axes EC packet 
monitor request 

Requests the start of the monitor of EtherCAT communication packet 
when the EC packet monitor is enabled by "MC common parameter". 
The packet data is saved in an SD memory card. The monitoring stops 
when (Y1) turns off. The monitoring also stops, and (X1) turns off 
when the packet monitor capacity reaches 6 Mbytes or 3904 packets. 



Supplementary Functions 

13-20 
 

13.9.4 How to Execute 

The packet monitor is execute in the following procedure. 

 Procedure 

① Insert the SD memory card into FP7 MC Unit. 

② Confirm that the EC packet monitor is set with CMI. 

③ Turn on the power supply. Confirm. 

④ Confirm that the operation monitor LED [SD] is off, and remove the SD memory card. 

13.9.5 Handling of SD Memory Card 

 Usable SD memory cards 
Use of Panasonic industrial SD memory cards (SLC type) is recommended. 
http://panasonic.net/avc/sdcard/industrial_sd/lineup.html 

(Note) An operation check has not been conducted for SD memory cards made by other 
manufacturers. 

Printed logo 
on CPU unit 

Usable SD memory cards 
Card type Capacity 

 
SDHC memory card 512 MB to 16 GB 

 Cautions on handling an SD memory card 
The data saved in the SD memory card may be lost in the following cases. We assume no 
responsibility whatsoever for the lost of saved data. 

• The user or a third party has misused the SD memory card. 

• When the SD memory card was affected by any static electricity or electrical noise. 

• The SD memory card was taken out, or the PLC body was powered off, while the card was 
being accessed. 

 Formatting an SD memory card  
In principle, SD memory cards have been formatted by the time of purchase, and no 
formatting by the user is required. If formatting becomes necessary, download formatting 
software for SD memory cards on the following website. 

"SD Association’s website" 
https://www.sdcard.org/home/ 

http://panasonic.net/avc/sdcard/industrial_sd/lineup.html
https://www.sdcard.org/home/
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• A file system formatted by PC's standard formatting software does not 

satisfy the SD memory card specifications. Please use the dedicated 
formatting software. 

• It is recommended to save important data in another media for backup. 
Never remove the card or power off the PLC body while the SD LED on FP7 
MC Unit is lit (data is being read from or written into the card). Data may be 
damaged. 

• Do not use an SD memory card the memory capacity of which is more than 
the usable capacity. Data in the card may be damaged. 
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 Troubleshooting 
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14.1 Errors and Warnings 

14.1.1 Errors and warnings 

When any operational unconformity occurs in FP7 MC Unit, errors or warnings will occur. 
When errors or warnings occur, the following operations will be performed. 

Error 
Occurs in any abnormal conditions. When a motor is operating, the operation stops. 
The motor stopped due to the occurrence of error will not activate until the error clear is 
executed. 

Warning 
Occurs when any operational unconformity not abnormal conditions exist. 
The operation can continue even after the occurrence of warnings, and the motor continues 
running if the motor is operating. 

14.1.2 Checking and Clearing by CMI 

It is possible to check and clear errors/warning on an axis-by-axis basis by selecting [Online] > 
[Data monitor] on the programming tool CMI. Some errors cannot be cleared. Some system 
errors and communication errors of AMP cannot be cleared by this operation. The power 
supply of the unit should be restored. 
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14.1.3 Clearing Errors/Warnings Using User Programs 

Errors and warnings can be cleared by turning on the "error clear request" or "warning clear 
request" allocated to the output control area using user programs. 

 Clearing errors/warnings using unit memories (output control area) 
It is possible to clear errors and warnings on an axis-by-axis basis by turning on the 
error/warning clear request flags allocated to the output control area. Some errors cannot be 
cleared. Some system errors and communication errors of AMP cannot be cleared by this 
operation. The power supply of the unit should be restored. 

(Example) When clearing the error in the axis no.1 of FP7 MC Unit installed in slot 1 

WR158BKMV.UL S1:UM000BFS1:UM000BA

S1:UM000C8BKMV.UL WR477WR472

R600 R1580

R4720

（ ）DF
R4720

SR14 X100

SR14 X100

Axis 1 Error
clear request

Axis 1 Error 
clear request

Axes 1 
Error flag

Axes 1 to 16
Error flag

Virtual axes 
17 to 21
Error flag

Axes 1 to 16
Error clear 

request

Virtual axes 
17 to 21
Error clear request

1st scan OFF Link 
Establish-

ment

Axes 1 to 16
Error flag

1st scan OFF Link 
Establish-

ment

Axes 1 to 16
Error clear 

request  

 Allocation of unit memories (Input control area/Output control area) 

Signal name 
Real axis Virtual axis 

Axes 
1-16 

Axes 
17-32 

Axes 
33-48 

Axes 
49-64 

Axes 
1-16 

Axes 
17-32 

Error annunciation UM000BA UM000BB UM000BC UM000BD UM000BE UM000BF 

Warning annunciation UM000C0 UM000C1 UM000C2 UM000C3 UM000C4 UM000C5 

Error clear request UM001C8 UM001C9 UM001CA UM001CB UM001CC UM001CD 

Warning clear request UM001CE UM001CF UM001D0 UM001D1 UM001D2 UM001D3 

(Note 1): Flags or request signals for 16 axes are allocated to each unit memory (1 word) in the above table. When 
the value of each bit is 1, it turns on. When the value of each bit is 0, it turns off. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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14.1.4 Error and Warning Logs 

FP7 MC Unit has log areas to store error and warning codes in its unit memories. 

• Once an error/warning occurs, the error/warning code will be stored in the log area of the 
axis that the error occurred. 

• When an error/warning that is not related to the axes occurs, such as an failure in the unit, 
the error/warning code will be stored in the log areas of all axes. 

• In the data monitor or tool operation dialog box on CMI, only the latest error and warning 
codes of each axis can be confirmed. 

• For referring the error and warning logs for each axis, read the following unit memory from 
the PLC. 

 Configuration of log areas 
Classification Classification Function 

Error 
announciation & 
clear area 

Error clear  

No. of occurrences of 
errors The number of occurred errors is stored. 

Error code annunciation 
buffer 1 Up to eight error codes per axis are stored. 

Eight-digit hex codes are stored as error codes. 
The buffer 1 is always the latest code. Error codes are stored in 
the occurrence order from the buffer 1. 

------ 

Error code annunciation 
buffer 8 

Warning 
announciation & 
clear area 

Warning clear  

No. of occurrences of 
warnings The number of occurred warnings is stored. 

Warning code 
annunciation buffer 1 Up to eight warning codes per axis are stored. 

The buffer 1 is always the latest code. Warning codes are stored 
in the occurrence order from the buffer 1. 

------ 

Warning code 
annunciation buffer 8 

REFERENCE  
• For details of the log areas, refer to "15.5.8 Error Annunciation and Clear 

Area" and "15.5.9 Warning Annunciation and Clear Area". 
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14.2 Error Recovery Process 

14.2.1 Overview 

The method to recover from error occurrence varies according to the states when errors occur. 

Status when 
an error 
occurred 

Description Error type 

Recoverable 
state 
(Yes) 

- After an error occurred, the operating axes stop. 
- After an error occurred, FP7 MC Unit can recover the error at any 
time. 

All error types 

Unrecoverable 
state 
(No) 

- Error when a critical trouble occurred on the FP7 MC Unit system 
- When an unrecoverable error occurred, the power supply of the 
positioning unit should be restored. 

System errors 
AMP  
communication 
errors 
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14.3 Error Code Table 

14.3.1 System Errors (From 00F0 1000H 

These are the errors that occur due to any failure within FP7 MC Unit. The system errors are 
defined as the fatal errors for the system. 

Error 
code Error name Description Object Recovered Countermeasures 

1000H System 
runaway 

System runaway 
If the error occurs, the ALARM 
LED on the unit turns on. 

All 
axes No 

Turn off the power supply and turn 
it on again. 
If an error occurs repeatedly, 
consult your Panasonic 
representative. 

1001H Hardware 
error 

An error occurred in the hardware 
test when the power supply turned 
on. 

All 
axes No 

1002H Unit error Any error occurred in the internal 
processing. 

All 
axes No 

1010H FROM write 
error 

 Any error occurred in the 
execution of writing to FROM. 
(Write error/Verify error/Erase 
error) 

All 
axes Yes 

Execute writing to FROM again. If 
the error occurred repeatedly, 
please contact us. 

1020H 

Tool 
operation 
abnormal 
end 

Any error occurred in the 
communication with a PC when 
executing the tool operaiton on 
CMI. 

All 
axes Yes 

Check the connection of the cable 
connecting the PC and PLC. 
Reboot the PC. 

1030H 
CPU unit 
error ALARM occurred in the CPU unit. All 

axes No 
Check the condition of the CPU 
unit. Turn off the power supply 
and turn it on again. 

(Note 1): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
(Note 2): The power supply must be turned off and on again to recover the errors whose "Recovered" column is "No". 

14.3.2 AMP Communication Errors (From 00F0 2000H) 

These are the errors occurred in the communication beteween FP7 MC Unit and AMP. They 
occur when the communication data was judged as abnormal. 

Error 
code Error name Description Object Recovered Countermeasures 

2020H 
AMP station 
address 
duplicate error 

The AMPs with the same 
station address exist in the 
network. 

All 
axes No 

Afer checking the station address 
settings of AMP, turn off the 
power supply and turn it on again. 

2030H 
AMP station 
address setting 
error 

The AMP with a station 
address outside the settable 
range exists. 

All 
axes No 

2060H No ENI file No ENI file exists in FP7 MC 
Unit. 

All 
axes No Download CMI project data. 

2061H 
Network 
configuration 
verify error 

The network configuration 
defined in the ENI file is 
different from the acutal 
network configuraiton. 

All 
axes No 

Check whether the configuration 
matches the connection 
configuration set on CMI. 

2062H 
Process data 
receive timeout 
error 

The PDO (Process data) 
communication error occurred. 

All 
axes No 

Check the communication cable 
to see if it is correctly connected. 
Check the power supply of Servo 
Amplifier A5B. 

(Note 1): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
(Note 2): The power supply must be turned off and on again to recover the errors whose "Recovered" column is "No". 
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14.3.3 Axis Operation Errors (From 00F0 3000H) 

These are the errors occurred while various operations are being executed. 
Error 
code Error name Description Object Recovered Countermeasures 

3000H Not servo 
ready 

The axis that servo is not locked 
was started. 

Each 
axis Yes Confirm the servo is locked while 

each axis is operating 

3001H 
Servo off 
detection in 
operation 

The servo became off during 
the operation being processed. 

Each 
axis Yes 

Turn off the servo on input when 
the busy flag for the target axis is 
not on. 
Check the state of the AMP. 

3005H 
Main power 
supply OFF 
error 

The servo on was requested 
when the main power supply of 
the AMP was off. 

Each 
axis Yes 

Turn the servo on after the main 
power supply has been turned on. 
Check the voltage of the main 
power supply. 

3010H Limit + signal 
detection 

The input on the plus side of the 
limit turned on. 

Each 
axis Yes Move the motor into the range of 

the limit by an operation such as 
the JOG operation. 
Check the settings of Servo 
Amplifier and FP7 MC Unit to see 
if the limit input is correct. 

3011H Limit - signal 
detection 

The input on the minus side of 
the limit turned on. 

Each 
axis Yes 

3012H Limit signal 
error 

Both inputs on the plus and 
minus sides of the limit turned 
on. 

Each 
axis Yes 

Check the settings of Servo 
Amplifier and FP7 MC Unit to see 
if the limit input is correct. 

3020H 
Software limit 
(plus side) 
detection 

The movement amount of the 
motor exceeded the upper limit 
of the software limit. 

Each 
axis Yes Move the motor into the range of 

the software limit by an operation 
such as the JOG operation. 
Check the setting values of the 
software limit. 3021H 

Software limit 
(minus side) 
detection 

The movement amount of the 
motor exceeded the lower limit 
of the software limit. 

Each 
axis Yes 

3025H 

Command 
speed 
operation 
error 

The internal operation of 
command speed failed due to 
overflow. 

Each 
axis Yes 

Lower the set speed. 
Check the settings of the pulse 
number per rotation and 
movement amount per rotation. 

3030H 
Axis 
operation 
error 

An error occurred in the 
operation processing of each 
axis. 

Each 
axis Yes 

Check the setting values and 
parameters of the positioning unit. 
If the error occurs repeatedly with 
the correct set values, consult 
your Panasonic representative. 

3031H 
Operation 
abnormal 
end 

An error occurred in the 
operation processing of each 
axis. 

Each 
axis 
All 
axes 

Yes 
If an error occurs repeatedly, 
consult your Panasonic 
representative. 

3032H 
Axis group 
operation 
error 

The setting of axis group was 
changed during the operation or 
when requesting the stop. 
The setting of axis group is out 
of the range. 

Each 
axis Yes 

Changing the axis group should 
be performed when the axes are 
not in operation. 
Do not make a stop request, 
either. 
Check the axis group settings. 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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Error 
code Error name Description Object Recovered Countermeasures 

3033H 
Interpolation 
operation 
error 

The operation stopped as an 
error occurred on other 
interpolation axis during the 
interpolation operation. 

Each 
axis Yes 

Check the set values for 
positioning data on interpolation. 
If the error occurs repeatedly with 
the correct set values, consult 
your Panasonic representative. 

3035H 
Positioning 
movement 
amount error 

The positioning movement 
amount has exceeded the upper 
or lower limit. 

Each 
axis Yes Check the set value. 

3040H 
Synchronous 
operation 
group error 

The synchronous group was 
changed during the 
synchronous operation or when 
requesting the stop in the 
synchronous operation. 
The setting of synchronous 
group is out of range. 
An error occurred in the home 
return of the synchronous 
operation. 

Each 
axis Yes 

Changing the synchronous group 
should be performed when the 
busy flag for the axes to be 
synchronized is off. 
Also, it should be performed when 
various stop requests (system 
stop, emergency stop, 
deceleration stop) are off. 

3043H 
Synchronous 
operation 
error 

The operation has stopped as 
an error occurred on another 
axis while the positioning unit is 
in synchronous operation. 

Each 
axis Yes 

Check the unit setting of the 
stopped axis. 
If the error occurs repeatedly with 
the correct set values, consult 
your Panasonic representative. 

3046H 

Movement 
automatic 
check value 
error 

The difference between the 
command value and feedback 
value exceeded the movement 
automatic check value with the 
movement automatic check 
function. 

Each 
axis Yes 

Check the operation of the target 
axes. 
Check the parameter of the 
movement amount automatic 
check function. 

3050H 
Torque 
judgment 
error 

The torque value exceeds the 
setting upper and lower limit 
values. 

Each 
axis Yes 

Design the system within the 
range that the torque of the motor 
does nto exceed the judgment 
value. 
Check the torque judgment value. 

3051H 
Actual speed 
judgment 
value error 

The actual speed exceeds the 
setting upper and lower limit 
values. 

Each 
axis Yes 

Design the system within the 
range that the actual speed of the 
motor does nto exceed the 
judgment value. 
Check the actual speed jdgement 
value. 

3060H 

Home return 
not 
executable 
error 

The home return could not be 
executed as AMP parameter 
settings and signal input were 
not correct. 

Each 
axis Yes Check the parameters of AMP 

and signal inputs. 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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14.3.4 Setting Value Errors (From 00F0 4000H) 

These are the errors in the various setting values specified using the positioning setting menu 
of the programming tool or ladder programs. 

Error 
code Error name Description Object Recovered Countermeasures 

4000H Axis group 
setting error 

The settings of axis groups are not 
correct. 

Each 
axis Yes 

Check the following items in 
the settings of the axis group 
and independent axis. 
- The same axis number has 
been registered in more than 
one group. 
- Four or more axes have 
been set in one group. 
- The group is composed of 
one axis only. 

4002H Unit setting 
error 

The unit system for the axis setting 
is out of the range. 

Each 
axis Yes 

Check if the unit is one of the 
followings. 
pulse, µm, inch, degree 

4004H 

Pulse 
number per 
revolution 
error 

The number of pulses is out of the 
range. 

Each 
axis Yes 

Check the set value. 
If the setting value is out of 
the range, reduce it by the 
following formula. (Pulse 
number per rotation) / 
(Movement amount per 
rotation) 

4005H 

Movement 
per 
revolution 
error 

The movement amount is out of the 
range. 

Each 
axis Yes 

4010H Software limit 
setting error 

The upper or lower limit value of 
software limit is out of the range. 

Each 
axis Yes 

Check the set value. 
If the error occurs repeatedly 
with the correct set values, 
consult your Panasonic 
representative. 

4020H 
Limit stop 
deceleration 
time error 

The limit stop deceleration time is 
out of the range. 

Each 
axis Yes 

4021H 
Error stop 
deceleration 
time error 

The error stop deceleration time is 
out of the range. 

Each 
axis Yes 

4022H 

Emergency 
stop 
deceleration 
time error 

The emergency stop deceleration 
time is out of the range. 

Each 
axis Yes 

4028H 
Auxiliary 
output setting 
error 

The settings of auxiliary output are 
not correct. 
A mode other than With mode or 
Delay mode has been set for the 
auxiliary output mode. 
The auxiliary output delay ratio of 
Delay mode is not in the range of 0 
to 100 (%). 

Each 
axis Yes 

4030H 
Synchronous 
group setting 
error 

The same axis has been set for the 
synchronous groups 1 and 2. 
Either master axis or slave axis has 
not been set. 
Multiple master axes or slave axes 
have been set. 
The same axis has been set for the 
master and slave axes. 
- The slave axis has been set to the 
interpolation group. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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Error 
code Error name Description Object Recovered Countermeasures 

4044H Speed rate error The stting of th speed rate is out 
of the range. 

Each 
axis Yes 

Check the set value. 
If the error occurs 
repeatedly with the 
correct set values, 
consult your Panasonic 
representative. 

4050H Startup speed error The startup speed is out of the 
range. 

Each 
axis Yes 

4080H 
JOG positioning 
acceleration/decelerati
on type error 

The acceleration/deceleration 
method of the JOG positioning is 
out of the range. 

Each 
axis Yes 

4081H 
JOG positioning 
operation acceleration 
time error 

The acceleration time of the JOG 
positioning is out of the range. 

Each 
axis Yes 

4082H 
JOG positioning 
operation deceleration 
time error 

The deceleration time of the JOG 
positioning is out of the range. 

Each 
axis Yes 

4083H 
JOG positioning 
operation target speed 
error 

The target speed of the JOG 
positioning is out of the range. 

Each 
axis Yes 

4102H Home return target 
speed error 

The target speed of the home 
return is out of the range. 

Each 
axis Yes 

4105H Home return 
acceleration time error 

The acceleration time of the 
home return is out of the range. 

Each 
axis Yes 

4106H Home return 
deceleration time error 

The deceleration time of the 
home return is out of the range. 

Each 
axis Yes 

4107H Home return setting 
code error 

The home return setting code is 
incorrect. 

Each 
axis Yes 

4110H Home return creep 
speed error 

The creep speed of the home 
return is out of the range. 

Each 
axis Yes 

4111H Home return direction 
error 

The moving direction of the 
home return is out of the range. 

Each 
axis Yes 

4112H Home return limit error 

The limit switch is disabled. 
(It occurs when the home return 
method is set to the stop-on-
contact method 1 or 2.) 

Each 
axis Yes 

4115H 
Home return stop-on-
cotnact torque value 
error 

The home return stop-on-contact 
torque value is out of the range. 
(It occurs when the home return 
method is set to the stop-on-
contact method 1 or 2.) 

Each 
axis Yes 

4116H 
Home return stop-on-
contact judgment time 
error 

The home return stop-on-contact 
judgment time is out of the 
range. (It occurs when the home 
return method is set to the stop-
on-contact method 1 or 2.) 

Each 
axis Yes 

4120H Home coordinate error The set home coordinates are 
out of the range. 

Each 
axis Yes 

4201H JOG operation target 
speed error 

The target speed of the JOG 
operation is out of the range. 

Each 
axis Yes 

4203H 
JOG operation 
acceleration/decelerati
on type error 

The acceleration/deceleration 
type of the JOG operation is 
incorrect. 

Each 
axis Yes 

4204H JOG operation 
acceleration time error 

The acceleration time of the JOG 
operation is out of the range. 

Each 
axis Yes 

4205H JOG operation 
deceleration time error 

The deceleration time of the JOG 
operation is out of the range. 

Each 
axis Yes 

4206H Inching movement 
amount error 

The inching movement amount is 
out of the range. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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Error 
code Error name Description Object Recovered Countermeasures 

4250H Current value update 
error 

The setting value of the 
current value update is out 
of the range. 

Each 
axis Yes 

Check the set value. 
If the error occurs repeatedly 
with the correct set values, 
consult your Panasonic 
representative. 

4301H Absolute/incremental 
setting error 

A value other than the 
absolute/increment is set for 
the move method. 

Each 
axis Yes 

4302H Dwell time error 
The setting value of the 
dwell time is out of the 
range. 

Each 
axis Yes 

4303H Positioning starting 
table no. error 

The specified table number 
is 0, or it exceeds the 
maximum table number. 

Each 
axis Yes 

4304H Table setting error 
The last table of the 
positioning setting tables is 
not point E. 

Each 
axis Yes 

4400H Positioning movement 
amount setting error 

The movement amount of 
the positioning operation is 
out of the range. 

Each 
axis Yes 

4401H 
Positioning 
acceleration/decelerati
on type error 

The 
acceleration/deceleration 
type of the positioning 
operation is incorrect. 

Each 
axis Yes 

4402H Positioning 
acceleration time error 

The acceleration time of the 
positioning operation is out 
of the range. 

Each 
axis Yes 

4403H Positioning 
deceleration time error 

The deceleration time of the 
positionign operation is out 
of the range. 

Each 
axis Yes 

4404H Positioning target 
speed error 

The target speed of the 
positioning operation is out 
of the range. 

Each 
axis Yes 

4500H Interpolation type error 
The setting of the 
interpolation type is 
incorrect. 

Each 
axis Yes 

4504H Circular interpolation 
not executable 

The parameter of the circular 
interpolation (such as center 
point or pass point) is 
incorrect. 

Each 
axis Yes 

4505H Spiral interpolation not 
executable 

The error occurred during 
the spiral interpolation as the 
setting value is incorrect. 

Each 
axis Yes 

4609H 
Movement automatic 
check operation 
method setting error 

The setting for the operation 
of movement automatic 
check function is incorrect. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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14.3.5 Synchronous Parameter Setting Errors (From 00F0 5000H) 

 Synchronous parameter: Common errors 
Error 
code Error name Description Object Recovered Countermeasures 

5000H 

Synchronous 
master 
setting value 
error 

The setting for the synchronous 
master axis is incorrect. 

⇒Setting error (Value is 
incorrect.) 

⇒Own axis setting 

Each 
axis Yes 

Check the set value.  
If the error occurs repeatedly with 
the correct set values, please 
contact us. 

5002H 
Synchronous 
setting 
disable error 

The synchronous setting rquest 
was made in the following axis 
setting . 
- Its own axis (slave axis) is set 
as the master of another axis. 
- The master axis is set as the 
slave axis of another axis. 
- Its own axis (slave axis) 
belongs to the interpolation 
group. 

Each 
axis Yes 

5006H 

Synchronous 
slave single 
deceleration 
stop 
deceleration 
time 

The setting for the synchronous 
slave single deceleration stop 
time is incorrect. 

Each 
axis Yes 

Check the set value. 
If the error occurs repeatedly with 
the correct set values, please 
contact us. 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
 

 Synchronous parameter: Electronic gear related errors 
Error 
code Error name Description Object Recovered Countermeasures 

5100H 

Electronic 
gear - Gear 
ratio 
numerator 
setting error 

The setting for the gear ratio 
numerator of the electronic gear 
is incorrect. 

Each 
axis Yes 

Check the set value. 
If the error occurs repeatedly with 
the correct set values, please 
contact us. 

5101H 

Electronic 
gear - Gear 
ratio 
denominator 
setting error 

The setting for the gear ratio 
denominator of the electronic 
gear is incorrect. 

Each 
axis Yes 

5102H 

Electronic 
gear- Gear 
ratio change 
time setting 
error 

The setting for the gear ratio 
change time of the electronic 
gear is incorrect. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
 



14.3 Error Code Table 

 
14-13 

 Synchronous parameter: Electronic clutch related errors 
Error 
code Error name Description Object Recovered Countermeasures 

5200H 
Electronic clutch - 
Clutch ON trigger 
type setting error 

The setting for the clutch ON 
trigger type is incorrect. 

Each 
axis Yes 

Check the set value. 
If the error occurs repeatedly 
with the correct set values, 
please contact us. 

5201H 

Electronic clutch - 
Clutch ON edge 
selection setting 
error 

The setting for the clutch ON 
edge selection is incorrect. 

Each 
axis Yes 

5203H 
Electronic clutch - 
Clutch OFF trigger 
type setting error 

The setting for the clutch OFF 
trigger type is incorrect. 

Each 
axis Yes 

5204H 

Electronic clutch - 
Clutch OFF edge 
selection setting 
error 

The setting for the clutch OFF 
edge selection is incorrect. 

Each 
axis Yes 

5207H 
Electronic clutch - 
Clutch ON method 
setting error 

The setting for the clutch ON 
method is incorrect. 

Each 
axis Yes 

5208H 
Electronic clutch - 
Clutch ON slip 
method setting error 

The setting for the clutch ON 
slip method is incorrect. 

Each 
axis Yes 

5209H 
Electronic clutch - 
Clutch ON slip time 
setting error 

The setting for the clutch ON 
slip time is incorrect. 

Each 
axis Yes 

5210H 

Electronic clutch - 
Clutch ON slip curve 
selection setting 
error 

The setting for the clutch ON 
slip curve is incorrect. 

Each 
axis Yes 

5211H 
Electronic clutch - 
Clutch OFF method 
setting error 

The setting for the clutch OFF 
method is incorrect. 

Each 
axis Yes 

5212H 
Electronic clutch - 
Clutch OFF slip 
method setting error 

The setting for the clutch OFF 
slip method is incorrect. 

Each 
axis Yes 

5213H 
Electronic clutch - 
Clutch OFF slip time 
setting error 

The setting for the clutch OFF 
slip time is incorrect. 

Each 
axis Yes 

5214H 

Electronic clutch - 
Clutch OFF slip 
curve selection 
setting error 

The setting for the clutch OFF 
slip curve is incorrect. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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 Synchronous parameter: Electronic cam related errors 
Error 
code Error name Description Object Recovered Countermeasures 

5300H 

Electronic cam - 
Cam control 
synchronous 
master axis 
cycle setting 
error 

The setting for the cam 
control synchronous master 
axis cycle is incorrect. 

Each 
axis Yes 

Check the set value.。 

If the error occurs repeatedly with 
the correct set values, please 
contact us. 

5301H 

Electronic cam - 
Used cam 
pattern no. 
setting error 

The used cam pattern 
number is out of the range. 
The used cam pattern 
number is not registered. 

Each 
axis Yes 

5302H 

Electronic cam - 
Cam stroke 
amount setting 
error 

The setting for the cam 
stroke amount is incorrect. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 

 Cam pattern related errors 
Error 
code Error name Description Object Recovered Countermeasures 

5400H 
Cam pattern 
resolution 
setting error 

The setting for the cam 
pattern resolution is out of 
the range. 

Each 
axis Yes 

Check the set value.。 

If the error occurs repeatedly with 
the correct set values, please 
contact us. 

5401H 
Cam pattern set 
number setting 
error 

The cam pattern set number 
is out of the range. 

Each 
axis Yes 

5402H 
Cam pattern 
section function 
setting error 

The setting for the cam 
pattern section function is 
out of the range. 

Each 
axis Yes 

5403H 

Cam pattern 
control start 
position setting 
error 

The setting for the cam 
pattern control start position 
is out of the range. 

Each 
axis Yes 

5404H 
Cam pattern 
start phase 
setting error 

The start phase setting for 
each section of cam pattern 
is out of the range. 

Each 
axis Yes 

5405H 
Cam pattern 
displacement 
setting error 

The displacement for each 
section of cam pattern is out 
of the range. 

Each 
axis Yes 

5406H 
Cam pattern 
cam curve no. 
setting error 

The curve number for each 
section of cam pattern is out 
of the range. 

Each 
axis Yes 

5410H 
Adjustment data 
total no. setting 
error 

The total number of cam 
pattern adjustment data is 
out of the range. 

Each 
axis Yes 

5411H Adjustment data 
no. setting error 

The number of cam pattern 
adjustment data is out of the 
range. (cam pattern unit) 

Each 
axis Yes 

5413H 
Adjustment data 
control point 
setting error 

The control point of cam 
pattern adjustment data is 
out of the range. 

Each 
axis Yes 

5414H 
Out-of-range 
adjustment data 
setting error 

The adjustment value of cam 
pattern adjustment data is 
out of the range. 

Each 
axis Yes 

(Note): To simplify the displays, only the lower four digits (Hex) of each error code are displayed in the above table. 
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14.4 Warning Code Table 

14.4.1 Unit Warnings (From 00B0 0000H) 

These are the warning codes to be given when the warnings occurred in the unit. 
Error 
code Error name Description Object Recovered Countermeasures 

0008H SD memory 
card warning 

The SD memory card access 
error occurred. 

All 
axes Yes Check if an SD memory card is 

inserted correctly. 

0010H Duplicate 
startup 

The same axis was 
requested to start even 
though the axis operation 
has not completed. 

Each 
axis Yes 

The requests for the axes being 
operated cannot be executed, 
except the following requests. 
- System stop request flag (all 
axes) 
- Emergency stop request flag 
(each axis) 
- Deceleration stop request flag 
(each axis) 

0030H 
J-point 
simultaneous 
startup warning 

“J-point speed change 
request” and J-point 
positioning start request” 
turned ON simultaneously 
during the JOG positioning 
operation. 
The J-pont speed change 
request turned ON during 
acceleraiton/deceleration. 

Each 
axis Yes 

When the both requests have 
been turned on simultaneously, 
“J-point positioning start request” 
has a priority, and “J-point speed 
change request” is ignored. 
Please program to turn on the J-
pont speed change request during 
turned ON during the constant 
speed control. 

0031H 
J-point speed 
change request 
warning 

The J-point speed change 
request turned ON when J-
point operation is not active. 

Each 
axis Yes Check the timing that the J-point 

speed change request turns ON. 

0032H 
J-point 
positioning start 
request warning 

The J-point positioning start 
request turned ON when J-
point operation is not active. 

Each 
axis Yes 

Check the timing that the J-point 
positioning change request turns 
ON. 

0046H 
Movement 
automatic check 
warning 

The difference between the 
command value and 
feedback value exceeded 
the specified movement 
automatic check value with 
the movement automatic 
check function. 
This warning occurs when 
setting the movement 
automatic check operation to 
"Warning". 

Each 
axis Yes Check the operation of the target 

axes. 

0050H Torque 
judgment error 

The torque value exceeds 
the setting upper and lower 
limit values. 

Each 
axis Yes 

- Design the system within the 
range that the torque of the motor 
does nto exceed the judgment 
value. 
- Check the torque judgment 
value. 
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Error 
code Error name Description Object Recovered Countermeasures 

0051H 
Actual speed 
judgment value 
error 

The actual speed exceeds 
the setting upper and lower 
limit values. 

Each 
axis Yes 

- Design the system within the 
range that the actual speed of the 
motor does nto exceed the 
judgment value. 
- Check the actual speed 
judgement value. 

0100H 
Synchronous 
setting change 
disable warning 

The change of the 
synchronous setting was 
requested on an operating 
axis. 

Each 
axis Yes 

Changing the synchronous setting 
should be performed when the 
busy flag for the axes to be 
synchronized is off. 

(Note): To simplify the displays, only the lower four digits (Hex) of each warning code are displayed in the above table. 
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15.1 Specifications 

15.1.1 General Specifications 

Items Description 
Operating ambient 
temperature 0°C to +55°C 

Storage ambient 
temperature -40°C to +70°C 

Operating ambient humidity 10% to 95%RH (at 25°C with no-condensing) 

Storage ambient humidity 10% to 95%RH (at 25°C with no-condensing) 

Breakdown voltage 
Each external connector pin and entire power supply terminals of CPU unit 
500 V AC for 1 minute 

Insulation resistance 
Each external connector pin and entire power supply terminals of CPU unit 
100 MΩ min. (at 500 V DC) 

Vibration resistance 

Conforming to JIS B 3502 and IEC 61131-2 
5 to 8.4 Hz, 3.5-mm single amplitude 
8.4 to 150 Hz, acceleration of 9.8 m/s2 
10 sweeps each in X, Y and Z directions (1 octave/min) 

Shock resistance 
Conforming to JIS B 3502 and IEC 61131-2 
147 m/s2 min in X, Y, and Z directions three times each. 

Noise resistance 1,000 V [p-p], pulse width of 50 ns/1 μs (by noise simulator) 

Environment Free from corrosive gases and excessive dust. 

EC Directive applicable 
standard EMC directive: EN 61131-2 

Overvoltage category Category II or lower 

Pollution degree Pollution degree 2 or lower 

Internal current 
consumption 120 mA or less 

Weight Approx. 150 g 
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15.1.2 Communication Specifications 

Item Description 
Communication standard IEC 61158 Type12 

Physical layer 100BASE-TX (IEEE802.3) 

Baud rate 100M bps 

Trasmission distance Max. distance between nodes: 100 m 

Topology Daisy chain (without brach) 

Applicable cable Shielded twisted-pair cable (Category 5e or higher) 

Connector 9-pin RJ45 x 1 

Communication cycle 0.5ms / 1ms / 2ms / 4ms 

No. of connected slaves Max. 16 / 32 / 64 slaves (according to models) 

Coonnected slave Panasonic AC servo motor A5B series 

(Note): Hubs for EtherCAT and Ethernet cannot be used. 
 



Specifications 

15-4

15.1.3 Performance Specifications 

Item 
Description 

AFP7MC16EC AFP7MC32EC AFP7MC64EC 

No. of control axes Real axis: 16 axes 
Virtual axis: 8 axes 

Real axis: 32 axes 
Virtual axis: 16 axes 

Real axis: 64 axes 
Virtual axis: 32 axes 

Interpolation control 2-axis linear interpolation, 2-axis circular interpolation, 3-axis linear
interpolation, 3-axis spiral interpolation

No. of occupied I/O points Input: 16 points, Output: 16 points 

A
ut

om
at

ic
 o

pe
ra

tio
n 

P
os

iti
on

in
g 

co
nt

ro
l C

PS
 

Position specification method Absolute (specified absolute position), Increment (specified relative 
position) 

Position specified unit 

pulse 
μm  (select a minimum instruction unit of 0.1 μm or 1 μm) 
inch (select a minimum instruction unit of 0.00001 inch or 0.0001 inch) 
degree (select a minimum instruction unit of 0.1 degree or 1 degree) 

Position reference range 

pulse: -2147483648~+2147483647 pulse 
μm (0.1 μm): -214748364.8~+214748364.7 μm 
μm (1 μm): -2147483648~+214748364.8 μm 
inch (0.00001 inch): -21474.83648~+21474.83648 inch 
inch (0.0001 inch): -214748.3648~+214748.3648 inch 
degree (0.1 degree): -214748364.8~+214748364.7 degree 
degree (1 degree): -2147483648~+2147483647 degree 

Speed reference range 

pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

Acceleration/deceleration type Linear acceleration/deceleration 
S-shaped acceleration/deceleration

Acceleration time 0 to 10,000 ms (adjustable in 1-ms increments) 

Deceleration time 0 to 10,000 ms (adjustable in 1-ms increments) 

No. of positioning tables Each axis: 1000 points 

C
on

tro
l m

et
ho

d 

Independent 
PTP control (E- and C-point control) 
CP control (P-point control) 
JOG positioning control (J-point control) 

2-axis
interpolation

Linear 
interpolation 

 E-, P-, C-point control; composite speed or long-axis speed 
specification 

Circular 
interpolation E-, P-, C-point control; center or passing point specification 

3-axis
interpolation

Linear 
interpolation 

E-, P-, C-point control; composite speed or long-axis speed 
specification 

Spiral 
interpolation E-, P-, C-point control; center or passing point specification 

Other functions Dwell time: 0 to 32,767 ms (Settable by 1 ms), auxiliary output 
contact, auxiliary output code 
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Item 
Description 

AFP7MC16EC AFP7MC32EC AFP7MC64EC 

S
yn

ch
ro

no
us

 o
pe

ra
tio

n 
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tio

n 

Synchronous 
basic setting 

Master axis Selectable from real axes, virtual axes and pulse inputs. 

Slave axis Max. 8 
axes/master 

Max. 16 
axes/master 

Max. 32 
axes/master 

Electronic 
gear 

Operation setting Gear ratio setting 

Operation method Direct method, acceleration/deceleration methodv 

Electronic 
clutch 

Clutch ON trigger Contact input 

Clutch method Direct method, linear slide method 

Electronic 
cam 

Cam curve Select from 20 types. Multiple curves can be specified within 
phase (0 to 100%) 

Resolution 1024, 2048, 4096, 8192, 16384, 32768 

No. of cam patterns 
16 to 64 
(According to 
resolution) 

32 to 128 
(According to 
resolution) 

64 to 256 
(According to 
resolution) 

M
an

ua
l o

pe
ra

tio
n 

JOG/Inching 
operation 

Speed reference range 

pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

Acceleration/deceleration 
type Linear acceleration/deceleration, S acceleration/deceleration 

Acceleration time 0 to 10,000 ms (adjustable in 1-ms increments) 

Deceleration time 0~10,000 ms  (adjustable in 1-ms increments) 

Home return 

Speed reference range 

pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

Acceleration/deceleration 
type Linear acceleration/deceleration 

Acceleration time 0 to 10,000 ms (adjustable in 1-ms increments) 

Deceleration time 0 to 10,000 ms (adjustable in 1-ms increments) 

Return method DOG method (4 types), Limit method (2 types), Z phase 
method, Stop-on-contact method (2 types), Data set method 

S
to

p 
fu

nc
tio

n Stop operation type System stop, emergency stop, limit stop, error stop, 
deceleration stop, pause 

Stop deceleration time 

The system stops when the deceleration time of all axes 
reaches 1 ms. 
The deceleration time of emergency stop, limit stop, error 
stop, deceleration stop and pause is 0 to 10,000 ms. (Settable 
by 1 ms.) 

Memory backup 

The data of communication parameters, positioning 
parameters and positioning tables is saved in the FROM 
within FP7 MC Unit (without battery). 
Guaranteed number of times of writing: Up to 10000 times 

Other functions (Note 1) 
General-purpose input: 5 points, General-purpose output: 1 
point (Input/output from AMP) 
Torque monitor, actual speed monitor 

(Note 1): Two points out of five general-purpose inputs are used as limit inputs. 
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15.2 I/O Allocation 
• In FP7 MC Unit, the I/O signals common to each axis are allocated to the I/O numbers in the 

following table.  

• The I/O numbers actually used vary according to the slot number where the unit is installed 
and the starting word number. 

 Allocation of I/O numbers (Input) 

I/O no. Target 
axis Name Description 

X0 All axes Link 
establishment 

Announces the establishment of the network link. 
ON: Link is establised, OFF: Link is stopped 

X1 All axes EC packet 
monitor active 

Turns on when the monitoring of EtherCAT communication packet is 
executed by the EC packet monitor request (Y1). 
ON: Monitoring is executed, OFF: Monitoring stops 

X2 － (Reserved for 
system) － 

X3 All axes FROM writing 
active 

Announces that data (positioning parameters, positioning tables) in the 
unit memory is being written in the FROM. 
ON: Writing is in progress, OFF: Writing is complete (Normal or 
abnormal end)  

X4 All axes Tool operation 

Flag to indicate that the positioning unit is in tool operation. The start-up 
by a user program (output control area) is not available during the Tool 
operaiton. If it performs, a warning will occur. 
ON: Tool operation is being executed, OFF: Tool operation is not 
executed 

X5 All axes All groups setting 
done 

Makes axis group setting changes in the unit with the axis group setting 
request contact (Y5) turned ON after making setting changes in the axis 
group with the program. The contact turns ON upon completion of the 
setting changes. 

X6 － (Reserved for 
system) - 

X7 All axes Recalculation 
done 

Tthe positioning data of the unit memory is restructured by turning on 
the recalculation request contact (Y7). This contact turns on after the 
completion of restructuring. 
If the recalculation request contact (Y7) turns on again, this contact will 
be off once. 
Note) It is used only when the positioning data has been rewritten by 
laddar programs. 

X8-XD － (Reserved for 
system) - 

XE All axes SD memory card 
access active 

Turns on while accessing an SD memory card. 
ON: Access in progress, OFF: Access stops 

XF All axes Initialization done 

Indicates that the initial preparation of FP7 MC Unit has been 
completed by reading the setting data from the FROm in the unit when 
the power turns on. 
ON: FP7 MC Unit preparation done, OFF: FP7 MC Unit in preparation 

(Note 1): The I/O numbers in the above table show relative addresses based on the base word number. The I/O 
numbers actually used vary according to the slot number where the unit is installed and the starting word 
number. 
Example) The link establishment flag is X100 for slot number 1 if the starting word is number 10. 
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 Allocation of I/O Numbers (Output) 
 

I/O no. Target 
axis Name Description 

Y0 All axes System stop 
Request the system stop. When it turns on, all axes stops with the 
deceleration time of 1 ms. While this is on, all operation cannot be 
started. 

Y1 All axes EC packet 
monitor request 

Requests the start of the monitor of EtherCAT communication packet 
when the EC packet monitor request flag is enabled by "MC common 
parameter". The packet data is saved in a SD memory card. The 
monitorint stops when (Y1) turns off. The monitoring also stops, and 
(X1) turns off when the packet monitor capacity reaches 6 Mbytes or 
3904 packets. 

Y2 － － － 

Y3 All axes FROM write 
request 

Requests the writing of data (parameters, positioning tables) in the unit 
memory to teh FROM. The FROM writing active flag (X3) is on during 
the writing, and (X3) turns off on completion of the writing. 
The writing result is stored in the unit memory (UM283). 

Y4 － (Reserved for 
system) － 

Y5 All axes Axis group setting 
change request 

This is used for changing the "Axis group setting" in the unit memory 
by user programs. Execute the following procedures by user 
programs. 
1) Write data to "Axis group setting area". 
2)  Turn on "Axis group setting change request (Y5)". 
3)  After confirming  "Axis grup setting done flag (X5)" turns on, turn off 
(Y5). 

Y6 － (Reserved for 
system) － 

Y7 All axes Recalculation 
request 

This is used for changing the "positioning table data" stored in the 
system area within FP7 MC Unit by user programs. The positioning 
data after the table number starting the recalculation specified in the 
unit memory can be restructured and is executable by turning on this 
signal. Execute the following procedures by user programs. 
1)  Write data to "positioning table". 
2)  Turn on "Recalculation request (Y7)". 
3)  After confirming "Recalculation done flag (X7)" turns on, and turn 
off (Y7). 
For details, refer to "8.5 Rewriting Positioning Data by User 
Programs". 

Y8-YF － (Reserved for 
system) － 

 

(Note 1): The I/O numbers in the above table show relative addresses based on the base word number. The I/O 
numbers actually used vary according to the slot number where the unit is installed and the starting word 
number. 
Example) The system stop request signal is Y100 for slot number 1 if the starting word is number 10. 
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15.3 Whole Configuration of Unit Memories 
The unit memories of F7 MC Unit are configured as follows. For details of each area, refer to 
"15.4 to 15.8". 

Name Unit memory no.
（Hex.） 

No. of 
occupied 
words 

Individual name of each area 

Reserved 
area for the 
system 

UM00000 - UM0007F 128 words Reserved area for the system 

Input 
control area UM00080 - UM0017F 256 words Input control area 

Output 
control area UM00180 - UM0027F 256 words Output control area 

Common 
area 

UM00280 - UM0037F 256 words Setting parameter control area 

UM00380 - UM003FF 128 words Operation speed rate area 

UM00400 - UM0048F 144 words Reserved area for the system 

UM00490 - UM0058F 256 words Axis group setting area 

UM00590 - UM0068F 256 words Current value update data area 

UM00690 - UM0098F 768 words Reserved area for the system 

UM00990 - UM009EF 96 words Positioning control starting table number setting 
area 

UM009F0 - UM00A4F 96 words Positioning control area 

UM00A50 - UM00A8F 64 words Reserved area for the system 

UM00A90 - UM0170F 3200 words Error announciation & clear area 

UM01710 - UM0238F 3200 words Warning announciation & clear area 

UM02390 - UM025CF 576 words 
Synchronous axis control monitor area 
For (6 words for each axis) x (64 real axes + 32 
virtual axes) 

UM025D0 - UM0260F 64 words Reserved area for the system 

Reserved 
area for the 
system 

UM02610 - UM0263F 48 words Reserved area for the system 

Each axis 
information 
monitor 
area 

UM02640  -  UM0323F 3072 words 
Each axis information monitor area 
For (32 words for each axis) x (64 real axes + 32 
virtual axes) 

Each axis 
setting area 

UM03240  - UM0623F 12288 words 
Parameter setting area 
For (128 words for each axis) x (64 real axes + 32 
virtual axes) 

UM06240 - UM63EFF 384192 words 

No. of buffers: 24 
For (16008 words for each buffer) x (24 buffers) 

The configuration per buffer is as follows. 
Buffer control area: 8 words 
Table data setting area: 16000 words 

Reserved 
area for the 
system 

UM63F00 - UM63F3F 64  words Reserved area for the system 
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Name Unit memory no.
（Hex.） 

No. of 
occupied 
words 

Individual name of each area 

Synchronous 
control 
setting area 

UM63F40 – UM65B3F 7168 words 

For (112 words for each axis) x (64 real axes) 

The configuration per axis is as follows. 
Synchronous control setting area: 16 words 
Common setting area: 16 words 
Clutch control area: 48 words 
Electronic cam setting area: 32 words 

UM65B40 - UM6693F 3584 words Reserved area for the system 

Reserved 
area for the 
system 

UM66940 - UM66D47 1032 words Reserved area for the system 

 

 Reading from unit memories (UM) 
It is possible to read the areas which are shown with "Available" in the "R" column in the 
following table using transfer instructions or arithmetic instructions with user programs. The 
operand of an instruction is specified by the combination of the slot number where the slot is 
installed and a unit memory number (UM). 

Example) Program to read the input control area (UM00086-UM00089) of the FP7 MC Unit 
installed in the slot no. 1 (S1) to an arbitrary internal relay area (WR106-WR109) 

R0
S1:UM00086 S1:UM00089 WR106MV.US

X100

 

 Writing to unit memories (UM) 
• It is possible to write to the areas which are shown with "Available" in the "W" column in the 

following table using transfer instructions or arithmetic instructions with user programs. The 
operand of an instruction is specified by the combination of the slot number where the slot is 
installed and a unit memory number (UM). 

• Be sure not to execute writing in the reserved areas for the system. 
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15.4 Unit Memories (Input and Output Control Areas) 

15.4.1 Configuration of Input Control Area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

UM 00080

UM 00086

UM 0008A

Each axis connection confirmation

Servo lock annunciation

UM 0008E

UM 00090 Busy annunciation

UM 00096 Operation done annunciation

UM 0009C Home return done annunciation

UM 000A2 Near home input

UM 000A6

UM 000AC Auxiliary contact

UM 000B2 Limit + / Limit -

UM 000BA Error annunciation

UM 000C0 Warning annunciation

UM 000C6 Synchronous setting done annunciation

UM 000CA

UM 000D0

UM 000CC Synchronous cancel active announciation

UM 000D2 Slave axis gear ratio change annunciation

UM 000D8 Slave axis clutch operation annunciation

UM 000DE General-purpose input

UM 000FE Registered slave table

UM 0010A Network participating slave table

UM 00116

UM 00122 Normal slave table

UM 0012E Abnormal slave table

UM 0013A

6 words

4 words

4 words

4 words

6 words

6 words

6 words

2 words

6 words

6 words

6 words

6 words

4 words

4 words

4 words

4 words

2 words

2 words

8 words

32 words

12 words

12 words

12 words

12 words

12 words

70 words

UM 000D6 2 words

UM 000DC 2 words

Whole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

48 words

3,072 words

396,480 words

64 words

10,752 words

Each axis setting area

Input control area

System area
Starting no. Name No. of words

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system
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15.4.2 Configuration of Output Control Area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

UM 00180

UM 00186

UM 0018A

Servo ON request

UM 0018C Servo OFF request

UM 00190

UM 00192 Positioning start request

UM 00198 Home return start request

UM 0019E JOG operation Forward/Reverse request

UM 001AA Inching operation request

UM 001B0 Emergency stop request

UM 001B6 Deceleration stop request

UM 001BC J point speed change request

UM 001C2 J point positioning start request

UM 001C8 Error clear request

UM 001CE Warning clear request

UM 001D8

UM 001D4 Synchronous setting request

UM 001DA Synchronous cancel request

UM 001DE

UM 001E0 Slave axis gear ratio change request

UM 001E6 Slave axis clutch ON request

UM 001EC Slave axis clutch OFF request

UM 001F2 General-purpose output

UM 001FA

6 words

4 words

2 words

12 words

2 words

6 words

6 words

4 words

6 words

6 words

6 words

6 words

4 words

2 words

6 words

4 words

6 words

2 words

6 words

4 words

4 words

4 words

8 words

134 words

UM 001E4 2 words

UM 001EA 2 words

UM 001F0 2 words

Whole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

Output control area

128 words

256 words

256 words

9,104 words

3,072 words

396,480 words

10,752 words

Each axis setting area

Input control area

System area

48 words

64 words

System area

Starting no. Name No. of words
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15.4.3 List of Input Control Area Functions 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

- UM 00080 
-UM 00085 

Reserved for 
system - - - - 

1-16 UM 00086 
Each axis 
connection 
confirmation 

H0 When corresponding axes exist, the bits 
corresponding to each axis number turn on.  - 

17-32 UM 00087 

33-48 UM 00088 

49-64 UM 00089 

1-16 UM 0008A 

Servo lock 
annunciation H0 

When corresponding axes are in the servo-
locked state, the bits corresponding to each 
axis number turn on. 
[The update cycle is communication 
(EtherCAT communication) cycle.] 
0 : Servo-free state 
1 : Servo-locked state 

 - 

17-32 UM 0008B 

33-48 UM 0008C 

49-64 UM 0008D 

- UM 0008E 
-UM 0008F 

Reserved for 
system - - - - 

1-16 UM 00090 

Busy 
annunciation H0 

When axes are operating by the start request 
of each control (positioning, JOG operation, 
home return), the bits corresponding to each 
axis number turn on.They turn off on 
completion of the operation. 

 - 

17-32 UM 00091 

33-48 UM 00092 

49-64 UM 00093 

Virtual 1-16 UM 00094 

Virtual 17-32 UM 00095 

1-16 UM 00096 

Operation 
done 
annunciation 

H0 

When the running operation of each control 
(positioning, JOG operation, home return) is 
completed, the bits corresponding to each axis 
number turn on. 
In the case of positioning control (P-, C-point 
control), they turn on when the execution of E-
point table is completed. After this flag turns 
ON, the ON-state will continue until the next 
control is activated. 

 - 

17-32 UM 00097 

33-48 UM 00098 

49-64 UM 00099 

Virtual 1-16 UM 0009A 

Virtual 17-32 UM 0009B 

(Note 1): Flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 0009C 

Home return 
done 
annunciation 

H0 

When the home return operation is completed, 
the bits corresponding to each axis number 
turn on.  After this flag turns ON, the ON-state 
will continue until the next control is activated. 

 - 

17-32 UM 0009D 

33-48 UM 0009E 

49-64 UM 0009F 

Virtual 1-16 UM 000A0 

Virtual 17-32 UM 000A1 

1-16 UM 000A2 

Near home 
input H0 

Monitor flag for the near home input connected 
to the corresnponding AMP. 
[The update cycle is communication 
(EtherCAT communication) cycle.] 

 - 17-32 UM 000A3 

33-48 UM 000A4 

49-64 UM 000A5 

- UM 000A6 
-UM 000AB 

Reserved for 
system - - - - 

1-16 UM 000AC 

Auxiliary 
contact H0 

This contact is enabled when the auxiliary 
output function has been set. 
When the positioning table is executed, the 
bits corresponding to each axis number turn 
on. 
The ON time and delay ratio depends on the 
contents specified in the axis parameter. 

 - 

17-32 UM 000AD 

33-48 UM 000AE 

49-64 UM 000AF 

Virtual 1-16 UM 000B0 

Virtual 17-32 UM 000B1 

(Note 1): Flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-8 UM 000B2 

Limit + / 
Limit - H0 

Monitor flag of the limit + input and limit - input 
connected to the corresponding AMP. 
[The update cycle is communication (EtherCAT 
communication) cycle.] 
When "Limit switch" in the axis parameter is set to 
"Enabled", the following inputs of AMP are 
monitored. 

･Limit switch +:SI-MON3 

･Limit switch: SI-MON4 

When "Limit switch" in the axis parameter is set to 
"Disabled", the following inputs of AMP are 
monitored. 

･Limit +: POT 

･Limit: NOT 

When "Limit + input logic" and "Limit - input logic" 
in the axis parameter of FP7 MC Unit is set to "A 
contact", it is reflected by the same logic as the 
input of servo amplifier. When set to "B contact", it 
is reversed. 

 - 

9-16 UM 000B3 

17-24 UM 000B4 

25-32 UM 000B5 

33-40 UM 000B6 

41-48 UM 000B7 

49-56 UM 000B8 

57-64 UM 000B8 

(Note 1): Flags for 16 axes are allocated to each area (1 word). 
bit no.15 08 7

Axis no.

＋－＋ －● ● ● ●

● ● 912● ● 1316
● ● 1720● ● 2124
● ● 2528● ● 2932
● ● 3336● ● 3740
● ● 4144● ● 4548
● ● 4952● ● 5356
● ● 5760● ● 6164

Limit
● ● 14● ● 58

＋－＋ －● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 000BA 

Error 
annunciation H0 

When an error occurs in FP7 MC Unit, the bits 
corresponding to each axis number turn on. 
The bits of all axes turn on if all axes have 
errors. 
The error contents are stored in the error 
annunciation buffer of the unit memory. 

 - 

17-32 UM 000BB 

33-48 UM 000BC 

49-64 UM 000BD 

Virtual 1-16 UM 000BE 

Virtual 17-32 UM 000BF 

1-16 UM 000C0 

Warning 
annunciation H0 

When a warning occurs in FP7 MC Unit, the 
bits corresponding to each axis number turn 
on. The bits of all axes turn on if all axes have 
warnings. 
The warning contents are stored in the warning 
buffer of the unit memory. 

 - 

17-32 UM 000C1 

33-48 UM 000C2 

49-64 UM 000C3 

Virtual 1-16 UM 000C4 

Virtual 17-32 UM 000C5 

1-16 UM 000C6 

Synchronous 
setting done 
annunciation 

H0 

Sets the synchronous setting in the unit by 
turning on the synchronous setting request of 
the output control area after setting the 
synchronous setting by the synchronous 
master axis selection for each axis. After the 
completion of the setting change, the bits 
corresponding to each axis number turnson. 

 - 

17-32 UM 000C7 

33-48 UM 000C8 

49-64 UM 000C9 

- UM 000CA 
-UM 000CB 

Reserved for 
system - - - - 

1-16 UM 000CC 

Synchronous 
cancel active 
announciation 

H0 

When the synchronous operation is canceled 
by turning on the synchronous setting cancel 
request of the output control area after setting 
the synchronous setting by the synchronous 
master axis selection for each axis, the bits 
corresponding to each axis number turn on. 
Note) The synchronous operation cannot be 
executed for the axes for which this flag is on. 

 - 
17-32 UM 000CD 

33-48 UM 000CE 

49-64 UM 000CF 

- UM 000D0 
-UM 000D1 

Reserved for 
system - - - - 

(Note 1): Flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 000D2 
Slave axis 
gear ratio 
change 
annunciation 

H0 

Changes the gear ratio by the slave axis gear ratio 
change request of the output control area. After 
the completion of the change of gear ratio, the bits 
corresponding to each axis number turn on. 

 - 
17-32 UM 000D3 

33-48 UM 000D4 

49-64 UM 000D5 

- UM 000D6 
-UM 000D7 

Reserved 
for system - - - - 

1-16 UM 000D8 
Slave axis 
clutch 
operation 
annunciation 

H0 

Starts the clutch operation by turning on the slave 
axis clutch on request or clutch off request of the 
output control area. After the completion of the 
clutach operation, the bits corresponding to each 
axis number turn on. 

 - 
17-32 UM 000D9 

33-48 UM 000DA 

49-64 UM 000DB 

- UM 000DC 
-UM 000DD 

Reserved 
for system - - - - 

(Note 1): Flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-2 UM 000DE 

General-
purpose 
input 

H0 

Monitor flag for the general-purpose input 
connected to the corresnponding AMP. The input 
status of this flag does not affect on the operations 
of the motor and FP7 MC Unit. 

bit Signal name Axis no. 

0 NOT 

1+2n 

1 POT 

2 HOME 

3 SI-MON1 / EXT1 

4 SI-MON2 / EXT2 

5 SI-MON3 

6 SI-MON4 

7 SI-MON5/ E-STOP 

8 NOT 

2n 

9 POT 

10 HOME 

11 SI-MON1 / EXT1 

12 SI-MON2 / EXT2 

13 SI-MON3 

14 SI-MON4 

15 SI-MON5/ E-STOP 
 

 - 

3-4 UM 000DF 

5-6 UM 000E0 

7-8 UM 000E1 

9-10 UM 000E2 

11-12 UM 000E3 

13-14 UM 000E4 

15-16 UM 000E5 

17-18 UM 000E6 

19-20 UM 000E7 

21-22 UM 000E8 

23-24 UM 000E9 

25-26 UM 000EA 

27-28 UM 000EB 

29-30 UM 000EC 

31-32 UM 000ED 

33-34 UM 000EE 

35-36 UM 000EF 

3738 UM 000F0 

39-40 UM 000F1 

41-42 UM 000F2 

43-44 UM 000F3 

45-46 UM 000F4 

47-48 UM 000F5 

49-50 UM 000F6 

51-52 UM 000F7 

53-54 UM 000F8 

55-56 UM 000F9 

57-58 UM 000FA 

59-60 UM 000FB 

61-62 UM 000FC 

63-64 UM 000FD 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 000FE 

Registered 
slave table H0 Turns on bits corresponding to each station 

address (slave number) registered in ENI file.  - 

17-32 UM 000FF 

33-48 UM 00100 

49-64 UM 00101 

65-80 UM 00102 

81-96 UM 00103 

97-112 UM 00104 

113-128 UM 00105 

129-144 UM 00106 

145-160 UM 00107 

161-176 UM 00108 

177-192 UM 00109 

1-16 UM 0010A 

Network 
participating 
slave table 

H0 
Turns on the bits corresponding to each station 
address (slave number) in the OP mode out of the 
slaves participating in the network. 

 - 

17-32 UM 0010B 

33-48 UM 0010C 

49-64 UM 0010D 

65-80 UM 0010E 

81-96 UM 0010F 

97-112 UM 00110 

113-128 UM 00111 

129-144 UM 00112 

145-160 UM 00113 

161-176 UM 00114 

177-192 UM 00115 

- UM 00116 
-UM 00121 

Reserved 
for system - - - - 

(Note 1): Sixteen slave numbers are allocated to each area (1 word). 
bit no.15 08 7

9 1816 ● ● ● ● ●● ● ● ● ●Slave no.
25 172432 ● ● ● ● ●● ● ● ● ●

41 334048 ● ● ● ● ●● ● ● ● ●

57 495664 ● ● ● ● ●● ● ● ● ●

73 657280 ● ● ● ● ●● ● ● ● ●

89 818896 ● ● ● ● ●● ● ● ● ●

105 97104112 ● ● ● ● ●● ● ● ● ●

121 113120128 ● ● ● ● ●● ● ● ● ●

137 129136144 ● ● ● ● ●● ● ● ● ●

153 145152160 ● ● ● ● ●● ● ● ● ●

169 161168176 ● ● ● ● ●● ● ● ● ●

185 177184192 ● ● ● ● ●● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 00122 

Normal 
slave table H0 

Turns on bits corresponding to each station 
address (slave number) in the OP mode out of the 
slaves registered in ENI file and participating in 
the network. 

 - 

17-32 UM 00123 

33-48 UM 00124 

49-64 UM 00125 

65-80 UM 00126 

81-96 UM 00127 

97-112 UM 00128 

113-128 UM 00129 

129-144 UM 0012A 

145-160 UM 0012B 

161-176 UM 0012C 

177-192 UM 0012D 

1-16 UM 0012E 

Abnormal 
slave table H0 

Turns on bits corresponding to each station 
address (slave number) in any modes other than 
the OP mode out of the slaves registered in ENI 
file and participating in the network. 

 - 

17-32 UM 0012F 

33-48 UM 00130 

49-64 UM 00131 

65-80 UM 00132 

81-96 UM 00133 

97-112 UM 00134 

113-128 UM 00135 

129-144 UM 00136 

145-160 UM 00137 

161-176 UM 00138 

177-192 UM 00139 

- UM 0013A 
-UM 0017F 

Reserved 
for system - - - - 

(Note 1): Sixteen slave numbers are allocated to each area (1 word). 
bit no.15 08 7

9 1816 ● ● ● ● ●● ● ● ● ●Slave no.
25 172432 ● ● ● ● ●● ● ● ● ●

41 334048 ● ● ● ● ●● ● ● ● ●

57 495664 ● ● ● ● ●● ● ● ● ●

73 657280 ● ● ● ● ●● ● ● ● ●

89 818896 ● ● ● ● ●● ● ● ● ●

105 97104112 ● ● ● ● ●● ● ● ● ●

121 113120128 ● ● ● ● ●● ● ● ● ●

137 129136144 ● ● ● ● ●● ● ● ● ●

153 145152160 ● ● ● ● ●● ● ● ● ●

169 161168176 ● ● ● ● ●● ● ● ● ●

185 177184192 ● ● ● ● ●● ● ● ● ●
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15.4.4 List of Output Control Area Function 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

- UM 00180 
-UM 00185 

Reserved for 
system - - - - 

1-16 UM 00186 

Servo ON 
request H0 

Requests the servo lock for the corresponding 
AMP. 
This request signal is enabled when the bits 
corresponding to each axis number turn on. 
(The operation is the edge type.) 

  
17-32 UM 00187 

33-48 UM 00188 

49-64 UM 00189 

- UM 0018A 
-UM 0018B 

Reserved for 
system - - - - 

1-16 UM 0018C 

Servo OFF 
request H0 

Requests the servo free for the corresponding 
AMP. 
This request signal is enabled when the bits 
corresponding to each axis number turn on. 
(The operation is the edge type.) 

  
17-32 UM 0018D 

33-48 UM 0018E 

49-64 UM 0018F 

- UM 00190 
-UM 00191 

Reserved for 
system - - - - 

1-16 UM 00192 

Positioning 
start contact H0 

Requests the positioning control start for the 
corresponding axis.  
The starting table is specified in the area for 
specifying the position control starting table 
number in the unit memory. 
This request signal is enabled when the bits 
corresponding to each axis number turn on. 
(The operation is the edge type.) 

  

17-32 UM 00193 

33-48 UM 00194 

49-64 UM 00195 

Virtual 1-16 UM 00196 

Virtual 17-32 UM 00197 

1-16 UM 00198 

Home return 
start request H0 

Requests the home return operation start for the 
corresponding axis. 
This request signal is enabled when the bits 
corresponding to each axis number turn on. 
(The operation is the edge type.) 

  

17-32 UM 00199 

33-48 UM 0019A 

49-64 UM 0019B 

Virtual 1-16 UM 0019C 

Virtual 17-32 UM 0019D 

(Note 1): Request flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●

 
(Note 2): The servo cannot be free automatically even in the program mode. To make the servo free, turn on the 

servo OFF request contact. 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-8 UM 0019E 

JOG 
operation 
forward/rever
se request 

H0 

Requests the JOG forward or reverse operation 
for corresponding axes. In the case of In the 
case of JOG operation, this request signal is 
enabled when the bits corresponding to each 
axis number are on. (The operation is the level 
type.) 
When the inching operation request is enabled, 
it functions as the request for the JOG inching 
forward or reverse operation. In the case of 
JOG inching operation, this request signal is 
enabled when the bits corresponding to each 
axis number turn on from off (The operation is 
the edge type.) 

  

9-16 UM 0019F 

17-24 UM 001A0 

25-32 UM 001A1 

33-40 UM 001A2 

41-48 UM 001A3 

49-56 UM 001A4 

57-64 UM 001A5 

Virtual 1-8 UM 001A6 

Virtual 9-16 UM 001A7 

Virtual 17-24 UM 001A8 

Virtual 25-32 UM 001A9 

1-16 UM 001AA 

Inching 
operation 
request 

H0 

Turns on the bits corresponding to each axis 
number for performing the JOG inching 
operation. The inching operation is enabled 
when the bits corresponding to each axis 
number are on. (The operation is the level 
type.) 
When this request signal is on, the above "JOG 
operation forward/reverse request" functions as 
the start request for the JOG inching operation. 
When it is off, it functions as the normal request 
"JOG operation forward/reverse". 

  

17-32 UM 001AB 

33-48 UM 001AC 

49-64 UM 001AD 

Virtual 1-16 UM 001AE 

Virtual 17-32 UM 001AF 

(Note 1): Request flags for 8 axes are allocated to each area (1 word) of the JOG operation forward/reverse request. 
bit no.15 08 7

Axis no.

F● ● ● ● RFRF● ● ● ● RFR

● ● 912● ● 1316
● ● 1720● ● 2124
● ● 2528● ● 2932
● ● 3336● ● 3740
● ● 4144● ● 4548
● ● 4952● ● 5356
● ● 5760● ● 6164

JOG direction

● ● 14● ● 58F : Forward
R： Reverse

 
(Note 2): Request flags for 16 axes are allocated to each area (1 word) of the inching operation request. 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 001B0 

Emergency 
stop request H0 

Requests the emergency stop for corresponding 
axes. 
This request signal is enabled when the bits 
corresponding to each axis number are on. (The 
operation is the level type.) 

  

17-32 UM 001B1 

33-48 UM 001B2 

49-64 UM 001B3 

Virtual 1-16 UM 001B4 

Virtual 17-32 UM 001B5 

1-16 UM 001B6 

Deceleration 
stop request H0 

Requests the deceleration stop for 
corresponding axes. 
It is switched between deceleration stop and 
pause by the "MC common" parameter setting. 
This request signal is enabled when the bits 
corresponding to each axis number are on. (The 
operation is the level type.) 

  

17-32 UM 001B7 

33-48 UM 001B8 

49-64 UM 001B9 

Virtual 1-16 UM 001BA 

Virtual 17-32 UM 001BB 

1-16 UM 001BC 

J-point 
speed 
change 
request 

H0 

Changes the speed up to the J-point target 
speed with a acceleration/deceleration time and 
pattern specified in the axis parameters by 
turning on this request during the J-point control 
operation. 
This request signal is enabled when the bits 
corresponding to each axis number are on. (The 
operation is the level type.) 

  

17-32 UM 001BD 

33-48 UM 001BE 

49-64 UM 001BF 

Virtual 1-16 UM 001C0 

Virtual 17-32 UM 001C1 

1-16 UM 001C2 

J-point 
positioning 
start request 

H0 

Transits to the process for the next table by 
turning on this request during the J-point control 
operation.  
This request signal is enabled when the bits 
corresponding to each axis number turn on.. 
(The operation is the edge type.) 

  

17-32 UM 001C3 

33-48 UM 001C4 

49-64 UM 001C5 

Virtual 1-16 UM 001C6 

Virtual 17-32 UM 001C7 

1-16 UM 001C8 

Error clear 
request H0 

Requests the error clear for FP7 MC Unit. 
The processing to recover from errors is 
performed and the error logs are cleared by 
turning on this request. 
Note) Unrecoverable errors cannot be recovered 
even if this request turned on. 

  

17-32 UM 001C9 

33-48 UM 001CA 

49-64 UM 001CB 

Virtual 1-16 UM 001CC 

Virtual 17-32 UM 001CD 

(Note 1): Request flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 001CE 

Warning clear 
request H0 

Requests the warning clear for FP7 MC Unit. 
Clears warnings and warning logs by turning 
on this request. 

  

17-32 UM 001CF 

33-48 UM 001D0 

49-64 UM 001D1 

Virtual 1-16 UM 001D2 

Virtual 17-32 UM 001D3 

1-16 UM 001D4 
Synchronous 
setting 
request 

H0 This contact turns on after changing the 
parameter setting of synchronous operation.   

17-32 UM 001D5 

33-48 UM 001D6 

49-64 UM 001D7 

- UM 001D8 
-UM 001D9 

Reserved for 
system - - - - 

1-16 UM 001DA 
Synchronous 
cancel 
request 

H0 Turns on the request for the amplifier to cancel 
the synchronous operation.   

17-32 UM 001DB 

33-48 UM 001DC 

49-64 UM 001DD 

- UM 001DE 
-UM 001DF 

Reserved for 
system - - - - 

1-16 UM 001E0 
Slave axis 
gear ratio 
change 
request 

H0 

Changes the gear ratio when the request flag 
for the corresponding axis during the 
synchronous operation turns on. (The 
operation is the edge type.) 

  
17-32 UM 001E1 

33-48 UM 001E2 

49-64 UM 001E3 

- UM 001E4 
-UM 001E5 

Reserved for 
system - - - - 

1-16 UM 001E6 

Slave axis 
clutch ON 
request 

H0 

Starts the clutch on operation when the 
request flag for the corresponding axis during 
the synchronous operation turns on. 
* Amplifiers that no clutch is used do not 
operate. 
(Set the operation to level type, rising edge, or 
falling edge.) 

  

17-32 UM 001E7 

33-48 UM 001E8 

49-64 UM 001E9 

 UM 001EA  
-UM 001EB 

Reserved for 
system - - - - 

(Note 1): Request flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 001EC 

Slave axis 
clutch OFF 
request 

H0 

Starts the clutch off operation when the request flag 
for the corresponding axis during the synchronous 
operation turns on. * Axes that no clutch is used do 
not operate. (Set the operation to rising edge, or 
falling edge.) 
These signals will be disabled while the slave axis 
clutch ON request signal is set to level type. 

  
17-32 UM 001ED 

33-48 UM 001EE 

49-64 UM 001EF 

－ UM 001F0 
-UM 001F1 

Reserved 
for system - - - - 

(Note 1): Request flags for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●  
●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-8 UM 001F2 

General-
purpose 
output 

H0 

General-purpose outputs connected to the 
corresponding AMP. 

bit 信号名 軸 No. 

0 set-brake 
1+2n 

1 EX-OUT1 

2 set-brake 
2+2n 

3 EX-OUT1 

4 set-brake 
3+2n 

5 EX-OUT1 

6 set-brake 
4+2n 

7 EX-OUT1 

8 set-brake 
5+2n 

9 EX-OUT1 

10 set-brake 
6+2n 

11 EX-OUT1 

12 set-brake 
7+2n 

13 EX-OUT1 

14 set-brake 
8+2n 

15 EX-OUT1 
 

  

9-16 UM 001F3 

17-24 UM 001F4 

25-32 UM 001F5 

33-40 UM 001F6 

41-48 UM 001F7 

49-56 UM 001F8 

57-64 UM 001F9 

- UM 001FA 
-UM 0027F 

Reserved 
for system - - - - 

(Note): For details of the method of using "set-brake", refer to the technical data of A5B. 
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15.5 Unit Memories (Common Area) 

15.5.1 Configuration of Common Area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

Setting parameter control area

Operation speed rate area

Axis group setting area

Current value update data area

Positioning table setting area

Error annunciation & clear area

Warning annunciation & clear area

Positioning control area

Synchronous control monitor area

UM 00280

UM 00380

UM 00490

UM 00590

UM 00990

UM 009F0

UM 00A90

UM 01710

UM 02390

UM 025D0

256 words

Starting no. Name No. of words

128 words

256 words

UM 00A50 64 words

256 words

96 words

96 words

3,200 words

3,200 words

64 words

576 words

UM 00690 768 words

UM 00400 144 wordsReserved area for the system

Reserved area for the system

Reserved area for the system

Reserved area for the system

Whole unit memory map

48 words

64 words

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

3,072 words

396,480 words

10,752 words

Each axis setting area

Input control area

System area
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15.5.2 Setting Parameter Control Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

- UM 00280 
-UM 00281 

Number of 
writing to 
FROM 

U0 
Announces the number of writing the positioning 
parameters and data in the unit memory into 
FROM. 

 － 

- UM 00282 Reserved 
for system - - - - 

- UM 00283 FROM write 
result H0 

FROM writing in progress : H5555 
FROM writing ended normally : H0 
FROM writing ended abnormally : HFFFF 
FROM writing by CMI in progress: HAAAA 

 － 

1 UM 00284 

Recalculatio
n starting 
table 
number 

U1 

This is used to rewrite positioning data using a 
user program. 
Reconstructs the positioning data which starts 
with the table number specified in this area 
when the recalculation request (Y7) turns on. 
Range: 1-1000 

  

1 UM 00285 
Recalculatio
n starting 
table size 

U0 

Reconstructs the positioning data of the table 
size specified in this area when the recalculation 
request (Y7) turns on. 

Range：1-500 

  

（2-64 
Virtual 1-32） 

UM 00286 
-UM 00343 

The following areas are allocated to each axis. 
 Recalculation starting table number: 1 word 
 Recalculation starting table size: 1 word 

  

- UM 00344 
 -UM 0037F 

Reserved 
for system - - - - 

15.5.3 Operation Speed Rate Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 00380 Operation 
speed rate U1 

All operations relating to axes (positioning, JOG 
operation, home return) can be performed at the 
specified rate. 
Range:0-500 [%] (For single axis control) 
Range:0-200 [%] (For interpolation control) 

  

(2-64 
Virtual 1-32) 

UM 00381 
-UM 003DF 

The following areas are allocated to each axis. 
 Operation speed rate: 1 word 

  

- UM 003E0 
 -UM 003FF 

Reserved 
for system - - - - 
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15.5.4 Axis Group Setting Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 00490 

Interpolation 
group 1 
setting 

H0 

Set either independent or interpolation for each 
axis in this area. In case of interpolation, each 
axis belongs to any group 1 to 32. For example, 
the axes 1, 2 and 3 belong to group 1 and are 3-
axis interpolation, set the corresponding 3 bits to 
1 in the interpolation axis setting of group 1. 
In case of single axis independent settimg, it 
does not belong to any group. Turn on the 
corresponding bits of the rest of the independent 
axis settings. 
Maximum number of interpolation axis per group 
is 3. The same axis cannot be set in more than 
one group. 

  

17-32 UM 00491 

33-48 UM 00492 

49-64 UM 00493 

Virtual 1-16 UM 00494 

Virtual 17-32 UM 00495 

- UM 00496 
-UM 0053F For interpolation groups 2 to 31, 6 words are allocated to each group.   

1-16 UM 0054A 

Interpolation 
group 32 
setting 

H0 Same as above.   

17-32 UM 0054B 

33-48 UM 0054C 

49-64 UM 0054D 

Virtual 1-16 UM 0054E 

Virtual 17-32 UM 0054F 

1-16 UM 00550 

Independent 
axis setting H0 

The bit corresponding to the axis is; 
0: Belongs to interpolatino group or the axis is 
not set as a used axis. 
1: Independent (Not belong to interpolation 
group) 
An error occurs when this overlaps with the 
setting of interpolation group. 

  

17-32 UM 00551 

33-48 UM 00552 

49-64 UM 00553 

Virtual 1-16 UM 00554 

Virtual 17-32 UM 00555 

- UM 00556 
 -UM 0058F 

Reserved for 
system - - - - 

(Note 1): Bits for 16 axes are allocated to each area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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15.5.5 Current Value Update Data Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1-16 UM 00590 

Current value 
update flag H0 

Changes "Unit system conversion current 
value" managed by FP7 MC Unit to the 
following "current value update coordinate" 
only when the bit corresponding to each axis 
number changes to 1 from 0. Afther the 
change, FP7 MC Unit clears the 
corresponding bits to 0 automatically. 

  

17-32 UM 00591 

33-48 UM 00592 

49-64 UM 00593 

Virtual 1-16 UM 00594 

Virtual 17-32 UM 00595 

- UM 00596 
 -UM 0059F 

Reserved for 
system - - - - 

1 UM 005A0 
-UM 005A1 

Current value 
update 
coordinate 

K0 

Stores the coordinate value to be preset as 
the current value after unit conversion. 
Range: -2147483648 to +2147483647 
An integer equivalent to the current value after 
unit conversion is set to the unit memory. 

Example) When the unit is um (0.1 µm), set to 
"10000" for making it be 1,000.0 µm. 

  

(2-64 
Virtual 1-32) 

UM 005A2 
-UM 0065F 

The following areas are allocated to each axis. 
 Current value update coordinate: 2 words 

  

- UM 00660 
 -UM 0068F 

Reserved for 
system - - - - 

(Note 1): Bits for 16 axes are allocated to each current value update flag area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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15.5.6 Positioning Control Starting Table Number Setting Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 00990 

Positioning 
control start 
table 
number 

U0 
Set the table number of each axis starting the 
position control. 
Range: 1 to 1000 

  

(2-64 
Virtual 1-32) 

UM 00991 
-UM 009EF 

The following areas are allocated to each axis. 
 Positioning control start table number: 1 word 

  

 

15.5.7 Positioning Control Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 009F0 
Positioning 
repeat 
count 

U0 

Set the number of times for repeating the operation 
from the positioning control starting table number 
until the E-point control. 
Range: 0 to 255 
When setting 0 or 1, the operation is executed only 
once. 
When setting 255, the operation is repeated 
unlimitedly until the operation is stopped.  

  

(2-64 
Virtual 1-32) 

UM 009F1 
-UM 00A4F 

The following areas are allocated to each axis. 
 Positioning repeat count: 1 word 

  

- UM 00A50 
 -UM 00A8F 

Reserved 
for system - - - - 
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15.5.8 Error Annunciation and Clear Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

- UM 00A90 
 -UM 00A95 

Reserved 
for system - - - - 

1-16 UM 00A96 

Error clear 
individual 
axis setting 

H0 
Clears the error of the axis for the corresponding bit. 
After changing the corresponding bit to 1, FP7 MC 
Unit clears the corresponding bit to 0 automatically. 

  

17-32 UM 00A97 

33-48 UM 00A98 

49-64 UM 00A99 

Virtual 1-16 UM 00A9A 

Virtual 17-
32 UM 00A9B 

- UM 00A9C 
 -UM00ABF 

Reserved 
for system - - - - 

(Note 1): Bits for 16 axes are allocated to the error clear individual axis setting area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●

 



15.5 Unit Memories (Common Area) 

 
15-31 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 00AC0 
No. of 
occurrences 
of errors 

U0 Annunciates the number of occurrences of errors on 
the 1st axis.  - 

1 UM 00AC1 Reserved 
for system - - - - 

1 UM 00AC2 
-UM 00AC3 

Error code 
Buffer 1 U0 

Stores the latest error code (8-digit hex) from the 
buffer 1 in order.  - 

1 UM 00AC4 
-UM 00AC5 

Error code 
Buffer 2 U0 

1 UM 00AC6 
-UM 00AC7 

Error code 
Buffer 3 U0 

1 UM 00AC8 
-UM 00AC9 

Error code 
Buffer 4 U0 

1 UM 00ACA 
-UM 00ACB 

Error code 
Buffer 5 U0 

1 UM 00ACC 
-UM 00ACD 

Error code 
Buffer 6 U0 

1 UM 00ACE 
-UM 00ACF 

Error code 
Buffer 7 U0 

1 UM 00AD0 
-UM 00AD1 

Error code 
Buffer 8 U0 

1 UM 00AD2 
-UM 00ADF 

Reserved 
for system - - - - 

(2-64 
virtual 1-32) 

UM 00AE0 
-UM 016BF 

As well as the area for axis 1, 32-word area is allocated to each axis in the 
following configuration. 
 Number of occurrences of errors: 1 word 
 Reserved area for the system: 1 word 
 Error code buffer: 2 words x 8 
 Reserved area for the system:  14 words 

  

- UM 016C0 
 -UM 0170F 

Reserved 
for system - - - - 

(Note 1): As for the unit memories in which error codes are stored, 2-word area is allocated for each axis. 
(Note 2): The difference between the unit memory number of the target axis number and the unit memory number of 

the adjacent axis number is H20 (for 32 words). 
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15.5.9 Warning Annunciation and Clear Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

- UM 01710 
 -UM 01715 

Reserved 
for system - - - - 

1-16 UM 01716 

Warning 
clear 
individual 
axis setting 

H0 

Clears the warning of the axis for the corresponding 
bit. 
After changing the corresponding bit to 1, FP7 MC 
Unit clears the corresponding bit to 0 automatically. 

  

17-32 UM 01717 

33-48 UM 01718 

49-64 UM 01719 

Virtual 1-16 UM 0171A 

Virtual 17-
32 UM 0171B 

- UM 0171C 
 -UM0173F 

Reserved 
for system - - - - 

(Note 1): Bits for 16 axes are allocated to the warning clear individual axis setting area (1 word). 

bit no.15 08 7

9 1816 ● ● ● ● ● ●● ● ● ● ● ●Axis no.
25 172432 ● ● ● ● ● ●● ● ● ● ● ●

41 334048 ● ● ● ● ● ●● ● ● ● ● ●

57 495664 ● ● ● ● ● ●● ● ● ● ● ●
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 01740 
No. of 
occurrences 
of warnings 

U0 Annunciates the number of occurrences of warnings 
on the 1st axis.  - 

1 UM 01741 Reserved 
for system - - - - 

1 UM 01742 
-UM 01743 

Warning 
code 
Buffer 1 

U0 

Stores the latest warning code (8-digit hex) from the 
buffer 1 in order.  - 

1 UM 01744 
-UM 01745 

Warning 
code 
Buffer 2 

U0 

1 UM 01746 
-UM 01747 

Warning 
code 
Buffer 3 

U0 

1 UM 01748 
-UM 01749 

Warning 
code 
Buffer 4 

U0 

1 UM 0174A 
-UM 0174B 

Warning 
code 
Buffer 5 

U0 

1 UM 0174C 
-UM 0174D 

Warning 
code 
Buffer 6 

U0 

1 UM 0174E 
-UM 0174F 

Warning 
code 
Buffer 7 

U0 

1 UM 01750 
-UM 01751 

Warning 
code 
Buffer 8 

U0 

1 UM 01752 
-UM 0175F 

Reserved 
for system - - - - 

(2-64 
virtual 1-32) 

UM 01760 
-UM 0233F 

As well as the area for axis 1, 32-word area is allocated to each axis in the 
following configuration. 
 Number of occurrences of warnings: 1 word 
 Reserved area for the system: 1 word 
 Warning code buffer: 2 words x 8 
 Reserved area for the system: 14 words 

  

- UM 02340 
 -UM 0238F 

Reserved 
for system - - - - 

(Note 1): As for the unit memories in which warning codes are stored, 2-word area is allocated for each axis. 
(Note 2): The difference between the unit memory number of the target axis number and the unit memory number of 

the adjacent axis number is H20 (for 32 words). 
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15.5.10 Synchronous Control Monitor Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 02390 

Synchronous 
master axis 
information 
monitor 

H0 

Stores the information on the master axis of 
synchronous control. 

Value   
Under 
synchrono
us control 

Synchrono
us control 
canceled 

Master axis 

H FFFF H FFFF No synchronous setting 

H 0000 H 0000 

The target axis for 
monitoring is the 
master axis. 
(For FP7 MC Unit, the 
value for the master 
axis does not change 
even when the 
synchronous control is 
canceled.) 

H 0001 H 8001 Axis 1 

H 0002 H 8002 Axis 2 

   

H 0010 H 8010 Axis 16 

   

H 0020 H 8020 Axis 32 

   

H 0040 H 8040 Axis 64 

H 0041 H 8041 Virtual axis 1 

   

H 0060 H 8060 Virtual axis 32 
 

 - 

1 UM 02391 

Synchronous 
output 
function 
selected 
state monitor 

H0 

Stores the information on the master axis of 
synchronous control. 

bit. Name Value 

0 Electronic gear 
0: Not use 
1: Use 

1 Clutch 

2 Electronic cam 

15-3 - = 
 

 - 

1 UM 02392 
-UM 02395 

Reserved for 
system - - - - 

(2-64 
virtual 1-
32) 

UM 02396 
-UM 025CF 

As well as the area for axis 1, 6-word area is allocated to each axis in the 
following configuration. 
 Synchronous master axis information monitor area: 1 word 
 Synchronous output function selected state monitor area: 1 word 
 Reserved area for the system: 4 words 

  

- UM 025D0 
 -UM 0260F 

Reserved 
for system - - - - 
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15.6 Unit Memories (Each Axis Information Area) 

15.6.1 Configuration of each axis information area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

Information and monitor area of 1st axisUM 02640

UM 02660 Information and monitor area of 2nd axis

UM 02820 Information and monitor area of 16th axis

:

UM 02A20 Information and monitor area of 32th axis

:

UM 02C20 Information and monitor area of 48th axis

:

UM 02E20 Information and monitor area of 64th axis

UM 02E40 Information and monitor area of virtual
1st axis

Information and monitor area of virtual
16th axis

Information and monitor area of virtual
32th axis

:

UM 03020

32 words

32 words

32 words

32 words

32 words

32 words

32 words

32 words

:

UM 03220 32 words

:

Starting no. Name No. of wordsWhole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

3,072 words

396,480 words

10,752 words

Each axis setting area

Input control area

System area

48 words

64 words
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15.6.2 Each Axis Information & Monitor Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 02640 
-UM 02641 Vender ID H0 Stores the ID code corresponding to brand name or 

vendor name. It is stored as 4 bytes.  - 

1 UM 02642 
-UM 02643 

Product 
Code H0 Stores the model code of AMP. It is stored as 4 

bytes.  - 

1 UM 02644 
-UM 02645 

Revision 
no. H0 Stores the firmware version of AMP. It is stored as 4 

bytes.  - 

1 UM 02646 
-UM 02647 Serial no. H0 Stores the serial number of AMP. 

It is stored as 4 bytes.  - 

1 UM 02648 Station 
Address H0 Stores the station address set to AMP. It is stored 

as 4 bytes.  - 

1 UM 02649 Reserved 
for system - - - - 

1 UM 0264A AMP status 
display H0 

Stores the status of AMP. 

bit. Name Value 

1-0 
Reserved for 
system - 

2 
Home return 
done 

0: Home return not 
completed 
1: Home return 
completed 

3 Torque limit 
0: Normal detection 
1: Contact detection 
(Torque limit) 

4 Warning 0: Normal 
1: Warrning occurred 

5 Alarm 0: Normal 
1: Alarm occurred 

6 Servo ready 
0: Cannot shift to the 
servo on-state. 
1: Servo ready 

7 Servo active 0: Servo off 
1: Servo on 

15-8 
Reserved for 
system - 

 

 - 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 0264B 

External 
input 
terminal 
monitor 

H0 

Stores the statuses of input terminals connected to 
each axis. 

bit. Name Value 

0 NOT 

0: Non active 
1: Active 

1 POT 

2 HOME 

3 SI-MON1 / EXT1 

4 SI-MON2 / EXT2 

5 SI-MON3 

6 SI-MON4 

7 SI-MON5/ E-STOP 

15-8 - - 
 

 - 

1 UM 0264C 
Torque 
monitor 
value 

- Stores the torque monitor value as integer. 
Range: 0 to 5000 (0.0% to 500.0 [%] )  - 

1 UM 0264D 

Actual 
speed 
monitor 
value 

- Stores the actual speed monitor value. 
Range: 0 to 5000 [rpm]  - 

1 UM 0264E 
 -UM 0264F 

Position 
deviation - 

Stores the difference value between the value of the 
position specified in FP7 MC Unit and the value of 
the position fed back from the amplifier. 

 - 

1 UM 02650 
Active or 
execution 
done table 

U1 
Stores the number of active positioning table or 
when the operation completed. 
Range: 1 to 1000 

 - 

1 UM 02651 Auxiliary 
output code U0 Stores the auxiliary output code when the auxiliary 

output function is enabled by the axis parameter.  - 

1 UM 02652 

Repeat 
count 
current 
value 

U0 

Stores the repeat count during the positioning 
operation. Stores 1 when no repeat operation is 
performed. Returns to 0 when the repeat count 
exceeds the upper limit. 
Range: 0 to 65535 [times] 

 - 

1 UM 02653 Reserved 
for system - - - - 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 02654 
 -UM 02655 

AMP 
current 
value 
[Absolute 
coordinate] 

K0 

Stores the current value based on a mechanical 
origin in pulse units. It will be reset to "0" on the 
completion of home return. The value will not be 
updated when the current value update function is 
executed. 
Unit: pulse 

 - 

1 UM 02656 
 -UM 02657 

Current 
value after 
unit 
conversion 
[Logic 
system 
coordinate] 

K0 

Stores the current value based on a electric origin 
(value set as home position coordinate). Stores 
values converted with the unit system (pulse, µm, 
inch, degree) selected in the axis parameter as 
integer. 
When the home return is completed, the value set 
as home position coordinate will be stored. When 
"0" is set as home position coordinate, it will be 
reset to "0". 
This area is also updated when the current value 
update function is used. 

 - 

1 UM 02658 

Control 
mode 
current 
value 

- 

Stores the current control mode. 
H0:Positioning control (E-point control / P-point 
control / C-point control) 
H1: J-point control 
H2: Home return 
H3: JOG operation 

 - 

1 UM 02659 
-UM 0265F 

Reserved 
for system - -   

(2-64 
Virtual 1-32) 

UM 2660 
-UM 323F 

As well as the area for axis 1, 32-word area is allocated to each axis in the 
following configuration. 

Item No. of words Item No. of words 
Vender ID 2 words Position deviation 2 words 
Product Code 2 words Active or execution 

done table 
1 word 

Revision no. 2 words Auxiliary output 
code 

1 word 

Serial no. 2 words Repeat count 
current value 

1 word 

StationAddress 1 word Reserved for 
system 

1 word 

Reserved for 
system 

1 word AMP current value 2 words 

AMP status 1 word Unit system 
conversion current 
value 

2 words 

External input 
terminal monitor 

1 word Control mode 
current value 

1 word 

Torque monitor 
value 

1 word Reserved area for 
the system 

7 words 

Actual speed 
monitor value 

1 word   
 

 - 
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15.7 Unit Memories (Each Axis Setting Area) 

15.7.1 Configuration of Each Axis Setting Area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

Starting no. Name No. of words

Whole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

3,072 words

396,480 words

10,752 words

Each axis setting area

Input control area

System area

Parameter setting areaUM 03240

UM 06240 Positioning data setting area

12,288 words

384,192 words

48 words

64 words
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15.7.2 Configuration of Parameter Setting Area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

UM 63EFF

Parameter setting area of 1st axisUM 03240

UM 032C0 Parameter setting area of 2nd axis

Parameter setting area of 16th axis

Parameter setting area of 32th axis

Parameter setting area of 48th axis

Parameter setting area of 64th axis

128 words

128 words

UM 039C0

UM 041C0

UM 049C0

UM 051C0

UM 05240

UM 059C0

128 words

128 words

128 words

128 words

128 words

128 words

:

:

:

:

:

UM 03240

UM 06240

Parameter setting area
12,288 words

Positioning data
setting area

384,192 words

UM 0623F

UM 061C0 128 words

Whole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

3,072 words

396,480 words

10,752 words

Each axis setting area

Input control area

System area

Starting no. Name No. of words

Parameter setting area of virtual
1st axis

Parameter setting area of virtual
16th axis

Parameter setting area of virtual
32th axis

48 words

64 words
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15.7.3 Parameter Setting Area 

The following table shows the unit memory numbers of axis number 1. 128-word area is 
allocated to each axis. 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 03240 Unit setting H0 

Set the unit system of movement amounts of the 
positioning control for each axis. The same unit 
system should be set for all interpolation axes. 
H0: pulse 
H100: μm （0.1 μm） 
H101: μm （1 μm） 
H200: inch （0.00001 inch） 
H201: inch （0.0001 inch） 
H300: degree （0.1 degree） 
H301: degree （1 degree） 

Any other settings will be errors.。 

  

1 UM 03241 Reserved 
for system - - - - 

1 UM 03242 
-UM 03243 

Pulse 
number per 
rotation 

U1 

Set the pulse number per rotation.It is necessary for 
the conversion of the pulse number when the unit is 
mm, inch or degree. 
Range: 1 to 32767000 

Any other settings will be errors.。 

  

1 UM 03244 
-UM 03245 

Movement 
amount per 
rotation 

U1 

Set the movement amount per rotation. It is 
necessary for the conversion of the pulse number 
when the unit is mm, inch or degree. 
Range: 1 to 32767000 

Any other settings will be errors.。 

The ranges vary depending on the unit settings as 
below. 
μm: 1 μm 
inch: 1/10,000 inch 
degree: 1 degree 

  

1 UM 03246 
-UM 03249 

Reserved 
for system - - - - 

1 UM 0324A 

Movement 
amount 
automatic 
check 
operation 

U2 

Set the operation to be performd when the 
difference between the command value and 
feedback value exceeds the moving amount check 
value. 
0: Error occurrence 
If the difference between the feedback value and 
the command moving amount exceeded the moving 
amount check value (threshold), an error occurs. 
1: Warning occurrence 
If the difference between the feedback value and 
the command moving amount exceeded the moving 
amount check value (threshold), a warning occurs. 
2: No 
The moving amount check is not performed. 

  
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 0324B 

Software 
limit 
enabled/dis
abled 

H0 

Select whether to enable or disable the software 
limit for each control. 

bit Name Description 

0 
For positioning 
control 0: Disable 

1: Enable 1 Fro home return 

2 For JOG operation 

15-3 - - 
 

  

1 UM 0324C 
-UM 0324D 

Upper limit 
of software 
limit 

21474 
83647 

Set the upper limit value of the software limit for 
absolute coordinates. 
The ranges vary depending on the unit settings as 
below. 
pulse: -2147483648 to +2147483647 pulse 
μm (0.1μm): -214748364.8 to +214748364.7 μm 
μm (1μm): -2147483648 to +2147483647μm 
inch (0.00001 inch): 
 -21474.83648 to +21474.83647  inch 
inch (0.0001 inch): 
 -214748.3648 to +214748.3647  inch 
degree (0.1 degree): 0.1 to 359.9 degree 
degree (1 degree): 1 to 359 degree 
Any other settings will be errors. 

  

1 UM 0324E 
-UM 0324F 

Lower limit 
of software 
limit 

-21474 
83648 

  

1 UM 03250 
-UM 03251 

Reserved 
for system - - - - 

1 UM 03252 
Auxiliary 
output 
mode 

HA00 

Set the auxiliary output mode and the ON time of 
auxiliary output. 

bit Name Description 

7-0 
Auxiliary 
output 
mode 

H0:Not use auxiliary output 
function 
H1:Use With mode 
H2:Use Delay mode 

15-8 
Auxiliary 
output 
ON time 

Range: 
H0(0 ms) to HFF(255 ms) 

 

  

1 UM 03253 
Auxiliary 
output 
Delay ratio 

U0 

Set the ratio (%) to the movement amount for 
starting the output when using the delay mode for 
the auxiliary output. 
Range: 0 to 100[%] 
Example) When it is 50%, the auxiliary output turns 
ON when the movement amount exceeds 50%. 

  
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 03254 Operation 
setting H31 

Configure the settings of limit, moving direction and 
input logic. 

bit Name Description 

0 
Limit 
enabled/disabled 

0: Enable 
1: Disable 

1 Moving direction 

0: Elapsed value + 
direction is CW 
1: Elapsed value + 
direction is CCW 

2 Limit connection 0: Standard connection 
1: Reverse connection 

3 
Home position 
proximity logic 0：Normal Open 

1：Normal Close 4 Limit + logic 

5 Limit - logic 

15-6 － － 
 

  

1 UM 03255 
-UM 03257 

Reserved 
for system - - - - 

1 UM 03258 Movement 
check value U10000 

Set the threshold for using the movement automatic 
check function. 
Range: 0 to 65536 [pulse] 

  

1 UM 03259 
-UM 0325B 

Reserved 
for system - - - - 

1 UM 0325C 
Monitor 
value error 
setting 

H0 

Set the monitor error method. 

bit Name Description 

0 
Torque 
judgement 

0: Valid 
1: Invalid 

1 
Torque 
judgement 

0: Error when it is valid 
1: Warning when it is valid 

2 
Actual speed 
judgement 

0: Valid 
1: Invalid 

3 
Actual speed 
judgement 

0: Error when it is valid 
1: Warning when it is valid 

15-4 － － 
 

  

1 UM 0325D 

Torque 
monitor 
judgement 
value 

U5000 Set the torque monitor judgement value as integer. 
Range: 0 to 5000 (0.0% to 500.0 [%] )   

1 UM 0325E 

Actual 
speed 
monitor 
judgement 
value 

U5000 Set the actual speed monitor value. 
Range: 0 to 5000 [rpm]   

1 UM 0325F Reserved 
for system - - - - 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 03260 
Home 
return 
setting code 

H0 

Set the pattern of home return. 
0: DOGmethod 1 (Based on front end + Z phase) 
1: DOG method 2 (Based on front end) 
2: DOG method 3 (Based on back end + Z phase) 
3: Limit method 1 (Limit signal + Z phase) 
4: Limit method 2 (Limit signal) 
5: Z phase method 
6: Stop-on-contact method 1 
7: Stop-on-contact method 2 (Stop-on-contact + Z 
phase) 
8: Data set 
9: DOG method 4 (Based on back end) 
Any other settings will be errors. 

  

1 UM 03261 
Home 
return 
direction 

H0 

Set the operation direction of home return. 
0: Elapsed value decreasing direction (Limit - 
direction) 
1: Elapsed value increasing direction (Limit + 
direction) 
Any other settings will be errors. 

  

1 UM 03262 

Home 
return 
acceleration 
time 

U100 Set the acceleration/deceleration time when 
performing the home return. 
Range: 0 to 10,000 (ms) 
Any other settings will be errors. 

  

1 UM 03263 

Home 
return 
deceleration 
time 

U100 

1 UM 03264 
-UM 03265 

Home 
return target 
speed 

U1000 

Set the target speed when performing the home 
return as integer. 
Range: 1 to 32767000 
Any other settings will be errors. 
The ranges vary depending on the unit settings as 
below. 
pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

  

1 UM 03266 
-UM 03267 

Home 
return creep 
speed 

U1000 

Set the speed to search the home position in the 
home return operation. Set the value lower than the 
home return target speed. 
Range: 1 to 32767000 
Any other settings will be errors. 
The ranges vary depending on the unit settings as 
below. 
pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

  

1 UM 03268 Reserved 
for system - - - - 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 03269 
JOG 
operation 
setting code 

H0 

Sets the mode when performing the JOG operation. 
bit Name Description 
0 － － 

1 
Acceleration/ 
deceleration 
pattern setting 

0: Linear 
acceleration/deceleration 
1: S-shaped 
acceleration/deceleration 

15-2 － － 
 

  

1 UM 0326A 

JOG 
operation 
acceleration 
time 

U100 Sets the acceleration/deceleration time when 
performing the JOG operation. 
Range: 0 to 10,000 (ms) 
Any other settings will be errors. 

  

1 UM 0326B 

JOG 
operation 
deceleration 
time 

U100 

1 UM 0326C 
-UM 0326D 

JOG 
operation 
target speed 

U1000 

Set the target speed for performing the JOG 
operation as integer. 
Range: 1 to 32767000 
Any other settings will be errors. 
The ranges vary depending on the unit settings as 
below. 
pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

  

1 UM 0326E 
-UM 0326F 

Inching 
movement 
amount 

U1 

Set the inching movement amount as integer. 
The ranges vary depending on the unit settings as 
below. 
pulse: 1 to +2147483647 pulse 
µm (0.1µm): 0.1 to +214748364.7 µm 
µm (1µm): 1 to +2147483647µm 
inch (0.00001 inch): 0.00001 to +2147483647  inch 
inch (0.0001 inch): 0.0001 to +214748.3647  inch 
degree (0.1 degree): 0.1 to 214748364.7 degree 
degree (1 degree): 1 to 2147483647 degree 
Any other settings will be errors. Also, the inching 
movement amount does not change when changing 
the operation speed rate. 

  

1 UM 03270 
-UM 03272 

Reserved 
for system - - - - 

1 UM 03273 

Emergency 
stop 
deceleration 
time 

U100 

Set the deceleration time at the time of emergency 
stop. 
Range: 0 to 10,000 (ms) 
Any other settings will be errors. 

  

1 UM 03274 Reserved 
for system - - - - 

1 UM 03275 
Limit stop 
deceleration 
time 

U100 
Set the deceleration time at the time of limit stop. 
Range: 0 to 10,000 (ms) 
Any other settings will be errors. 

  



15.7 Unit Memories (Each Axis Setting Area) 

 
15-47 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 03276 Reserved for 
system - - - - 

1 UM 03277 
Error stop 
deceleration 
time 

U100 
Set the deceleration time at the time of error stop. 
Range: 0 to 10,000 (ms) 
Any other settings will be errors. 

  

1 UM 03278  
-UM 0327C 

Reserved for 
system - - - - 

1 UM 0327D 

Home return 
stop-on-
cotnact 
torque value 

U100 
Set this item when specifying the home return stop-
on-contact method. 
Range: 0 to ～5000 (0.0% to 500.0 [%] ） 

  

1 UM 0327E 

Home return 
stop-on-
contact 
judgment time 

U100 
Set this item when specifying the home return stop-
on-contact method. 
Range: 0 to 10,000 [ms] 

  

1 UM 0327F  
-UM 03280 

Reserved for 
system - - - - 

1 UM 03281 J-point control 
code H0 

Set the acceleration/deceleration pattern when 
performing the J-point control 

bit Name Description 

0 － － 

1 
Acceleration/ 
deceleration 
pattern setting 

0: Linear 
acceleration/deceleration 
1: S-shaped 
acceleration/deceleration 

15-2 － － 
 

  

1 UM 03282 
J-point control 
acceleration 
time 

U100 Sets the acceleration/deceleration time when 
performing the J-point control. 
Range: 0 to 10,000 (ms) 
Any other settings will be errors. 

  

1 UM 03283 
J-point control 
deceleration 
time 

U100 

1 UM 03284 
-UM  03285 

J-point control 
target speed U1000 

Sets the target speed when performing the J-point 
control as integer. 
Range: 1 to 32767000 
Any other settings will be errors. 
The ranges vary depending on the unit settings as 
below. 
pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

  

1 UM 03286 
-UM  0328D 

Reserved for 
system - - - - 

1 UM 0328E 
-UM  0328F 

Home 
coordinates K0 

Set the home coordinates after the completion of the 
home return. This is reflected in the area of the unit 
system conversion current values after the 
completion of the home return. 

  

1 UM 03290 
-UM032BF 

Reserved for 
system - - - - 
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15.7.4 Configuration of Positioning Data Setting Area 

The positioning data setting area is used for reading or writing positioning data by user 
programs. It is constituted by 24 buffers (buffer no. 1 to buffer no.24). 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

UM 63EFF

Buffer #16 Positioning
data setting area

Buffer #1 Positioning
data setting area

Buffer #2 Positioning
data setting area

Buffer #8 Positioning
data setting area

Buffer #24 Positioning
data setting area

UM 06240

UM 0A0C8

16,008 words

UM 217F8

UM 40C38

UM 60078

:

:

:

UM 03240

UM 06240
UM 0623F

16,008 words

16,008 words

16,008 words

16,008 words

Parameter setting area
12,288 words

Positioning data
setting area

384,192 words

Whole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

3,072 words

396,480 words

10,752 words

Each axis setting area

Input control area

System area

Starting no. Name No. of words

48 words

64 words
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 Constitution of buffers 
Each buffer is constituted by the "control area (8 words)" which specifies an operation to be 
executed and "positioning data setting area (16000 words)" which sets positioning data. 

The following figure shows the constitution of buffer no. 1. Buffers no. 2 to 24 have the same 
constitution. 

UM 06248

UM 08167
UM 08168

UM 09107
UM 09108

UM 0A0A8
UM 0A0A7

UM 071C7
UM 071C8

UM 06240
UM 06247
UM 06248

UM 06240

UM 0A0C7 UM 0A0C7

UM 06267

UM 071E7

UM 08187

UM 09127

UM 0A0C7

Table no. 1
Positioning data

Table no. 125
Positioning data

Table no. 250
Positioning data

Buffer #1 Positioning
data setting area

Control code

Operation pattern

Positioning acceleration time

Positioning deceleration time

Positioning target speed

Positioning movement amount

Auxiliary point

Dwell time

Auxiliary output code

1 words

1 words

2 words

2 words

1 words

2 words

2 words

1 words

1 words

1 words

18 words

Table no. 375
Positioning data

Table no. 500
Positioning data

Control area for
buffer control

Positioning data
setting area
[For 500 tables]

32 words

32 words

32 words

32 words

16,008 words 16,000 words

8 words

Starting no. Name No. of words

Reserved area for the system

Reserved area for the system

UM 06248

UM 06249

UM 0624A

UM 0624C

UM 0624D

UM 0624E

UM 06250

UM 06252

UM 06254

UM 06255

UM 06256

 

 Buffers 1 to 8 

 
Buffer  

1 
Buffer  

2 
Buffer  

3 
Buffer  

4 
Buffer  

5 
Buffer  

6 
Buffer  

7 
Buffer  

8 
Request flag 
control UM06240 UM0A0C8 UM0DF50 UM11DD8 UM15C60 UM19AE8 UM1D970 UM217F8 

Request code 
control UM06241 UM0A0C9 UM0DF51 UM11DD9 UM15C61 UM19AE9 UM1D971 UM217F9 

Response code 
control UM06242 UM0A0CA UM0DF52 UM11DDA UM15C62 UM19AEA UM1D972 UM217FA 

Axis number 
control UM06243 UM0A0CB UM0DF53 UM11DDB UM15C63 UM19AEB UM1D973 UM217FB 

Starting table 
number UM06244 UM0A0CC UM0DF54 UM11DDC UM15C64 UM19AEC UM1D974 UM217FC 

Table size UM06245 UM0A0CD UM0DF55 UM11DDD UM15C65 UM19AED UM1D975 UM217FD 
Reserved for 
system UM06246 UM0A0CE UM0DF56 UM11DDE UM15C66 UM19AEE UM1D976 UM217FE 

Reserved for 
system UM06247 UM0A0CF UM0DF57 UM11DDF UM15C67 UM19AEF UM1D977 UM217FF 

Table no. 1 UM06248 UM0A0D0 UM0DF58 UM11DE0 UM15C68 UM19AF0 UM1D978 UM21800 
Table no. 2 UM06268 UM0A0F0 UM0DF78 UM11E00 UM15C88 UM19B10 UM1D998 UM21820 
Table no. 3 UM06288 UM0A110 UM0DF98 UM11E20 UM15CA8 UM19B30 UM1D9B8 UM21840 
- - - - - - - - - 
Table no. 100 UM06EA8 UM0AD30 UM0EBB8 UM12A40 UM168C8 UM1A750 UM1E5D8 UM22460 
- - - - - - - - - 
Table no. 200 UM07B28 UM0B9B0 UM0F838 UM136C0 UM17548 UM1B3D0 UM1F258 UM230E0 
- - - - - - - - - 
Table no. 300 UM087A8 UM0C630 UM104B8 UM14340 UM181C8 UM1C050 UM1FED8 UM23D60 
- - - - - - - - - 
Table no. 400 UM09428 UM0D2B0 UM11138 UM14FC0 UM18E48 UM1CCD0 UM20B58 UM249E0 
- - - - - - - - - 
Table no. 500 UM0A0A8 UM0DF30 UM11DB8 UM15C40 UM19AC8 UM1D950 UM217D8 UM25660 

(Note): The difference between the starting number of adjacent tables is H20 (for 32 words). 
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 Buffers 9 to 16 

 
Buffer  

9 
Buffer 

10 
Buffer 

11 
Buffer 

12 
Buffer 

13 
Buffer 

14 
Buffer 

15 
Buffer 

16 
Request flag 
control UM25680 UM29508 UM2D390 UM31218 UM350A0 UM38F28 UM3CDB0 UM40C38 
Request code 
control UM25681 UM29509 UM2D391 UM31219 UM350A1 UM38F29 UM3CDB1 UM40C39 

Response code 
control UM25682 UM2950A UM2D392 UM3121A UM350A2 UM38F2A UM3CDB2 UM40C3A 
Axis number 
control UM25683 UM2950B UM2D393 UM3121B UM350A3 UM38F2B UM3CDB3 UM40C3B 

Starting table 
number UM25684 UM2950C UM2D394 UM3121C UM350A4 UM38F2C UM3CDB4 UM40C3C 

Table size UM25685 UM2950D UM2D395 UM3121D UM350A5 UM38F2D UM3CDB5 UM40C3D 
Reserved for 
system UM25686 UM2950E UM2D396 UM3121E UM350A6 UM38F2E UM3CDB6 UM40C3E 

Reserved for 
system UM25687 UM2950F UM2D397 UM3121F UM350A7 UM38F2F UM3CDB7 UM40C3F 

Table no. 1 UM25688 UM29510 UM2D398 UM31220 UM350A8 UM38F30 UM3CDB8 UM40C40 
Table no. 2 UM256A8 UM29530 UM2D3B8 UM31240 UM350C8 UM38F50 UM3CDD8 UM40C60 
Table no. 3 UM256C8 UM29550 UM2D3D8 UM31260 UM350E8 UM38F70 UM3CDF8 UM40C80 
- - - - - - - - - 
Table no. 100 UM262E8 UM2A170 UM2DFF8 UM31E80 UM35D08 UM39B90 UM3DA18 UM418A0 
- - - - - - - - - 
Table no. 200 UM26F68 UM2A170 UM2DFF8 UM31E80 UM35D08 UM39B90 UM3DA18 UM418A0 
- - - - - - - - - 
Table no. 300 UM27BE8 UM2BA70 UM2F8F8 UM33780 UM37608 UM3B490 UM3F318 UM434A0 
- - - - - - - - - 
Table no. 400 UM28868 UM266F0 UM30578 UM34400 UM38288 UM3C110 UM3FF98 UM43E20 
- - - - - - - - - 
Table no. 500 UM284E8 UM2D370 UM311F8 UM35080 UM38F08 UM3CD90 UM40C18 UM44AA0 

(Note): The difference between the starting numbers of adjacent tables is H20 (for 32 words). 

 Buffers 17 to 24 

 
Buffer  

17 
Buffer 

18 
Buffer 

19 
Buffer 

20 
Buffer 

21 
Buffer 

22 
Buffer 

23 
Buffer 

24 
Request flag 
control UM44AC0 UM48948 UM4C7D0 UM50658 UM544E0 UM58368 UM5C1F0 UM60078 

Request code 
control UM44AC1 UM48949 UM4C7D1 UM50659 UM544E1 UM58369 UM5C1F1 UM60079 

Response code 
control UM44AC2 UM4894A UM4C7D2 UM5065A UM544E2 UM5836A UM5C1F2 UM6007A 

Axis number 
control UM44AC3 UM4894B UM4C7D3 UM5065B UM544E3 UM5836B UM5C1F3 UM6007B 

Starting table 
number UM44AC4 UM4894C UM4C7D4 UM5065C UM544E4 UM5836C UM5C1F4 UM6007C 

Table size UM44AC5 UM4894D UM4C7D5 UM5065D UM544E5 UM5836D UM5C1F5 UM6007D 
Reserved for 
system UM44AC6 UM4894E UM4C7D6 UM5065E UM544E6 UM5836E UM5C1F6 UM6007E 
Reserved for 
system UM44AC7 UM4894F UM4C7D7 UM5065F UM544E7 UM5836F UM5C1F7 UM6007F 

Table no. 1 UM44AC8 UM48950 UM4C7D8 UM50660 UM544E8 UM58370 UM5C1F8 UM60080 
Table no. 2 UM44AE8 UM48970 UM4C7F8 UM50680 UM54508 UM58390 UM5C218 UM600A0 
Table no. 3 UM44B08 UM48990 UM4C818 UM506A0 UM54528 UM583B0 UM5C238 UM600C0 
- - - - - - - - - 
Table no. 100 UM45728 UM495B0 UM4D438 UM512C0 UM55148 UM58FD0 UM5CE58 UM60CE0 
- - - - - - - - - 
Table no. 200 UM463A8 UM4A210 UM4E098 UM51F20 UM55DA8 UM59C30 UM5DAB8 UM61940 
- - - - - - - - - 
Table no. 300 UM47028 UM4AEB0 UM4ED38 UM52BC0 UM56A48 UM5AD80 UM5E758 UM625E0 
- - - - - - - - - 
Table no. 400 UM47CA8 UM4BB30 UM4F9B8 UM53840 UM576C8 UM5B550 UM5F3D8 UM63260 
- - - - - - - - - 
Table no. 500 UM48928 UM4C7B0 UM50638 UM544C0 UM58348 UM5C1D0 UM60058 UM63EE0 

(Note): The difference between the starting numbers of adjacent tables is H20 (for 32 words). 
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15.7.4.1 Control Area for Buffer Control 

This area is used for reading or writing positioning data by user programs. 
●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 06240 Request 
flag control H0 

Write data to this area for sending/receiving data of 
buffers for positioning data. After the completion of 
the execution, it is rewritten to H0 by FP7 MC Unit. 
H0000: No request 
H0001: Request 
Any other settings will be errors. 

  

1 UM 06241 
Request 
code  
control 

H0 

Configure the control setting for sending/receiving 
data of buffers for positioning data. 
H0080: Read request 
H0081: Write request 
Any other settings will be errors. 

  

1 UM 06242 
Response 
code  
control 

H0 

Stores the response code for the request of the 
buffer for positioning data. 
H0000: Complete 
H0001: In progress 
HFF00: Setting value error 

 - 

1 UM 06243 
Axis 
number 
control 

U1 

Specify the axis number of positioning data to be 
transferred. 

Range Corresponding axis no. 
1-64 Corresponds to the existing axes 1 to 64. 
65-96 Corresponds to the virtual axes 1 to 32. 

Any other settings will be errors. 

  

1 UM 06244 
Starting 
table 
number 

U1 

Specify the starting table number of positioning data 
to be transferred. 
Range: 1 to 1000 
Any other settings will be errors. 

  

1 UM 06245 Table size U1 

Specify the table size of positioning data to be 
transferred. 
Range: 1 to 500 
Any other settings will be errors. 

  

1 UM 06246 
- UM 06247 

Reserved 
for system - - - - 
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15.7.4.2 Positioning Data Setting Area 

The positioning data setting area is used for reading or writing positioning data by user 
programs. The following table shows the offset addresses from the starting table of each 
buffer. 

●: Available, -: Not available 
Offset 

address Name Default Description R W 

000H Control code  H0 

Set the position setting mode and acceleration/deceleration 
pattern for the positioning operation. 

bit Name Description 

0 Control method 0: Increment mode 
1: Absolute mode 

1 
Acceleration/deceleration 
type 

0: Linear acceleration/ 
deceleration 
1: S-shaped 
acceleration/deceleration 

15-2 － － 
 

  

001H Operation 
pattern H0 

Set the single and interpolation operation pattern for the 
positioning operation. 

bit Name Description 

7-0 
Control 
pattern 

H00: E-point control (End point control) 
H01: P-point control (Pass point control) 
H02: C-point control (Continuance point control) 
H03: J-point control (Speed point control) 
Any other settings will be errors. 

15-
8 

Interpolation 
setting 

H 00: Linear interpolation (Composite speed) 
H 01: Linear interpolation (Long axis speed) 
H 10: Circular interpolation (Center point/CW 
direction) 
H 11: Circular interpolation (Center point/CCW 
direction) 
H 20: Circular interpolation (Pass point): 
H 50: Spiral interpolation (Center point/CW 
direction/1st axis movement) 
H 51: Spiral interpolation (Center point/CCW 
direction/1st axis movement) 
H 52: Spiral interpolation (Center point/CW 
direction/2nd axis movement) 
H 53: Spiral interpolation (Center point/CCW 
direction/2nd axis movement) 
H 54: Spiral interpolation (Center point/CW 
direction/3rd axis movement) 
H 55: Spiral interpolation (Center point/CCW 
direction/3rd axis movement) 
H 60: Spiral interpolation (Pass point/1st axis 
movement) 
H 61: Spiral interpolation (Pass point/2nd axis 
movement) 
H 62: Spiral interpolation (Pass point/3rd axis 
movement) 
Any other settings will be errors. 

In the interpolation control, the setting for the axis with the 
smallest number in an axis group is effective. 

  

002H 
-003H 

Reserved for 
system - - - - 

004H 
Positioning 
acceleration 
time 

U100 
Set the acceleration and deceleration time for the positioning 
operation. 
Range: 0 to 10,000 [ms] 
Any other settings will be errors. In the interpolation control, the 
setting for the axis with the smallest number in an axis group is 
effective. 

  

005H 
Positioning 
deceleration 
time 

U100   
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●: Available, -: Not available 
Offset 

address Name Default Description R W 

006H 
-007H 

Positioning 
target speed 
(Interpolation 
speed) 

U1000 

In case of the individual operation (no interpolation), it is the target 
speed of the corresponding axis. In case of the interpolation 
operation, it is the target speed of the interpolation. In the 
interpolation operation, the setting for the axis with the smallest 
number in an axis group is effective. 
Range: 1 to 32,767,000 
Any other settings will be errors. 
The ranges vary depending on the unit settings as below. 
pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

  

008H 
-009H 

Positioning 
movement 
amount 

K0 

Set the position command value for the positioning operation. It is 
the movement amount in the case of increment, and coordinate in 
the case of absolute depending on the control code setting. 
Range: -2147483648 to +2147483647 
Any other settings will be errors. 
The ranges vary depending on the unit settings as below. 
pulse: -2147483648 to +2147483647 pulse 
µm (0.1µm): -214748364.8 to +214748364.7 µm 
µm (1µm): -2147483648～+2147483647μm 
inch (0.00001 inch): -2147483648 to +2147483647  inch 
inch (0.0001 inch): -214748.3648 to +214748.3647  inch 
degree (0.1 degree): -214748364.8 to +214748364.7 degree 
degree (1 degree): -2147483648 to +2147483647 degree 

  

00AH 
-00BH 

Auxiliary  
point K0 

Set the auxiliary point (coordinate of center or pass point) in the 
case of circular interpolation or sprial interpolation control. 
Range: -2147483648 to +2147483647 
Any other settings will be errors. 
The ranges vary depending on the unit settings as below. 
pulse: -2147483648 to +2147483647 pulse 
µm (0.1µm): -214748364.8 to +214748364.7 µm 
µm (1µm): -2147483648 to +2147483647µm 
inch (0.00001 inch): -2147483648 to +2147483647  inch 
inch (0.0001 inch): -214748.3648 to +214748.3647  inch 
degree (0.1 degree): -214748364.8 to +214748364.7 degree 
degree (1 degree): -2147483648 to +2147483647 degree 

  
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●: Available, -: Not available 
Offset 

address Name Default Description R W 

00CH Dwell time U0 
Set the dwell time. 
Range: 0 to 32,767 [ms] 
Any other settings will be errors. 

  

00DH Auxiliary 
output code U0 Set arbitrary data as auxiliary output codes when using the 

auxiliary output function.   

00EH  
-00FH 

Reserved for 
system － － - - 
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15.8 Unit Memories (Synchronous Control Setting Area) 

15.8.1 Configuration of Synchronous Control Setting Area 

UM 00000

UM 0260F
UM 02610
UM 0263F
UM 02640

UM 63EFF

UM 03240

UM 63F00
UM 63F3F
UM 63F40

UM 6693F

UM 0323F

UM 0027F
UM 00280

UM 0017F
UM 00180

UM 0007F
UM 00080

UM 6693F

UM 65B40

UM 653D0
UM 653CF

UM 64CD0
UM 64CCF

UM 645D0
UM 645CF

UM  63F40

UM 63FB0
UM 63FAF

UM 65B3F

UM 65AD0
UM 65ACF

Whole unit memory map

Common area

Each axis
information area

Synchronous
control setting area

System area

System area

Output control area

128 words

256 words

256 words

9,104 words

48 words

3,072 words

396,480 words

64 words

10,752 words

Synchronous control
common setting areaUM 63F40

UM 63F50

16 words

Starting no. Name No. of words

UM 63F60

UM 63F90

Synchronous control
setting area of 1st
axis
Synchronous control
setting area of 2nd
axis

Synchronous control
setting area of 16th
axis

Synchronous control
setting area of 32th
axis

Synchronous control
setting area of 48th
axis

Synchronous control
setting area of 64th
axis

112 words

16 words

48 words

32 words

Electronic gear setting
area

Clutch setting area

Electronic cam setting
area

112 words

Reserved area for
the system

3584 words

112 words

112 words

112 words

112 words

:

:

:

:

Each axis setting area

Input control area

System area
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15.8.2 Sychronous Control Setting Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 63F40 
synchronous 
master axis 
selection 

H0 

Set the synchronous master axis for each axis. 
Value Setting 

H 0000 U0 
The target axis is the master 
axis. 

H 0001 U1 Axis 1 
H 0002 U2 Axis 2 
----- ----- ----- 
H 0010 U16 Axis 16 
----- ----- ----- 
H 0020 U32 Axis 32 
----- ----- ----- 
H 0040 U64 Axis 64 
H 0041 U65 Virtual axis 1 
----- ----- ----- 
H 0060 U96 Virtual axis 32 

Any other settings will be errors. 

  

1 UM 63F41 

Synchronous 
output 
function 
selection 

H0 

Set the synchronous function for each axis. 
bit Name Description 

0 
Electronic gear 
operation setting 

0: Not use 
1: Use 

1 
Clutch operation 
setting 

2 
Electronic operation 
setting 

15-3 
Area reserved for 
system － 

 

  

1 UM 63F42 

Synchronous 
slave single 
deceleration 
stop 
deceleration 
method 

H0 

bit Name Description 

0 Not used  

1 Deceleration method 
0: Linear 
1：- 

15-3 
Area reserved for 
system － 

 

  

1 UM 63F43 

Synchronous 
slave single 
deceleration 
stop 
deceleration 
time 

U100 

Set the deceleration time when performing the 
deceleration stop during the synchronous operation. 
Range: 0 to 10,000 [ms] 
Any other settings will be errors. 

  

1 UM 63F44 
-UM 63F4F 

Reserved for 
system - - - - 

(Note): The above table shows the unit memory numbers of axis number 1. For details of the whole configuration, 
refer to "15.8.1 Configuration of Synchronous Control Setting Area". 
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15.8.3 Electronic Gear Setting Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 63F50 
-UM 63F51 

Gear ratio 
numerator of 
each axis 

U1 

Set the numerator and denominator for the gear 
ratio of electronic gear separately. 
Range: U1 to U2147483647 
Electronic gear ratio is determined by the following 
formula. 
Output speed of electronic gear = Operating speed 
of master axis x (Gear ratio numerator/Gear ratio 
denominator) 

  

1 UM 63F52 
-UM 63F53 

Gear ratio 
denominator 
of each axis 

U1   

1 UM 63F54 
Gear ratio 
change time 
of each axis 

U1 

Set the time required to change the current gear 
ratio to a new gear ratio when the new gear ratio is 
set for the electronic gear in operation. 
1 to 10000 [ms] 

  

1 UM 63F55 
-UM 63F5F 

Reserved 
for system - - - - 

(Note): The above table shows the unit memory numbers of axis number 1. For details of the whole configuration, 
refer to "15.8.1 Configuration of Synchronous Control Setting Area". 

15.8.4 Clutch Setting Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 63F60 Clutch ON 
trigger type H0 H0: I/O clutch ON request   

1 UM 63F61 
Clutch ON 
edge 
selection 

H0 

Set the valid condition of trigger signals. 
H0: Level 
H1: Leading edge 
H2: Trailing edge 

  

1 UM 63F62 
-UM 63F67 

Reserved 
for system - - - - 

1 UM 63F68 Clutch OFF 
trigger type H0 H0: I/O clutch OFF request   

1 UM 63F69 
Clutch OFF 
edge 
selection 

H0 

Set the valid condition of trigger signals. This item is 
unavailable when the clutch ON edge selection is 
set to "H0: Level". 
H0: Disabled 
H1: Leading edge 
H2: Trailing edge 

  

1 UM 63F6A 
-UM 63F6F 

Reserved 
for system - - - - 

(Note): The above table shows the unit memory numbers of axis number 1. For details of the whole configuration, 
refer to "15.8.1 Configuration of Synchronous Control Setting Area". 
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●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 63F70 Clutch ON 
method H0 

Select the clutch ON method. 
H0: Direct 
H1: Slip 

  

1 UM 63F71 Reserved 
for system - - - - 

1 UM 63F72 Clutch ON 
slip method H0 H0: Slip time setting   

1 UM 63F73 Clutch ON 
slip time U1 

Set a slip time when the clutch ON method is set to 
"H1: Slip". 
1 to 10000 [ms] 

  

1 UM 63F74 
-UM 63F75 

Reserved 
for system - - - - 

1 UM 63F76 
Clutch ON 
slip curve 
selection 

H0 H0: Linear   

1 UM 63F77 
-UM 63F7F 

Reserved 
for system - - - - 

1 UM 63F80 Clutch OFF 
method H0 

Select the clutch OFF method. 
H0: Direct 
H1: Slip 

  

1 UM 63F81 Reserved 
for system - - - - 

1 UM 63F82 Clutch OFF 
slip method H0 H0: Slip time setting   

1 UM 63F83 Clutch OFF 
slip time U1 

Set a slip time when the clutch OFF method is set to 
"H1: Slip". 
1 to 10000 [ms] 

  

1 UM 63F84 
-UM 63F85 

Reserved 
for system - - - - 

1 UM 63F86 
Clutch OFF 
slip curve 
selection 

H0 H0: Linear   

1 UM 63F87 
-UM 63F8F 

Reserved 
for system - - - - 

(Note): The above table shows the unit memory numbers of axis number 1. For details of the whole configuration, 
refer to "15.8.1 Configuration of Synchronous Control Setting Area". 
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15.8.5 Electronic Cam Setting Area 

●: Available, -: Not available 

Axis no. 
Unit 

memory 
no. (Hex) 

Name Default Description R W 

1 UM 63F90  
-UM 63F91 

Cam control 
synchronous 
master axis 
cycle 

U1 Set the cam control synchronous master cycle. 
U1  to U2147483647   

1 UM 63F92 Reserved for 
system - - - - 

1 UM 63F93 Cam pattern 
number U1 Set the registered cam pattern number to be used. 

1 to  256   

1 UM 63F94  
-UM 63F95 

Cam stroke 
amount U1 

Displacement amount upper limit setting for cam 
control 
U1  to  U2147483647 

  

1 UM 63F96 
-UM 63FAF 

Reserved for 
system - - - - 

(Note): The above table shows the unit memory numbers of axis number 1. For details of the whole configuration, 
refer to "15.8.1 Configuration of Synchronous Control Setting Area". 
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15.9 Dimensions 

 AFP7MC16EC/ AFP7MC32EC/ AFP7MC64EC 

90

28 80 4

 
(Unit: mm) 
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